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Introduction
This manual explains how to use Universal Viewer. To ensure correct use, please read this
manual thoroughly before beginning operation.
For details on the functions related to SMARTDAC+ series options, see also the manual for

the options.
Notes

» The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the software’s performance and functions.

» Every effort has been made in the preparation of this manual to ensure the accuracy of its
contents. However, should you have any questions or find any errors, please contact your
nearest YOKOGAWA dealer.

» Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA's permission is strictly prohibited.

QR Code

The product has a QR Code pasted for efficient plant maintenance work and asset

information management.

It enables confirming the specifications of purchased products and user’s manuals.

For more details, please refer to the following URL.

https://www.yokogawa.com/qr-code

QR Code is a registered trademark of DENSO WAVE INCORPORATED.

Trademarks

+ SMARTDACH+ is registered trademarks of Yokogawa Electric Corporation.

* Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation
in the United States and/or other countries.

» Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems
Incorporated.

» Pentium is a trademark of Intel Corporation in the United States and/or other countries.

» Kerberos is a trademark of the Massachusetts Institute of Technology (MIT).

« Company and product names that appear in this manual are registered trademarks or
trademarks of their respective holders.

* The company and product names used in this manual are not accompanied by the
registered trademark or trademark symbols (® and ™).

Revisions

December, 2012 1st Edition

February, 2013 2nd Edition

May, 2014 3rd Edition

December, 2014 4th Edition

January, 2015 5th Edition

March, 2015 6th Edition

August, 2015 7th Edition

December, 2015 8th Edition
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December, 2016 10th Edition
June, 2017 11th Edition
September, 2017 12th Edition
December, 2017 13th Edition

March, 2018 14th Edition
June, 2018 15th Edition
June, 2018 16th Edition
March, 2019 17th Edition
December, 2019 18th Edition
May, 2020 19th Edition

19th Edition: May 2020 (YK)
All Rights Reserved, Copyright © 2012, Yokogawa Electric Corporation
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Software License Agreement

IMPORTANT - PLEASE READ CAREFULLY BEFORE INSTALLING OR USING:

THANK YOU VERY MUCH FOR SELECTING SOFTWARE OF YOKOGAWA ELECTRIC CORPORATION (“YOKOGAWA”) PROVIDED BY DOWNLOADING FROM
YOKOGAWA'S WEB SITE, OR THE RECORDING MEDIUM(collectively, “Software Product’). BY INSTALLING OR OTHERWISE USING THE SOFTWARE PRODUCT, YOU
AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT INSTALL NOR USE THE SOFTWARE PRODUCT.

1. Scope
This Agreement applies to the Software Product and associated documentation of Yokogawa. Unless otherwise provided by Yokogawa, this Agreement applies to the updates
and upgrades of the Software Product which may be provided by Yokogawa.

Software Product: SMARTDAC+ STANDARD Universal Viewer

2. Grant of License

2.1 Subject to the terms and conditions of this Agreement, Yokogawa hereby grants to you a non-exclusive and non-transferable right to use the Software Product for your internal
operation use,

2.2 Unless otherwise agreed or provided by Yokogawa in writing, the following acts are prohibited:

a) to reproduce the Software Product, except for one archival copy for backup purpose, which shall be maintained with due care subject to this Agreement;

b) to sell, lease, distribute, transfer, pledge, sublicense, make available via the network or otherwise convey the Software Product or the license granted herein to any other
person or entity;

c) to use the Software Product on any unauthorized computer via the network;

d) to cause, permit or attempt to dump, disassemble, decompile, reverse-engineer, or otherwise translate or reproduce the Software Product into source code or other human
readable format, or to revise or translate the Software Product into other language and change it to other formats than that in which Yokogawa provided;

e) to cause, permit or attempt to remove any copy protection used or provided in the Software Product; or

f) to remove any copyright notice, trademark notice, logo or other proprietary notices or identification shown in the Software Product.

2.3 Any and all technology, algorithms, know-how and process contained in the Software Product are the property or trade secret of Yokogawa or licensors to Yokogawa.
Ownership of and all the rights in the Software Product shall be retained by Yokogawa or the licensors and none of the rights will be transferred to you hereunder.

2.4 You agree to maintain the aforementioned property and trade secret of Yokogawa or licensors and key codes in strict confidence, not to disclose it to any party other than your
employees, officers, directors or similar staff who have a legitimate need to know to use the Software Product and agreed in writing to abide by the obligations hereunder.

2.5 Upon expiration or termination of this Agreement, the Software Product and its copies, including extracts, shall be returned to Yokogawa and any copies retained in your
computer or media shall be deleted irretrievably. If you dispose of media in which the Software Product or its copy is stored, the contents shall be irretrievably deleted.

2.6 The Software Product may contain software which Yokogawa is granted a right to sublicense or distribute by third party suppliers, including affiliates of Yokogawa (“Third
Party Software”). If suppliers of the Third Party Software (“Supplier”) provide special terms and conditions for the Third Party Software which differ from this Agreement, the
special terms and conditions separately provided by Yokogawa shall prevail over this Agreement. Some software may be licensed to you directly by Supplier.

2.7 The Software Product may contain open source software (“OSS”), for which the special terms and conditions separately provided by Yokogawa shall take precedence over
this Agreement.

3. Restrictions on Application

3.1 Unless otherwise agreed in writing between you and Yokogawa, the Software Product is not intended, designed, produced or licensed for use in relation to aircraft operation
or control, ship navigation or marine equipment control, or ground facility or device for support of the aforesaid operation or control, or for use in relation to rail facility, nuclear
related facility, radiation-related equipment, or medical equipment or facility, or under any other circumstances which may require high safety standards.

3.2 |If the Software Product is used for the abovementioned purposes, neither Yokogawa nor assumes liability for any claim or damage arising from the said use and you shall
indemnify and hold Yokogawa, Supplier, their affiliates, subcontractors, officers, directors, employees and agents harmless from any liability or damage whatsoever, including
any court costs and attorney’s fees, arising out of or related to the said use.

4. Limited Warranty

4.1 The Software Product shall be provided to you on an “as is” basis at the time of delivery, Yokogawa shall disclaim all of the warranties whatsoever, express or implied, and all
liabilities therefrom. If any physical defect is found on the recording medium not later than twelve (12) months from delivery, Yokogawa shall replace such defective medium
free of charge, provided that the defective medium shall be returned to the service office designated by Yokogawa at your expense within the said twelve (12) months. THIS
LIMITED WARRANTY PROVIDED IN THIS CLAUSE IS IN LIEU OF ALL OTHER WARRANTIES OF ANY KIND WHATSOEVER AND YOKOGAWA HEREBY DISCLAIMS
ALL OTHER WARRANTIES RELATING TO THE SOFTWARE PRODUCT, WHETHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE, NON-INFRINGEMENT, QUALITY, FUNCTIONALITY, APPROPRIATENESS,
ACCURACY, RELIABILITY AND RECENCY. IN NO EVENT SHALL YOKOGAWA WARRANT THAT THERE IS NO INCONSISTENCY OR INTERFERENCE BETWEEN
THE SOFTWARE PRODUCT AND OTHER SOFTWARE NOR SHALL BE LIABLE THEREFOR. The warranty provisions of the applicable law are expressly excluded to the
extent permitted.

4.2 At the sole discretion of Yokogawa, Yokogawa may upgrade the Software Product to the new version number (“Upgrade”) and make it available to you at your expense or
free of charge as Yokogawa deems fit. In no event shall Yokogawa be obliged to upgrade the Software Product or make the Upgrade available to you.

4.3 Certain maintenance service may be available for some types of Software Product at Yokogawa'’s current list price. Scope and terms and conditions of the maintenance
service shall be subject to those separately provided by Yokogawa. Unless otherwise provided in Yokogawa catalogues or General Specifications, maintenance services
will be available only for the latest version and the immediately preceding version. In no event will service for the immediately preceding version be available for more than 5
years after the latest version has been released. In addition, no service will be provided by Yokogawa for the Software Product which has been discontinued for more than 5
years. Notwithstanding the foregoing, maintenance service may not be available for non-standard Software Product. Further, in no event shall Yokogawa provide any service
for the Software Product which has been modified or changed by any person other than Yokogawa.
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Software Licensing Agreement

5. Infringement

5.1 If you are warned or receive a claim by a third party that the Software Product in its original form infringes any third party’s patent (which is issued at the time of delivery of
the Software Product), trade mark, copyright or other intellectual property rights (“Claim”), you shall promptly notify Yokogawa thereof in writing.

5.2 |If the infringement is attributable to Yokogawa, Yokogawa will defend you from the Claim at Yokogawa’s expense and indemnify you from the damages finally granted by the
court or otherwise agreed by Yokogawa out of court. The foregoing obligation and indemnity of Yokogawa shall be subject to that i) you promptly notify Yokogawa of the Claim
in writing as provided above, ii) you grant to Yokogawa and its designees the full authority to control the defense and settlement of such Claim and iii) you give every and all
necessary information and assistance to Yokogawa upon Yokogawa’s request.

5.3 If Yokogawa believes that a Claim may be made or threatened, Yokogawa may, at its option and its expense, either a) procure for you the right to continue using the Software
Product, b) replace the Software Product with other software product to prevent infringement, c) modify the Software Product, in whole or in part, so that it become non-
infringing, or d) if Yokogawa believes that a) through c) are not practicable, terminate this Agreement and refund you the paid-up amount of the book value of the Software
Product as depreciated.

5.4 Notwithstanding the foregoing, Yokogawa shall have no obligation nor liability for, and you shall defend and indemnify Yokogawa and its suppliers from, the Claim, if the
infringement is arising from a) modification of the Software Product made by a person other than Yokogawa, b) combination of the Software Product with hardware or software
not furnished by Yokogawa, c) design or instruction provided by or on behalf of you, d) not complying with Yokogawa’s suggestion, or e) any other causes not attributable to
Yokogawa.

5.5 This section states the entire liability of Yokogawa and its suppliers and the sole remedy of you with respect to any claim of infringement of a third party’s intellectual property
rights. Notwithstanding anything to the contrary stated herein, with respect to the claims arising from or related to the Third Party Software or OSS, the special terms and
conditions separately provided for such Third Party Software or OSS shall prevail.

6. Limitation of Liability

6.1 EXCEPT TO THE EXTENT THAT LIABILITY MAY NOT LAWFULLY BE EXCLUDED IN CONTRACT, YOKOGAWA SHALL NOT BE LIABLE TO ANY PERSON OR LEGAL
ENTITY FOR LOSS OR DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES, OR OTHER SIMILAR
DAMAGES OF ANY KIND, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OR DESTRUCTION
OF DATA, LOSS OF AVAILABILITY AND THE LIKE, ARISING OUT OF THE USE OR INABILITY TO USE OF THE SOFTWARE PRODUCT, OR ARISING OUT OF ITS
GENERATED APPLICATIONS OR DATA, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER BASED IN WARRANTY (EXPRESS OR IMPLIED),
CONTRACT, STRICT LIABILITY, TORT (INCLUDING NEGLIGENCE), OR ANY OTHER LEGAL OR EQUITABLE GROUNDS. . If the Software Product delivered by
Yokogawa is altered, modified or combined with other software or is otherwise made different from Yokogawa catalogues, General Specifications, basic specifications,
functional specifications or manuals without Yokogawa'’s prior written consent, Yokogawa shall be exempted from its obligations and liabilities under this Agreement or law.

6.2 Any claim against Yokogawa based on any cause of action under or in relation to this Agreement must be given in writing to Yokogawa within three (3) months after the cause
of action accrues.

7. Export Control
You agree not to export or provide to any other countries, whether directly or indirectly, the Software Product, in whole or in part, without prior written consent of Yokogawa.
If Yokogawa agrees such exportation or provision, you shall comply with the export control and related laws, regulations and orders of Japan, the United States of America,
and any other applicable countries and obtain export/import permit and take all necessary procedures under your own responsibility and at your own expense.

8. Audit; Withholding

8.1 Yokogawa shall have the right to access and audit your facilities and any of your records, including data stored on computers, in relation to the use of the Software Product
as may be reasonably necessary in Yokogawa’s opinion to verify that the requirements of this Agreement are being met.

8.2 Even after license being granted under this Agreement, should there be any change in circumstances or environment of use which was not foreseen at the time of delivery
and, in Yokogawa'’s reasonable opinion, is not appropriate for using the Software Product, or if Yokogawa otherwise reasonably believes it is too inappropriate for you to
continue using the Software Product, Yokogawa may suspend or withhold the license provided hereunder.

9. Assignment
If you transfer or assign the Software Product to a third party with Yokogawa'’s prior written consent, you shall expressly present this Agreement to the assignee to ensure
that the assignee comply with this Agreement, transfer all copies and whole part of the Software Product to the assignee and shall delete any and all copy of the Software
Product in your possession irretrievably. This Agreement shall inure to the benefit of and shall be binding on the assignees and successors of the parties.

10. Termination
Yokogawa shall have the right to terminate this Agreement with immediate effect upon notice to you, if you breach any of the terms and conditions hereof. Upon termination of
this Agreement, you shall promptly cease using the Software Product and, in accordance with sub-clause 2.5, return or irretrievably delete all copies of the Software Product,
certifying the same in writing. Clauses 2.4 and 2.5, 3, 5, 6 and 11 shall survive any termination of this Agreement.

11. Governing Law; Disputes
This Agreement shall be governed by and construed in accordance with the laws of Japan.
Any dispute, controversies, or differences which may arise between the parties hereto, out of, in relation to or in connection with this Agreement (“Dispute”) shall be resolved
amicably through negotiation between the parties based on mutual trust. Should the parties fail to settle the Dispute within ninety (90) days after the notice is given from either
party to the other, the Dispute shall be addressed in the following manner:
(i) If you are a Japanese individual or entity, the Dispute shall be brought exclusively in the Tokyo District Court (The Main Court) in Japan.
(ii) If you are not a Japanese individual or entity, the Dispute shall be finally settled by arbitration in Tokyo, Japan in accordance with the Commercial Arbitration Rules of
the Japan Commercial Arbitration Association. All proceedings in arbitration shall be conducted in the English language, unless otherwise agreed. The award of arbitration
shall be final and binding upon both parties, however, each party may make an application to any court having jurisdiction for judgment to be entered on the award and/or for
enforcement of the award.

12. Miscellaneous

12.1 This Agreement supersedes all prior oral and written understandings, representations and discussions between the parties concerning the subject matter hereof to the extent
such understandings, representations and discussions should be discrepant or inconsistent with this Agreement.

12.2 If any part of this Agreement is found void or unenforceable, it shall not affect the validity of the balance of the Agreement, which shall remain valid and enforceable according
to its terms and conditions. The parties hereby agree to attempt to substitute for such invalid or unenforceable provision a valid or enforceable provision that achieves to the
greatest extent possible the economic, legal and commercial objectives of the invalid or unenforceable provision.

12.3 Failure by either party to insist on performance of this Agreement or to exercise a right when entitled does not prevent such party from doing so at a later time, either in relation
to that default or any subsequent one.

End of document
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About the Usage of Open Source Software

Heimdal

The password-management function of the following product uses Heimdal source code for
AES authentication key generation.

In accordance with the Heimdal license agreement, the copyright notice, redistribution
conditions, and license are listed below.

SMARTDAC+ STANDARD Universal Viewer

Copyright (c) 2006 Kungliga Tekniska Hogskolan (Royal Institute of Technology, Stockholm,
Sweden).All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. Neither the name of the Institute nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE INSTITUTE OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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How to Use This Manual

Structure of the Manual

This manual contains five chapters.

Chapter Title and Description

1 Before Using the Product
Gives an overview of Universal Viewer and explains the PC system requirements for the software.

2 Basic Operation

Explains common data file operations, such as how to start the software, how to open data files, and how to

connect to data files.

3 Displaying and Converting Data

Explains how to set display conditions of data files and how to convert data into Excel and ASCII formats.

4 Saving and Printing Data
Explains how to save data display conditions and how to print data.

5 Troubleshooting

Lists error messages and explains how to deal with them.

Scope of This Manual

This manual does not explain the basic operations of your PC’s operating system. For this
information, read the Windows user’s guide or related materials.

Conventions Used in This Manua
Unit
K
k

A

WARNING

Notes

CAUTION

Note

Reference Item

>

Denotes 1024. Example: 768K (file size)
Denotes 1000.

Improper handling or use can lead to injury to the user or damage to
the instrument. This symbol appears on the instrument to indicate that
the user must refer to the user’'s manual for special instructions. The
same symbol appears in the corresponding place in the user’s manual
to identify those instructions. In the manual, the symbol is used in
conjunction with the word “WARNING” or “CAUTION.”

Calls attention to actions or conditions that could cause serious or fatal
injury to the user, and precautions that can be taken to prevent such
occurrences.

Calls attention to actions or conditions that could cause light injury
to the user or cause damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Calls attention to information that is important for the proper operation
of the instrument.

Reference to related operation or explanation is indicated after this
mark.
Example: P> section 4.1

Conventions Used in the Procedural Explanations

Bold characters

Explanation

Indicates character strings that appear on the screen.
Example: Voltage

Carry out the procedure according to the step numbers. All procedures
are written under the assumption that you are starting operation at the
beginning of the procedure, so you may not need to carry out all the
steps in a procedure when you are changing the settings.

The explanation section describes limitations and related information
about the operation.
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How to Use This Manual

Images

The images used in this manual may differ from those that actually appear in the software.
Such differences do not affect the procedural explanation.

Products That This Manual Covers’

Product

Version

SMARTDAC+ STANDARD Universal Viewer Up to R.3.09.xx

Revision history

For the types of files that can be displayed, see section 1.1.1, “Files That Can Be Displayed
and Their Extensions”.

Edition Explanation

1

New edition

2

Modified for version R1.02.xx.
Added descriptions for the GX10, GP10, and GP20 data file display and for search data file linking. Improvements to
descriptions.

Modified for version R2.01.xx.

Added descriptions for the SMARTDAC+ GX/GP release number 2 and Data Logging Software GA10 release number 1.
<Support Information>: Display condition files (.vdx), linking files (.Idx), and display templates created using old versions of
Universal Viewer are supported.

Modified for version R2.02.xx.
Added descriptions for the SMARTDAC+ GM release number 1.
Improvements to descriptions.

Modified for version R2.03.xx.
Feature additions (text comment line and the like).

Modified for version R2.04.xx.
HMR10000/uR20000: Added descriptions on how data files saved to SD memory cards (/EM1 option) are displayed. Feature
additions (enhancements to file searching and the like)

Modified for version R2.05.xx.
Added descriptions on how data files of the SMARTDAC+ GM advanced security function (/AS option) are displayed. Added
descriptions for the function that allows waveforms to be simultaneously turned on and off on the waveform display window.
Improvements to descriptions.

Modified for version R2.06.xx.
Added descriptions for the SMARTDAC+ GX/GP/GM release number 3.
Improvements to descriptions.

Modified for version R2.08.xx.
Added descriptions for the SMARTDAC+ GA10 release number 3.
<Support Information>: Expansion to the number of tags (Max. 4000) of GA10 is supported.

Modified for version R2.09.xx.
Feature addition (switching the time zone for displaying GX/GP/GM and GA10 data files). Improvements to descriptions.

Modified for version R3.01.xx.

Added descriptions for SMARTDAC+ GX/GP/GM release number 4 (dual interval measurement mode, control, etc.). Addition
of a function that displays data from different files in the same window with separate time axes (superimposed display).
Improvements to descriptions.

Modified for version R3.02.xx.

Modified to accommodate the displaying and printing of data files and report files recorded with DAQLOGGER and DAQ32Plus/
DAQ32. Improvement to the area for printing the cursor value dialog box in the superimposed display. Added descriptions for a
function that shows and hides the time axis grid.

Modified for version R3.03.xx.

Printout setup for multiple groups was added. Improvement was made to save the display condition file for the data file opened
in the GA10 file list page in the GA10 server folder. In addition, improvement was made to make the file link target folder the
GA10 server folder for Link Previous File, Link Next File, and Link All Files.

Modified for version R3.04.xx.
Added descriptions for an improvement that allows the font size and legend position to be adjusted in waveform display printing.

Modified for version R3.05.xx.
Added descriptions for the SMARTDAC+ GX/GP/GM release number 4 (version R4.02 (calibration correction of communication
channels )).

Modified for version R3.06.xx.
“Show/Hide” was added to the statistics dialog box.

Modified for version R3.07.xx.
Added descriptions for the SMARTDAC+ GX/GP/GM release number 4 (version R4.06).

Modified for version R3.08.xx.

Added descriptions for the SMARTDAC+ GX/GP/GM release number 4 (version R4.07).

Added descriptions for the SMARTDAC+ GA10 release number R3.06).

Added descriptions for new functions (filter for the operation log list, saving and printing of statistics results, displaying of the
data file being recorded on the GA10).

Other improvements.

Modified for version R3.09.xx.
Added descriptions for the SMARTDAC+ GA10 release number R3.07).

vi

IM 04L61B01-01EN



Contents

Chapter 1

Chapter 2

Chapter 3

T (oo 18 T3 1o o [P SRI i
Software License Agreement i
About the Usage of Open Source SOMWAIE..........cccuuii it iv

HOW t0 USE ThiS IMANUANL.........cooieeiiiiieee ettt et e e e e e e e e e e e e e e e e e e e eeeenees v

Before Using the Product

1.1

1.2

Overview Of UNIVErSal VIEBWET ........coiiiiiiiii ittt 1-1
1.1.1 Files That Can Be Displayed and Their EXENSIONS ..........cccoiiiiiiiiiieniececeeeece e 1-1
1.1.2 Screen Transition and Displayed COoNteNtS ..........cociiiiiiiiiiieiie e 1-6
1.1.3 MENU @NA ICONS ...ttt et ekttt et e et e b e aane e 1-8
1.1.4 Installation and Version Updating..........coooiiiiiiiiiiiie e 1-14
PC System ReqUINEMENTS ..ot 1-15
1.21 HAPAWAIE......ooii e 1-15
1.2.2 OPErating SYSTEM ...ttt 1-15
1.2.3 Other REQUIrEMENTS ........iiiiiiiiiie et 1-16
124 SECUIMEY MEASUIES ...ttt ettt et e e bt et e et eebeeaneeenes 1-16

Basic Operation

2.1

2.2

23

24

2.5

Starting and Closing UNIVersal VIEWET ..........cuuiiiiiiiiiiiiiiee e 2-1
211 Starting UNIVErsal VIBWET ........o...iiiiiiee ettt 2-1
21.2 Setting General Display OPtioNS ........ccuiiiiiiiieie e 2-1
213 Closing UNIVErsal VIBWET ..........couiiiiiiii i 2-2
OpeNING @ Data File .....c.ueiiiiiii s 2-3
2.21 Specifying a File Name and Opening the Data File ..........cccoiiiiiiiiiii e 2-3
222 Dragging a Data File t0 OPEN It .......ooiuiiiiiiiii e 2-5
223 Opening a Data File from Search ReSUIES..........c.cocoiiiiiiiiiiic e 2-5
LINKING Data FileS......coiuiiiiiiii ettt 2-13
2.31 Linking Files Using the Menu or TOOoIDar .............cociiiiiiiiiii e 2-13
2.3.2 Linking Files from @ Dialog BOX.........couiiitiiiiiaiie ittt s 2-15
233 Saving Link Information Files ..........c.coiiiiiiiii e 2-17

Viewing Data File Information
241 Displaying File Information

2.4.2 Displaying Setting INformation ... 2-22
SIgNING Data FilesS ... ...ttt e et e e e
2.5.1 Applicable Models and Files

252 OPEratioN OVEIVIEW ........ooiuiiiiiiiie ittt ettt ettt sbe ettt e b eaes
253 ST (e a1 1aTo I o E SRR OUPPTTOTRRRN

Displaying and Converting Data

3.1

DisSplaying Wave OrMS. .....coouuii ettt
3.1.1 Waveform Display WINAOW ........cc.iiiiiiiiiiiiieiee et

3.1.2 Setting Display Group Details
3.1.3 SettiNg the TIME AXIS ... .iiiii ittt

IM 04L61B01-01EN

vii




Contents

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.14 Displaying and Searching for AlarmsS ..........ccoouiiiiiiiee e 3-13
3.1.5 SEING the YoAXIS ...ttt et ettt e et e e e ente e e e eneeeeannes 3-14
3.1.6 Operations That You Can Perform from the Legend...........cccoooiiiiiiiiiiiiieic e 3-17
3.1.7 MOVING THP LINES ...ttt et ettt 3-18
3.1.8 SEHING CUISOIS ...ttt ettt ettt e e be e e e e be e e e e nbe e e e enteeeeeneeeeannes 3-19
3.1.9 Displaying Cursor Values and StatistiCs...........c.eviiiiiiiiiiiie e 3-21
3.1.10  Adding, Editing, and Deleting Marks .............cociiiiiiiiiiieceee e 3-23
3.1.11  Adding, Editing, and Deleting Mark NOES ............ooiiiiiiiiiiiie e 3-26
3.1.12 Displaying, Copying, and Printing Image Marks (Freehand messages) ...........c.ccccevvernene 3-28
3.1.13  Changing the Waveform ThIiCKNESS ..........ooouiiiiiiiiiiii e 3-30
3.1.14  CopYiNG WaVETOIMS ... ..coiiiiiieiie ettt et

3.1.15 Appending a Comment to a Time Range (Text comment line)

3.1.16  Displaying Waveforms Using Superimposed DiSplay ...........cccceeiiiieeiiiieiiiiie e
Displaying Waveforms on a Circular Chart ............cocoiiiiiiiiiee e
3.21 Circular DiSplay WINGOW ..........oiiiiiiiiiieiie ettt
3.2.2 Setting Display Group DetailS ...........oooiiiiiiiiiiiieie e

3.2.3 Setting the Time Axis..

3.24 DISPIaYING ALGIMIS.....eeiiie ettt eas 3-40
3.25 Displaying Cursors and Marks ...........c.ooiuiiiiioiiiiie et 3-40
Displaying Digital ValUES .............oiiiiiiiiiiiiiiee e 3-41

3.3.1 Digital Display Window...... ... 3-41
3.3.2 Setting Display Group DetailS ...........ooiieiiiiiiiiii s 3-42
3.3.3 Setting the TIME AXIS.......oiiiiiiii et 3-42
3.34 SEHING CUISOTS ...ttt e ettt e ettt e e s as e e e be e e e e be e e e anteeeenneeeeannes 3-43
3.3.5 AAAING 8 MATK ...t 3-44
Displaying a List of Alarms, Marks, and Image Marks ............cccocveiiiiiiiieeice e 3-45
3.4.1 List display window
3.4.2 ATBIMN LIST ..ttt
343 CONrOl ALGIM LIS .....eiieeiieie e et
3.4.4 VP LIS ettt ettt
3.4.5 IMAGE MAIK LISt......o ettt et e e e et e e e nnneeas 3-51
Listing Event Information and Control Modes .............oooiiiiiiiiiii e 3-52
3.5.1 EVENE LIS ..o s 3-52
3.5.2 CHrl SEATUS LISt ...t 3-54
Listing the Operation Log (DX100P/DX200P, DX1000/DX2000 with the /AS1 option, or
GX10/GX20/GP10/GP20/GM10 with the /AS 0ption) ......ceeeiiieieiie e 3-57
3.6.1 OPEration LOG LiSt. ... ..oiueiiiieiiiiiiie ittt 3-57
3.6.2 Starting the Hardware Configurator and Viewing Operation LOgs ..........ccccovvviiiiiinieiiineenn. 3-65
Displaying and Converting a TLOG File (CX1000/CX2000, DX100/DX200/DX200C,
DX100P/DX200P, MV100/MV200 0Or FXT100) ......uuiiieiieiiiiiee e et 3-67
3.71 TLOG File Display WINAOW ........ccuiiiiiiiiiiieiie ettt 3-67
3.7.2 Converting @ TLOG FilE ...ttt e e e e 3-68
VIeWing REPOI FilS ...t 3-69
3.8.1 Report File DiSplay WINAOW ........couuiiiiiiiiiie ettt 3-69
3.8.2 Hourly, Daily, Weekly, and Monthly Report File Display Window (CX1000/CX2000, DX100/
DX200, DX100P/DX200P, MV100/MV200 Or FXT00) ......ccveeeeeierirrieieriaieeieeieseeneeeeesee s 3-72

viii

IM 04L61B01-01EN



Contents

3.9 Viewing Manual Sampled Data Files ... 3-73
3.10 CONVEITING DAL ...
3.10.1  Converting Data
3.10.2  Converting Alarm, Mark, Image Mark, Event, Control Mode, and Operation Log Information,
AN SEALISHCS ... s 3-77
3.10.3  Converting Intergration Report Data ...........cccoeiiiiiiiiiiieiie e 3-78
3.1 Displaying Intergration Graph, Demand MONItOr............ccciiiiiiiiiiii e 3-79
3.11.1  Displaying Intergration Graph ..o 3-79
3.11.2  Displaying Demand Monitor Data ............coouiiiiiiiiiiic e 3-83
Chapter 4 Saving and Printing Data
41 Saving Display CONAItIONS ........cooiiiiiiii e 4-1
411 Saving a Display Condition File .........ccoiiiiiiiiie e 4-1
41.2 Saving the Display Conditions of Superimposed DiSplay ...........ccccooiieiiiiniiiiiiiiieieeeeeen 4-2
4.1.3 Display Condition Files and PreCedence ............cocooouiiiiiiiiiiiiiiic e 4-3
4.2 Saving Display TEMPIAES ........eii i 4-4
421 Saving a Display TEMPIAte .........iiiiiiee et e s 4-4
422 Applying a Display TEMPIALe ..........ooiiiiii e 4-4
4.2.3 Using a Display TEMPIAtE ........coouiiiiiiie et 4-5
4.3 ] (10T SO OU PRSPPSO 4-6
4.31 PriNt SENGS ....coeee e 4-6
4.3.2 Print OPEration ........cc.eoiiiiiiie ettt eraeas 4-10
4.3.3 Print Example (Superimposed diSPlay) .........couiiiiiiiiiiiieieie e 4-11
Chapter 5 Troubleshooting
51 L8] o] (511 gTe o) i1 o TR SPTRSRT 5-1
Index
IM 04L61B01-01EN iX




N B lan k



Chapter 1 Before Using the Product

1.1

1.1.1

Overview of Universal Viewer

This manual describes Universal Viewer.

You can use Universal Viewer to display on screen and print the following types of data that
is generated by recorders.

* Display data files

* Event data files

* TLOG data files

* Report files (including hourly, daily, monthly, batch, and daily-custom, and free reports)

» Manual sampled data files

* Integration report file (GA10)

» Demand monitor file (GA10)

Multiple data files can be displayed simultaneously in separate windows. You can link and
convert data files that are displayed.

You can include signatures (approval information) in display data files and event data files
created with a recorder using the advanced security function' or with a DX100P/DX200P.
1 The /AS option on the GX/GP/GM, the /AS1 option on the DX1000/DX2000, etc.

Files That Can Be Displayed and Their Extensions

The table below shows the types and extensions of files that Universal Viewer can display.

On the tables of each device, the columns show the device’s data file types, and the rows
the Universal Viewer’s display types (menus).
A dash indicates that the combination of the device’s data file and display does not exist.

Depending on the model and the model firmware version, older versions of Universal Viewer
may not be able to display data files. Update Universal Viewer to the latest version. For the
procedure, see section 1.1.4.

GX10, GX20, GP10, GP20 ', GM10 2

File Type Display Event Data Report Manual Sampled
(Extension) Data File File Data File Data File
Display Type ~GDS | *.GSD® | *.GEV | *GSE® *.GRE *.GMN
Waveform Display Yes Yes — —
Digital Display Yes Yes — —
Circular Display Yes Yes = =
Alarm List Yes Yes — —
- Mark List Yes Yes — —
%‘ Image Mark List Yes Yes — =
A |Event List = = = =
.‘_lﬁ Control Alarm List* | Yes — Yes — — —

Control Mode List * Yes — Yes —

Operation Log List — Yes — Yes — —
TLOG Display — — = =
Report Display — — Yes —
Manual Sample Display — — — Yes

1 GX/GP release number 2 is supported by Universal Viewer R2.01 and later.
2 GM10 is supported by Universal Viewer R2.02 and later.

3 /AS option. Supported on Universal Viewer R2.01 and later for the GX/GP and R2.05 and later for
the GM10.

4 Displayed for data files acquired by a GX/GP/GM with a PID control module installed. Supported by
Universal Viewer R3.01 and later.
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1.1 Overview of Universal Viewer

GA10
(Supported by Universal Viewer R2.01 and later.)
File Type .
] (Extension) Display R':te‘?r;ag(;?a Deman Monitor
Display Ty Data File '°File1 Data File'
*.did *.GRI *.DRE
Waveform Display Yes — —
Digital Display Yes = =
Circular Display Yes — —
Alarm List Yes — —

= [Mark List Yes = =

E‘ Image Mark List — — —

% Event List — — —

3 |Control Mode List — — —

Operation Log List — — —

TLOG Display — — —
Report Display — — —
Manual Sample Display — — —
Integratin Graph Display — Yes —
Demand Monitor Display 2 — — Yes

1 Supported by Universal Viewer R3.08 and later.

2 The displayed content is equivalent to that of the report display.

DX1000, DX1000N, DX1000T, DX2000, DX2000T, MV1000, MV2000, FX1000,

FW1000
File Type Display Event Data Report Manual Sampled
(Extension) Data File File File Data File
Display Type *DAD | *DSD' | *DAE | *.DSE’ *DAR * DAM
Waveform Display Yes Yes — —
Digital Display Yes Yes — —
Circular Display Yes Yes — —
Alarm List Yes Yes — —
% |Mark List Yes Yes — —
E‘ Image Mark List = = — —
g Event List — — — —
3 |Control Mode List — — — —
Operation Log List — Yes — Yes — -
TLOG Display — — — —
Report Display — — Yes —
Manual Sample Display — — — Yes

1 /AS1 option
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DX100P, DX200P

File Type Display Event Data TLOG Report Manual Sampled
(Extension) Data File File Data File File Data File
Display Type * dbd * dbe * dtg *33: Z‘_j::; *dmn
Waveform Display Yes Yes — — —
Digital Display Yes Yes — — —
Circular Display Yes Yes — — —
Alarm List Yes Yes — — —
= [Mark List Yes Yes — — —
E‘ Image Mark List — — — — —
g Event List — — — — —
3 (Control Mode List — — — — —
Operation Log List Yes Yes — — —
TLOG Display — — Yes — —
Report Display — — — Yes —
Manual Sample Display — — — — Yes
CX1000, CX2000
File Type Display Event Data TLOG Report Manual Sampled
(Extension) Data File File Data File File Data File
Display Type *.cds *.cev *.dtg :3:,:’, :3::", *.dmn
Waveform Display Yes Yes — — —
Digital Display Yes Yes — — —
Circular Display Yes Yes — — —
Alarm List Yes Yes — — —
= [Mark List Yes Yes — — —
E‘ Image Mark List — — — — —
g Event List Yes Yes — — —
3 [Control Mode List Yes Yes — — —
Operation Log List — — — — —
TLOG Display — — Yes — —
Report Display — — — Yes —
Manual Sample Display — — — — Yes
DX100, DX200, MV100, MV200, AX100, FX100
File Type Display Event Data TLOG Report Manual Sampled
(Extension) Data File File Data File File Data File
Display Type *.dds *.dev *.dtg :3:,: :g::r *.dmn
Waveform Display Yes Yes — — —
Digital Display Yes Yes — — —
Circular Display Yes Yes — — —
Alarm List Yes Yes — — —
= [Mark List Yes Yes — — —
E‘ Image Mark List — — — — —
g Event List — — — — —
3 [Control Mode List — — — — —
Operation Log List — — — — —
TLOG Display — — Yes — —
Report Display — — — Yes —
Manual Sample Display — — — — Yes
IM 04L61B01-01EN 1-3
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1.1 Overview of Universal Viewer

MR10000 and pR20000 with the SD memory card (/EM1 option)
(Supported by Universal Viewer R2.04 and later.)

File Type Event
(Extension) Data File

Display Type * RXE
Waveform Display Yes
Digital Display Yes
Circular Display Yes
Alarm List Yes
& |Mark List Yes
E‘ Image Mark List —
% Event List —
3 (Control Mode List —

Operation Log List

TLOG Display

Report Display

Manual Sample Display

1 Measured data saved to an SD memory card (/EM1 option) on a uR10000 or yuR20000.
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1.1 Overview of Universal Viewer

DAQLOGGER
(Supported by Universal Viewer R3.02 and later.)
File Type Display Report
(Extension) Data File File
Display Type *mid * rbi
Waveform Display Yes —
Digital Display Yes —
Circular Display Yes =
Alarm List Yes —
& |Mark List Yes —
E‘ Image Mark List — —
% Event List — —
3 |Control Mode List — —
Operation Log List — —
TLOG Display — —
Report Display — Yes

Manual Sample Display

.mld: Data file created by the logger function of DAQLOGGER.
.rbi: Report file in binary format created by the report software of DAQLOGGER.

DAQ32Plus/DAQ32

(Supported by Universal Viewer R3.02 and later.)

File Type Display Report
(Extension) Data File File
Display Type * daq * rbi
Waveform Display Yes —
Digital Display Yes —
Circular Display Yes =
Alarm List Yes —
& |Mark List Yes —
E‘ Image Mark List — —
% Event List — —
3 |Control Mode List — —
Operation Log List — —
TLOG Display — —
Report Display — Yes

Manual Sample Display

.daq: Data file created by the logger function of DAQ32 Plus R9 or later.
.rbi: Report file created by a DC100 (DR series with a report option) or report file created by the

DAQ32 Plus logger.
Note

Data files created by a logger earlier than DAQ32 Plus R9 (.bfd or .Y** extension) cannot be

displayed.
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1.1 Overview of Universal Viewer

1.1.2

Screen Transition and Displayed Contents
The figure below shows screen transitions from the main window.
— indicates that a new window will open, and < indicates that you can move between

Main window

Startup window

windows.

The window that opens when you open a data file varies depending on the data type and

display format.

|:| Window
[ Tabbed page

Y
Waveform Digital Circular List disol
| display display display Ist display
| | |
| .| TLOG file
| | | | | | ]
rAIarm Mark |Ilmage Mark| Event Ctrl Alarm | Ctrl Mode | Operation
i i i i i i Log List
Manual sample Print proview List List List List List List g Li
e screen
Hourly, daily,
— weekly, and [
monthly report
| | [Integration
report file
.| Demand
monitor file
Report file
|
| | | | | | | | | |
) Batch Daily Column Batch
rHourIy rDally rWeekIy rMontth rReport rCustom r Free r All rbargraph r i

The table below lists the different screens of Universal Viewer and what they are used for.

Window and Tab Names

Displayed Content and Format

Waveform display window

Displays data as waveforms

Circular display window

Displays data as waveforms on a circular chart

Digital display window

Displays data using digital (numeric) values

List display
window

Alarm List tabbed page

Displays changes in the alarm status of recording

Mark List tabbed page

Displays mark information that is attached to data

Image Mark List tabbed page

Displays freehand message information that is attached to data

Event List tabbed page

Displays information on events that occurred during recording

Ctrl Alarm List tabbed page

Displays changes in the control alarm status of memory sampling

Ctrl Status List tabbed page

Displays control operations that were performed during recording

Operation Log List tabbed page

Displays operation log information in data files

TLOG file display window

Displays data in TLOG data files using digital values

display window

Hourly, daily, weekly, and monthly report file

Displays data in hourly, daily, weekly, and monthly data files using
digital values

Integration data display window

Displays data in integration report data files using integration bar,

Integration trend

Continued on the next page
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1.1 Overview of Universal Viewer

Window and Tab Names

Displayed Content and Format

Demand monitor display window

Displays demand monitor data

Report file
display window

Hourly report tabbed page

Displays hourly report data in tabular format

Daily report tabbed page

Displays daily report data in tabular format

Weekly report tabbed page

Displays weekly report data in tabular format

Monthly report tabbed page

Displays monthly report data in tabular format

Batch report tabbed page

Displays batch report data in tabular format

Daily-custom tabbed page

Displays daily-custom report data in tabular format

Free tabbed page

Displays free data in report files

All display tabbed page

Displays all data in report files in tabular format

Column bar tabbed page

Displays data in report files in stacked bar graph format

Batch information tabbed page

Displays the batch information in the batch report file

Manual sampled file display window

Displays data in manual sampled data files using digital values

Print preview screen

Displays a print preview of the data in the active window

Note

Report files are displayed in either the report file display window or the hourly, daily, weekly, and
monthly report file display window depending on the recorder that generated the files.
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1.1 Overview of Universal Viewer

1.1.3

Menu and Icons

Startup Menu

Menu

[Explanation

File

0t

L

Open

Search Open

Opens a data file

Opens a data file from the search results

Integration Data Open

Opens a integration data file

Use Template

Specify Template

Specifies a template

Uses a template when opening a file

Print Setup

Sets printer options

(Recent files)

A list of files used recently

Exit

Closes the viewer and prompts to save the file
display conditions.

View

Style p |Light Displays the screen using a light style
Dark Displays the screen using a dark style

Date Format p |YY/MM/DD Displays the date in year/month/day format
MM/DD/YY Displays the date in year/day/month format
DD/MM/YY Displays the date in day/month/year format
DD.MM.YY(S) Displays the date in day.month.year format

Decimal Point p | Dot Displays decimal points with a period
Comma Displays decimal points with a comma

Time Zone(U) p |Data Displays time using the time zone of the data file
PC Displays time using the time zone of the PC

Tool Bar

Search Bar

Status Bar

Superimposed Disply Bar(J)

Shows or hides the tool bar
Shows or hides the search bar
Shows or hides the superimposed disply bar

Shows or hides the status bar

Language

>

English
Japanese

Simplified Chinese
Traditional Chinese

French
German
Russian

Korean

Switches the language (menu commands are
displayed using the original language)

?

Help

User's Manual
About...

Opens the user’s manual using Adobe Reader

Displays program information, version number
and copyright

Update

Opens a website for updating Universal Viewer

*1 The menu type and enabled/disabled states vary depending on the window. This menu is the
default menu that appears when Universal Viewer is started.
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1.1 Overview of Universal Viewer

Menu That Appears When Waveforms

Are Displayed

Menu |[Explanation
File

- |Open Opens a data file
= p p

Serach Open
@ p

Integration Data Open
Close

Save Display Settin
=] play 9

Opens a data file from the search results

Opens a integration data file

Closes the opened file

Saves the display settings (display conditions) of
the opened file

Specify Template
Use Template
Save Template

Specifies a template
Uses a template when opening a file

Saves the display settings (display conditions) to
the template

Link Previous File

3

Link Next File

e

Link All Files

k)

Link Dual Interval Waveform

£

Links the previous file and displays the result

Links the next file and displays the result

Links all files and displays the result

Links all files acquired in dual interval measurement
mode and displays the result

& Print Prints the opened file
Print Preview Displays a print preview
Print Settings Set the print method
Pring Setup... Set the printer options
(Recent files) A list of files used recently
Exit Closes the viewer and prompts to save the file display
conditions.
Edit
Copy Copies the selected range to the clipboard
Select All Selects all data
Create Cursor Clears cursors
Search Alarm P> [Right move cursor A [Moves cursor A to the alarm change point on the
right side
Left move cursor A |[Moves cursor A to the alarm change point on the
left side
Right move cursor B|Moves cursor B to the alarm change point on the
right side
Left move cursor B |[Moves cursor B to the alarm change point on the
left side
Search Mark p |Right move cursor A |Moves cursor A to the mark on the right side
Left move cursor A |Moves cursor A to the mark on the left side
Right move cursor B|Moves cursor B to the mark on the right side
Left move cursor B |Moves cursor B to the mark on the left side

Append Mark

Ch

Delete Mark

Reset mark

Adds a mark at the cursor position

Deletes marks in the selected area

Resets marks to their initial conditions

Append Mark Note

!

Delete Mark Note

Adds a mark note at the cursor position

Deletes mark notes in the selected area

Append text comment line

f fx

cg Delete text comment line

Adds a comment by specifying the time range with
the cursor

Deletes comments in the time range specified by
the cursor

TimeAxis

Absolute Time

Relative Time

Displays time using data timestamps

Displays relative time from the first data entry

All

Displays all data
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1.1 Overview of Universal Viewer

Menu Explanation
Grid(S) Shows or hides the grid.
Standard Grid Displays using Standard Grid
Dense Grid Displays using Dense Grid1
Dense Grid2(R) Displays using Dense Grid2
Dense Grid3 Displays using Dense Grid3
Dense Grid4 Displays using Dense Grid4
@ Zoom In Zooms in on the cursor area
Q Zoom Out Zooms out from the cursor area
Y-Axis
! Full Zone Sets Y-axis to Full Zone
iig Slide Zone Sets Y-axis to Slide Zone
I Auto Zone Sets Y-axis to Auto Zone
151 Free Zone Sets Y-axis to Free Zone
Standard Grid Displays using Standard Grid
Dense Grid1 Displays using Dense Grid1
Dense Grid2 Displays using Dense Grid2
Dense Grid3 Displays using Dense Grid3
Dense Grid4 Displays using Dense Grid4
= Clip Clips waveforms
View
o Display Group Setting... Configure display group settings
W Logging Waveform Display (H) Displays the logging waveform by updating to the
- latest data
E‘ Alarm Shows or hides alarms
Channel Name p|Channel Displays channels with channel numbers
Tag No Displays channels with tag numbers
Tag Comment Displays channels with tag comments
Loop(N) P |Loop Number Displays loop names with loop numbers
Tag No Displays loop names with tag numbers
Tag Comment Displays loop names with tag comments
Pattern(B) p |Pattern Name Displays pattern names with user-defined names
Pattern Number Displays pattern names with pattern numbers
2 Value p | Digits Displays the scale value of 2-value channels
numerically
Label Displays the scale value of 2-value channels with
labels
TRIG Mark Displays a mark indicating the trigger position in
the file
Mark Note p |Normal Displays all mark notes at normal size
Compact Displays all mark notes at reduced size
Image Mark(X) p(Normal Displays all image marks at normal size
Compact Displays all image marks at reduced size
Image Mark Size P [Small Displays image marks in small size
Normal Displays image marks in normal size
Large Displays image marks in large size
Line Thick p |Normal Draws waveforms with normal lines
Middle Draws waveforms with middle lines
Thick Draws waveforms with thick lines
Legend Shows or hides the legend
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1.1 Overview of Universal Viewer

Menu Explanation
Legend Mode p|Channel Displays the legend in channel mode
Axis Displays the legend in axis mode
| Cursor Value Shows or hides cursor values

Cursor Transparency | Transparent Displays cursor values with transparent background
Opaque Displays cursor values with opaque background

Style p> [Light Displays the screen using a light style
Dark Displays the screen using a dark style

Date Format p|YY/MM/DD Displays the date in year/month/day format
MM/DD/YY Displays the date in year/day/month format
DD/MM/YY Displays the date in day/month/year format
DD.MM.YY(S) Displays the date in day.month.year format

Decimal Point p | Dot Displays decimal points with a period
Comma Displays decimal points with a comma

Time Zone p |Data Displays time using the time zone of the data file
PC Displays time using the time zone of the PC

Tool Bar Shows or hides the tool bar

Search Bar Shows or hides the search bar

Superimposed Disply Bar(J)

Shows or hides the superimposed disply bar

Stasus Bar Shows or hides the status bar
Language p |[English Switches the language (menu commands are
Japanese displayed using the original language)
Simplified Chinese
Traditional Chinese
French
German
Russian
Korean
Window
Cascade Cascades windows
Tile Tiles windows
Arrange Icons Arranges icons at the bottom of the window
= Graph Opens a waveform display window
Sheet Opens a sheet display window
Circular Opens a circular display window
B List Opens a list display window
5] Superimposed Display Opens a superimposed display window
Control Displays the value at the cursor position
Statistics Calculates the section specified with cursors
File Configuration Displays the file configuration of the displayed data
Convert
Data To... Converts data
Alarm To... Converts alarm information data
Mark To... Converts mark information data

Image Mark To...
Event To...

Converts image mark information data

Converts event information data
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1.1 Overview of Universal Viewer

Menu Explanation
Ctrl Mode To... Converts control mode information data
Ctrl Alarm To... Converts control alarm information data
Operation Log To... Converts log information data
Statistics to... Converts statistics data
Information
About Document... Displays file information
Setting information Displays the setting information of the data
acquisition device
Sigature
Y Apply Signature... Applies signature to the data file
Help
User's Manual Opens the user’'s manual using Adobe Reader
9 About.. Displays program information, version number and
copyright
Update Opens a website for updating Universal Viewer

*2 The menu type and enabled/disabled states vary depending on the window. This menu appears
on the waveform display window (except the superimposed display).

Example of a Window Showing Waveform Data

Search bar Toolbar
I Uriversal Wiy - Iutey Ple-Grach[003305_138524_113934.0407) e
fo] Eie Edn Tietum Y-huu View Wedon Convst  flondtion  Gienaties| Hebp =
gad Ao gl ENE A8 Bl b B OR0E o3 b D & i?|
Py o Te o o Rn ) e

]
W cris
o [l cHoos
T i e

1045 00872

ZTDE 0t
o
Z10650 0 0145

o+ Cursor
| L

Tlde T wgw  wew wee  amw uew . :

B o FEEE -

Ready L < MM L st
L—Y-axis area '— Time axis Status bar

The commands that correspond to the buttons on the toolbar, search bar, and superimposed
display toolbar are described on the subsequent pages. The buttons on the toolbar
correspond to the commands in the menus. If the window does not have certain menus, the
corresponding buttons on the toolbar are disabled.
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1.1 Overview of Universal Viewer

Toolbar
Logging Waveform
Display
Open List Control
Search open Circular Statistics
Save display setting Sheet Version
’fGroup setting Graph _|—‘ information
| I
EmE 89S ereerss EE 22 B LA B R0 % o i abe @
L |
Link files
Button Menu Button Menu
= File—Open 15 Y Axis—Auto Zone
File—Search Open Y Axis—Free Zone
s Iyl
a File—Save Display Setting Y Axis—Standard Grid(Dense Grid 1 to 4
¥.  |from pull-down)
E) Edit—Copy I Time Axis—Standard Grid(Dense Grid 1 to
%+ 14 from pull-down)
£ View—Display Group Setting = Y Axis—Clip
W View—Logging Waveform Display = Window—Graph
¥
ot Edit—Append Mark i Window—Sheet
X Edit—Delete Mark o Window—Circular
ot Edit—Append Mark Note @) Window—List
o Edit—Erase 5 Window—Superimposed Display
o Edit—Append text comment line = Window—Control
o |n1.0|
& Edit—Delete text comment line Window—Statistics
View—Alarm Signature—Apply Signature
@ ke
View—Legend a File—Link Previous File
|| View—Cursor Value Y File—Link All Files
@ Time Axis—Zoom in 3 File—Link Next File
Q Time Axis—Zoom out & File—Print
1 Y Axis—Full Zone 2 Help—About
g Y Axis—Slide Zone
Search Bar
s &7 %a &% | AF Fin e e
Button Menu Button Menu
8, Edit—Search Alarm—Right move cursor A Al Edit—Search Mark—Right move cursor A
n
i Edit—Search Alarm—Left move cursor A Fin Edit—Search Mark—Left move cursor A
P
8 Edit—Search Alarm—Right move cursor B B Edit—Search Mark—Right move cursor B
&
J Edit—Search Alarm—Left move cursor B e Edit—Search Mark—Left move cursor B
+i
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1.1 Overview of Universal Viewer

Superimposed Display Toolbar

== el

Button Menu Button Menu

B Edit—Group Assignment TimeAxis—Align with First Data

1+
('}

++ |TimeAxis—Display Mode—Synchronous TimeAxis—Align with Time

==t [Mode
-, TimeAxis—Display Mode—Individual
== [Mode

When you move the cursor over a toolbar or search bar button, a tooltip will appear.
You can move, show, and hide bars as you would other standard Windows toolbars.

If, on the View menu, you click Tool Bar, A/M Search Bar, or Status Bar and turn on the
command, the corresponding bar appears.

If you turn off the command, the bar disappears.

114 Installation and Version Updating

Download the latest installer from YOKOGAWA's website to install and update the software.
From the Help menu, you can view the software version information and access the link to
the website. Besides, before installing the software, check that your PC is not infected by a
virus.

Nofte

There are two types of Universal Viewer: standalone installer and GA10 installer. These two types
can be installed and used on the same computer even if they have different versions, but if you
show data files with the old version, the display conditions and the template content may not be
reflected in the display. We recommend showing data files using the latest version.
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1.2 PC System Requirements

1.21 Hardware

PC
Item Description
CPU Intel Core2 Duo E6300 or faster x64 or x86 processor.
Main memory At least 2 GB.
Hard disk Free space of at least 100 MB (depending on the amount of data, you may need
more memory)
Display A video card that is recommended for the OS and a display that is supported by
the OS.
Mouse A mouse compatible with the OS
Keyboard A keyboard compatible with the OS
Communication port |An Ethernet port compatible with the OS. The TCP/IP protocol must also be
installed.
Printer A printer compatible with the OS. A printer driver that is recommended for the
OS.
1.2.2 Operating System
0s'’ Edition Service Pack 32-bit/64-bit
Windows 8.1 Update 32-bit edition and 64-bit edition
Pro Update 32-bit edition and 64-bit edition
Windows 10 Home 32-bit edition and 64-bit edition
Pro 32-bit edition and 64-bit edition
Enterprise 32-bit edition and 64-bit edition
Enterprise LTSB 32-bit edition and 64-bit edition

1 Yokogawa will also stop supporting OSs that Microsoft Corporation no longer supports.

Nofte

* To set the PC time zone, open Date and Time in Control Panel. However, do not change the PC
time zone while Universal Viewer is running. If you do, it may affect the results of file searches
based on date and time.

* By setting the PC to the same time zone (including DST) as that used for recording on the
recorder, you can view data with the same time as when the data was recorded.

« If your region has daylight saving time, select the Automatically adjust clock for Daylight Saving
Time check box.

» Do not use the time zone setting in autoexec.bat of Windows. If a time zone command such as
“TZ=GTMO) exists in autoexec.bat, disable it by typing REM in front.

» This software cannot handle data dated after year 2037.

* You can select the format of dates displayed on the software, but when entering dates, you
must use the “year/month/day) format.

» Supported OS languages are English, Japanese, simplified Chinese, traditional Chinese,
French, German, Russian, Korean and Itarian. However, make sure to use the same language
for the recorder (which recorded the data), this software, and OS.

» If you want to start Hardware Configurator from this software and view the operation log
information, install Hardware Configurator in the same folder as this software.

» 242 Displaying Setting Information”on page 2-22
“3.6.2 Starting the Hardware Configurator and Viewing Operation Logs”on page 3-65

« If you view large linked data files, processing speed may decrease depending on the CPU and RAM.

« If the PC resumes from hibernation, you may not be able to expand the viewer window. If this
occurs, restart the viewer.

* Do not print more than 36500 pages at once from the PC.

* On 32-bit editions (x86), the maximum number of supported channels when displaying 32
million points is as shown in the table below.

Data Type Channel Type Maximum Number of Supported Channels
Display data Math channel 4
Measurement channel 8
Event data Math channel 8
Measurement channel 12

IM 04L61B01-01EN 1-15

jonpouid ay} Buisn alojeg H



1.2 PC System Requirements

1.2.3 Other Requirements
Converting Data to Excel Format

This software can convert data to the format that can be handled by the Excel below.
Microsoft Office Excel 2003, 2007, 2010, 2013 or 2016

Viewing User’s Manual

To view the user’s manual of this software, you need to use Adobe Reader 7 or later by
Adobe Systems.

1.2.4 Security Measures

To deal with security threats, we recommend that you take security measures.

» Apply restrictions to PC network connections.
We recommend that you use an isolated network.

* Manage external media properly.
Prevent malware intrusion through external media, unauthorized file operations on
external media, and information leakage due to misplacement.

» Set a strong password and manage it properly.
Use a password that is at least eight characters in length, and include three types of
characters from uppercase letters, lowercase letters, numbers, and symbols. Change the
password regularly.

 Install antivirus software.
This software has been verified to work on a PC running McAfee VirusScan Enterprise
Ver. 4.8.0.887.
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Chapter 2 Basic Operation

2.1 Starting and Closing Universal Viewer

211 Starting Universal Viewer

Procedure

1 On the taskbar, click Start, All Programs, SMARTDAC+ STANDARD 1 and then
Viewer.
1 If you are using Universal Viewer on Data Logging Software GA10, click SMARTDAC+ Data
Logging Software and then Viewer.

Universal Viewer starts. (No data is displayed initially.)

T Mot asit @ i, B D A O i ¥

| Fnae s

On Windows, you can associate data files to Universal Viewer so that when you double-click
a data file, the file opens in Universal Viewer.

21.2 Setting General Display Options
Changing the Style

To change the screen color, on the View menu, click Style and then Light or Dark. The

default setting is Light.
The style cannot be changed in some windows and dialog boxes.

Changing the Date Format

You can change the date display format to one of the four types below. To do so, on the
View menu, click Date Format.

* YY/MM/DD

+ MM/DD/YY

+ DD/MM/YY

+ DD.MM.YY

Decimal Point

To change the decimal point character in Universal Viewer, on the View menu, click Decimal
Point.

Tool Bar, Search Bar, and Status Bar

To show or hide the bars, on the View menu, click Tool Bar, Search Bar, or Status Bar.
Tool bar and Search bar : P> page 1-13

IM 04L61B01-01EN 21
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2.1 Starting and Closing Universal Viewer

Language

You can change the Universal Viewer’s user interface language by clicking Language under
the View menu.

Nofte

» Before changing the Universal Viewer language, close all files that are open.
» Make sure to use the same language for the recorder (which recorded the data), this software,
and OS.

213 Closing Universal Viewer

1 On the File menu, click Exit. Or, click the x button.
If you have changed the settings, the message “Save changes to file name.***?” appears.

To save the settings, click Yes. Otherwise, click No.
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2.2 Opening a Data File

On Universal Viewer, you can use any of the following methods to open a data file.
» Specify a file name and open the data file

» Drag a data file to open it

» Open a data file from search results

2.21 Specifying a File Name and Opening the Data File

In the Open dialog box, specify the file name, and open the data file.

1 On the File menu, click Open. Or, click Open on the toolbar.

)

File  Wiew Help
F 1 IEIE =

A A B B | 5 Lo g

Pl
E = Open {Ctrl+0)
Open an exsting file

uonesadQ oiseg

The Open dialog box appears.
[% open x|

Lookin: | ), DATADT R N = =

Neme - |-| Dstem.. |-|Type [-|Sze ||
|| 000006_121203_092343 DAE
| 000007_121209_093507.DAE
|| 000008_121209_094507.DAE
D [ 000009 _121209_095507.DAE
PP | | 000010_121209_100507.DAE
E . |_1000011_121209_101507 DAE

] 000012_121209_102507.DAE
SRl | || 000013_121209_103507.DAE
000014 _121209_104507.DAE
| ]000015_121209_105507 DAE Select the
] 000016_121209_110507.0AE _— . .
|| 000027_121209_032950.DAD data file to d isplay.
| 000028_121209_093508. DAD
|| 000029_121209_103508.DAD

: - Click here.
File name: [000016_121209_110507.DAE - = e The fi R

e file will open.
Files of type: [A1 Readable Fie ("GDS: ~GEV: * DAD: ".DAE 7] Cancel P

~ EventFile (Not Damaged)

Device Type  FX1000 Additional Info. |

Serial o 85LC07466 Time Correct  [Nong]
File Message SamplingInt.  1.000 sec

Ch. Count 81010 Trigger Time  2012M2/08 11:08:00.000
DataCount 417 Trigger No. 53

StatTime  2012M2/09 11:05:07.000 Starting Cond. ~ Triggered Restart
StopTime  2012M2/09 11:12:03.000 Dividing Cond.  Manual

Statted by [KeyIn]
Stopped by [KeyIn]

2 In the dialog box, select the file you want to open, and click Open. Or, double-click the
file.

The data appears in the window.

Nofte

» Link information files (.Idx extension) and display condition files (.vdx extension) of Universal
Viewer cannot be opened by themselves. To display files using the conditions saved in a
condition file, the “original data file” must be present in the same folder as the condition file.

» Asuperimposed display condition file (.ovd extension) can be double-clicked to reproduce the
superimposed display.
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2.2 Opening a Data File

Explanation

The Open dialog box consists of the file selection area (top half) and the file information
display area (bottom half).

fso £
Look in: | DATADT j & 5 B~
g Mame = |-| Datem.. [-[ Type  [-|Sze ||
|| 0D0006_121209_092943 DAE
ety | |000007_121208_093507 DAE
| 0D00D8_121209_094507 DAE
D || 00000_121209_095507 DAE

T ] 000010_121208_100507 DAE
- ] 000011_121208_101507.DAE
| 000012_121209_102507.DAE

RATTPEl| L | 000013_121209_103507.DAE . .
|| 000014_121208_104507 DAE — File selection area
A ] 000015_121208_105507.DAE

oy || 000016 121203 110507.0AE
s || 000027_121209_092950.DAD
h‘—? || 000028_121205_093508 DAD

Na\;crk || 0D0029_121209_103508 DAD

File name: [o00016_121209_110507.0A8 =l Open
Files of type: [Ar Readable File ~.GDS: ~GEV: ~DAD; " DAE x| Cance!

[~ EventFile (Not Damaged)
Device Type  FX1000 Adtional no. |
Serial No. S5LCO7466 Time Correct.  [None]
File Message ‘Sampling Int. 1.000 sec
ch. Count 6/0/0 Trigger Time  201212/09 11:06:00.000
DataCount 417 Trigger No. 53 _— .
— File information area
Start Time 2012/12/09 11:05:07.000 Starting Cond.  Triggered Restart
StopTime  2012/12/09 11:12:03.000 Dividing Cond. ~ Manual
Started by [Key In]
Stopped by [KeyIn]
J

File Selection Area

The file selection area has the same structure as a standard Windows open dialog box. The
available data file options are shown below.

Option Description

All Readable File (*.GSD; *.GSE; *.GDS; *.GEV; *.dld; Displays all loadable files

* DAD; *.DAE; *.DBD; *.DBE; *.DSD; *.DSE; *.dds;

*.dev; *.cds; *.cev; *.RXE; *.mld; *.dag; *.dtg; *.Idx;

* GRE; *.d?r; *.GMN; *.DAM; *.dmn; *.rbi; *.GRI; *.DRE)

Display File (*.GSD; *.GDS; *.DAD; *.DBD; *.DSD; Displays only display data files
*.dds; *.cds)

Event File (*.GSE; *.GEV;, *.dId; *.DAE; *.DBE; *.DSE; Displays only event data files
*.dev; *.cev, *.RXE; *.mld; *.daq;)

Logger File (*.dld; *.mld; *.daq;) Displays only Logger data files

TLOG File (*.dtg) Displays only TLOG data files

Link File (*.1dx) Displays only connection information data files
Report File (*.GRE; *.d?r; *.rbi; *.GRI; *.DRE ) Displays report files or hourly, daily, weekly,

monthly data files, Integration data files (/WH)
and demand monitor data files (/WH)

Manual Sample File (*.GMN; *.DAM; *.dmn) Displays only manual sampled data files

Superimposed Display File (*.ovd) Displays only superimposed display condition
files

All File (*.*) Displays all files in the folder

File Information Area

The file information display area shows information about the selected file. You can also
view the detailed information of the data file in the File Information dialog box.
> Viewing Data File Information (section 2.4)

Note

* The information displayed in the information display area of the Open dialog box varies
depending on the data file type.
« If you type a file name, the file information will not be displayed.
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2.2 Opening a Data File

2.2.2 Dragging a Data File to Open It

You can open a data file by dragging the file to the Universal Viewer window.

Procedure

1 From the desktop or Explorer, drag the data file that you want to view in the main
window.
The data appears in the window.

223 Opening a Data File from Search Results
In the Search Open dialog box, search for the data file, and open it.
You can specify the following search conditions.
» Search by time period
» Seach by mark (message)
» Search by channel number, tag number, or tag comment
» Search by batch name
» Search by batch comment
» Search by batch text
» Search by signin status

Procedure

1 On the File menu, click Search Open. Or, click Search Open on the toolbar.

2

File  Aiew Help

S CIEIE =
o :

B B L =

=L
& @ Search Open r

| Search and open the file

The Search Open dialog box appears.

2 Specify the search conditions (1 to 7), and click Search.
For details on search conditions 1 to 7, see “Search Conditions” on page 2-12.
(2) Channel number, tag number, or tag comment
Calendar Specify the folfler

|s:.

(1) Time period [ = |
Fower. Cwsenn 030 Calaien f:]

# inchute Sub Fouer
(3) Mark Sewen Concron: @ &7 Date & T [rem v s m)[e0): [o0]- [ o [o8] - [m]4 0 escwss sgacayoma )

(4)Batchname| “== ==
el ‘

E— T (Haich MG« Lot Ma )
(5) Batch comment ¢ s corme
(6) Batch text —————o e (7o Daacrighen)
|——0" Egnin Slates - [ |
(7) Signin status monoo)|

Lancel

On the File View tabbed page and Link View tabbed page, search results are displayed in
respective groups (in groups of files and linked files).
If there is no folder in the search range, the error “No such folder” will appear.

uonesadQ oiseg
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2.2 Opening a Data File

3 If you want to adjust the search result display, carry out the following operation.

When the pointer changes to <=
on the border line, drag to change the display width.

Show button of
search items

|

Y CLLLL
File Hame \&|JDevice Type Serial Ho. | Kind | Start Time:
B e

File Hame =
|

Device Type

S|
Serial Ho. @ Kind |
|

Start Time |

Click the title to switch between ascending and descending sort order

Hide button of the search item

* Move the cursor over a display button to show the item title in a tooltip. Click the button

to display the corresponding search results.

« If you move the cursor over a title, a hide button appears. Click it to hide the item. You

cannot hide the File Name.

« If you click an item title, a sort icon will appear. Click it to change the sort order
between ascending and descending.

4 From the search results, double-click the file you want to open; or select the file, and

click Open.

Explanation

Search Conditions

The data appears in the window.

(1) Searching by Time Period
You can specify a search period to perform the search.

You can specify dates by clicking the arrow and using the calendar that appears or selecting

and entering the numbers directly.
The selectable range is from “1990/01/01 00:00” to “2037/12/31 23:59.”

When you specify a period, if any section of a file overlaps with the search period, the
file appears in the search results. For details on the search operation when the Exclude

specified time check box is selected, see example 5.
Below are several examples for different search periods.

Example 1. When consecutive data files A to E all exist

| File A |

File B

File C

File D

| File E

Files B, C, and D will appear on the file view tabbed page.

Search period

If the files are linked, files A to E are detected as a single unit and displayed on the link view

tabbed page.

Example 2. When a portion of the linked files does not exist and the search period is

within that portion

File A

File B

File C
Missing

File D

File E

No files are displayed on the file view tabbed page.

Search
period

If the data files are linked, no file links are displayed on the link view tabbed page.
However, in the case of a batch file, files A to E are detected as a single unit and displayed
on the link view tabbed page.

2-6

IM 04L61B01-01EN



2.2 Opening a Data File

Example 3. When a portion of the linked files does not exist and the search period
includes that portion

File A File B File C File D File E
Missing

| Search period |

Files B and D, which overlap the search period, are displayed on the file view tabbed page.
If the files are linked, the unit consisting of files A and B and the unit consisting of files D
and E are displayed on the link view tabbed page. In the case of a batch file, files Ato E are
detected as a single unit and displayed on the link view tabbed page.

Example 4. If the time was changed in the middle of recording

Time changed on the GX/GP

Start 4:00:00 6:00:00—10:00:00 12:00:00 14:00:00
FileA | File B | File C File D | File E |

Start time will be 8:00:00. End 14:00:00

—+ Computation * ﬁ}

| File A | File B | File C | File D | File E

If the time on the recorder was changed during recording, the timestamps of data entries are
calculated in reference to the last data entry position. As shown above, if the time is changed
from 6:00:00 to 10:00:00, the original timestamps from 4:00:00 to 6:00:00 are assumed to
be 8:00:00 to 10:00:00. These timestamps are used in the search, so if you set the search
period as 5:00:00 to 6:00:00, nothing will be detected. If you set the search period as
8:00:00 to 9:00:00, files will be detected and displayed on the link view tabbed page.

Example 5. If the Exclude specified time check box is selected

If you specify a time range from 8:00 to 10:00, a file whose stop time is 8:00 or a file whose
start time is 10:00 is not included in the search result.

(2) Searching by Channel Number, Tag Number, or Tag Comment

From the list box, select Channel No., Tag No., or Tag Comment, and then enter the
character string you want to search for. Data files that contain the string will be displayed in
the search results.

You cannot specify a character string that includes a space.

(3) Searching by Mark (Message)

Select the Mark (Message) check box, and enter the character string you want to search
for. The first 70 characters of the string are valid. The search string is not case sensitive.
Spaces, even if entered, are ignored. When a search is executed, data files in which the
search string is included are displayed. Only the marks that have been entered on the
recorder (the device that created the file) can be searched. Marks added on the viewer are
not searched.

(4) Searching by Batch Name

Select the Batch Name check box, and enter the batch number and lot number.

You can also search by specifying only the batch number or only the lot number. If you
select the check box and leave both the batch number and lot number blank, data files that
include batch information will be displayed in the search results.

IM 04L61B01-01EN 2-7
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2.2 Opening a Data File

(5) Searching by Batch Comment

Select the Batch Comment check box, and enter the search character string. The first 96
characters of the string are valid. Spaces, even if entered, are ignored.

When a search is executed, data files in which the search string is included in batch
comments 1, 2, or 3 are displayed. The search result displays columns for batch comments
1,2, and 3.

(6) Searching by Batch Text

Select the Batch Text check box, and enter the search character string. The first 23
characters of the title and 96 characters of the description are valid. Spaces, even if entered,
are ignored. The search string is not case sensitive.

Note

You can view batch information and batch text by selecting About Document from the Information
menu. P> section 2.4.1, “Displaying File Information”

(7) Searching by Signin Status

Of the data files that include signature information, data files with the selected signin
statuses are searched. From the list, select the signin status you want to search for.
The available options and their descriptions are shown below.

Option Description

1No sig. Files without Signature 1

2No sig. Files without Signature 2

3No sig. Files without Signature 3

None signed Files without Signature 1, Signature 2, or Signature 3
Signed Files with Signature 1, Signature 2, or Signature 3
Signed All Files with Signature 1, Signature 2, and Signature 3

When the search is performed in units of file links, file links whose last file meets the search
conditions are detected.

2-8
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2.2 Opening a Data File

Displaying Search Results

In the Search Open dialog box, search results are displayed on two tabbed pages.

File View Tabbed Page

Search results are displayed at the file level.

. . w
Link View Tabbed Page -
. __— . o
Search results are displayed at the file link level.* Files are searched separately, and then o
linkable files are linked and displayed. k]
*: A*file link” means a set of data files that are linked and treated as one unit. b
~-
File View Tab — Link View Tab g
[ sosreh oppm
Foader. |eatrsersing WDocuments 00 Datatlesix_DATAD_sctvF)s_GLY | [ g ]
—F7 kockada Jub Fukdur 3
Search Chodien: B Daste & Tjme: 1w o x| foo|:fool- (207 s 0ai s = .ﬂl L5 [ Excuide speciey tme )
L1 cnm
[ Markibebsage Search condition
] Sk b : (Bate Ha. - Lot e} setting area
[ Bistcs Cmment:
] Batcs ret (Tithe : Descripbon)
[ 1 Signin Efssay - Ernrh )
ﬁii ( Link View )
[kt Gl leals]
File Name: ‘j Devies Type | interval | Srart Time Batch Name | [
| 000001_120912_061076 GEW [=F0 1000 Wone
Q00001 120913 170245.G0% Ln}::l‘l 1000 ! 3 'ia::
o s Ptavnzos e e Search result
o — fot = | [ display area
oxin 1000 i1 17 02 4T 000 Hone
1 GX10 1000 FNZ0STS 170507000 Hane
0000412051 T EROT GEV [l 1000 209209410 17 18 0T 000 - Hone
000005 _ 120391 s GX2D 1000 ZNZNEN0 1328:41.000 201209410 13:29:29.000 000000 None
DODOOS_120812_152727 GFV, 000008_ GX30 1008 JB1T0AM T 1537 31 000 20170617 153558 000 MHone
[T

@uw lagrated Bk view Obﬂw dual ieberval intagrated bk view ( ) Cancel )
l

|— Show dula interval integrated link view

Show integrated link view

+ If you select Show integrated link view, files are linked first, then search conditions are

applied, and the result is displayed.

+ If you select Show dual interval integrated link view, files measured in dual interval mode

are also linked and displayed.

Note

» Show integrated link view and Show dual interval integrated link view can be turned on and off
separately.

* Files can be linked only within the same folder.

* There are three types of data files measured in dual interval measurement mode depending
on the combination of the recording mode: Free+Free, Free+Trigger, and Trigger+Trigger.
This software can only recognize Free+Free files as “file pairs measured in dual interval
measurement mode.
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2.2 Opening a Data File

Search Results of Show Dual Interval Waveform Integrated Link View

If you select Show dual interval integrated link view, data files acquired in dual interval
measurement mode are linked and displayed.

Here we assume the following files are searched and show examples of displayed results.

Files 1 to 3 acquired at interval 1 and files A to | acquired at interval 2 are in the same
folder.

The search range is between files 1 and 2.

Interval 1 (1 sec)(Free) 1 2 3

Interval 2 (100 ms)(Free) | A | B][ ¢ | b [[E] F | e | H [ I

[« Search period >

The number of data points in files and start and end times are as shown in the
following table.

File Name Interval Data Count  |Start Time Stop Time
1.GSD,..,3.GSD 1sec 10800 2015/12/25 10:00:00 [2015/12/25 13:00:00
A.GSD,...,I.GSD 100msec 108000 2015/12/25 10:00:00 [2015/12/25 13:00:00

When Show dual interval waveform integrated link view is set to off

The search result list is displayed as follows:

File Name Data Count Interval Start Time Stop Time
1.GSD,..,2.GSD 7200 1sec 2015/12/25 10:00:00 [2015/12/25 12:00:00
B.GSD,..,.E.GSD 48000 100msec 2015/12/25 10:20:00 |2015/12/25 11:40:00

When Show dual interval waveform integrated link view is set to on

Files 1 and 2 from interval 1 and files B to E from interval 2 are paired. Search results
are consolidated and displayed in a single row. In this example, the search start time is
the start time of file 1 and the search end time the end time of file 2.

File Name Data Count |Interval Start Time Stop Time
1.GSD,.../B.GSD,... — 1sec/100msec |2015/12/25/ 10:00:00 [2015/12/25 12:00:00

If you double-click this list and display it, files 1 and 2 are linked, files B to files E are
linked, and they are displayed as waveforms in separate windows.

When Show dual interval waveform integrated link view and Show integrated link
view are both set to on

If Show integrated link view is also selected at the same time, the search result is
displayed as follows:

File Name Data Count |Interval Start Time Stop Time
1.GSD,.../A.GSD,... — 1sec/100msec |2015/12/25 12:00:00 [2015/12/25 13:00:00

If you double-click this list and display it, files 1 and 3 are linked, files A to files | are
linked, and they are displayed as waveforms in separate windows..

210
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2.2 Opening a Data File

The table below shows the displayed search result items and their details. Descriptions in
brackets are the displayed contents when Show dual interval waveform integrated link view
is selected.

Display Item

Display Details

Description

File Name

File name including the
extension.

[File name with the
beginning of the interval

1 file name and the
beginning of the interval 2
file name concatenated]

For linked files in dual interval measurement mode, the file
names are displayed as follows:
1.GSD,.../2.GSD,....

Model

Model that sampled the
data

Serial No '

Serial number of the
instrument that sampled
the data

uonesadQ oiseg

Type '

Display or event

Data file type

Interval

Interval
[ Interval 1, Interval 2]

Process Type '3

Batch, Continuous, —

Recording process
A dash is displayed if there is no information.

Data Count '

Data count

The number of data entries from the first data entry of the
first file to the last data entry of the last file. This includes
power-failure data entries and missing-file data entries.
However, data entries of missing files at the front and end
are not counted.

Start Time

Data start time

Displays the time of the first data entry of the first file.
[Displays the earlier of the start times of interval 1 and
interval 2]

Stop Time

Data stop time

Displays the time of the last data entry of the last file.
[Displays the later of the end times of interval 1 and interval
2]

Batch Name

Batch name

Adash is displayed if there is no batch information.
[Displays the batch name if the batch names are the same
or a dash if they are not]

Batch Comment '

Batch comments 1, 2,
and 3 that include the
specified character string
are displayed

Status Data file status (normal If the file is corrupt or the data is erroneous, an error is
or error) displayed.
[Displays an error if either interval file is in error]
Duplicate ? Yes or no Displays whether there are duplicate files.
[Displays “Yes” if either interval file has duplicate files]
File Missing ? Yes or no Displays whether there are missing files in the batch.
[Displays “Yes” if either interval file has missing files]
Signature 1 No sig., pass, fail, or “—” No sig.: Not signed.
Signature 2 [—] Pass: Signature result is pass.
I Signature 3 Fail: Signature result is fail.
Signin . ) : )
Status : — No signature mforma.tlon : :
Sig. 1 User Name User name, or “—’ Displays the user name if already signed. Displays a dash
Sig. 2 User Name [—] if there is no signature information.
Sig. 3 User Name
1 Not displayed by default.
2 Displayed only on the link view tabbed page.
3 In GX/GP, “Process Type” is called “Sign in type,” and “Continuous” is called “File.”
4 Dual interval measurement mode and advanced security function cannot be used simultaneously. As such,

Nofte

If a time change occurs in a data file, it may not appear in the search results. For details, see

dual interval files do not contain signature information.

Search Conditions” on page 2-11.
» Linking selected files: P23 Linking Data Files”
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2.2 Opening a Data File

Displaying Consecutive Data That Exceeds 32 Million Points

Universal Viewer cannot display consecutive data that exceeds 32 million points (e.g., a data

file sampled at 1 second intervals over one year) in the same window.

If you open such data from the search results, the data is automatically divided according to

the following conditions and displayed in multiple windows.

» The first division contains data from the first file up to the file that results in a number of
points as close as possible to, but not exceeding, 32 million points. The number of data
points in this calculation includes those of missing files and those during power-failure
periods.

* In the first division, when the 32 millionth point falls on a power-failure period, the end of
the file before the file containing this power-failure period will be the break point.

* In the second division, the file or the missing file following the first division will be used as
the first file in the division. From this point, the above rule is applied repeatedly.

Note

» The divided pieces of data are displayed in order from the last piece.
« If there is not enough RAM on the PC, a portion of the data may not be displayed.
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2.3 Linking Data Files

Files that have been divided by recorders’ auto-save feature or due to power failures can be
linked for display. There are two ways to link files. One is to use the menu bar or toolbar.

The other is to use the File Configuration dialog box.
*: Files whose recording was stopped cannot be linked.

2.31 Linking Files Using the Menu or Toolbar
You can use menu commands or buttons on the toolbar to link data files.
Only the files in the same directory can be linked.

Procedure

1 On the File menu, click Open. Or, click Open on the toolbar.

2

File  Wiew Help

s =

Al AB. B o Fig gl

4
B = Open (Ctrl+0}
Open an exsting file

The Open dialog box appears.

[[-= open =i
Lookin: [ | DATAD1 = e mck -
Nome - |-| Datem || Type [-|Ses |-
] 000006_121209_092949.DAE
RN | | | 000007_121209_093507.DAE
[ 000008_121209_094507.DAE
E L 000003 _121209_095507.DAE
Deskiop L1000010_121209_100507.DAE

[l 000011_121209_101507.0AE
[ 000012_121209_102507.DAE
PP [ 000013_121209_103507.DAE
i L 000014_121209_104507.0AE
|_]000015_121209_105507.DAE 1 T

Rl o o vrone — | Select the first file.
g | 000027_121209_092950.0AD
A | 000028_121209_093508.DAD
i || 000029_121209_103508 DAD

Network

Fil niame: [ononie_121209_110507.088 = o +—— Click here.
Fles of type: [A1 Readatle Fie .GDS; " GEV: ~.DAD: " DAE; =] Cancel The file will open.

|- Event File (Not Damaged)

Device Type  FX1000 Additional Info |

Serial No. S5LCO7466 Time Correct.  [None]

File Message SamplingInt.  1.000 sec

Ch. Count 610/ 0 TriggerTime  2012112/09 11:06:00.000
DataCount 417 Trigger No. 53

StartTime  2012/12/09 11:05:07.000 Starting Cond.  Triggered Restart
StopTime  2012/12/09 11:12:03.000 Dividing Cond.  Manual

Started by [KeyIn]
Stoppedby  [Keyln]

2 In the dialog box, select the first data file that you want to link, and click Open.
Or, double-click the file.

The data appears in the window.

3 From the File menu, click Link Previous File, Link Next File, or Link All Files. Or, on
the toolbar, click on one of the following buttons.

Link Previous File: Links the file before the currently displayed file
Link All Files: Links all the files before and after the currently displayed file
Link Next File: Links the file after the currently displayed file

= wmE ot okt 2 2| FEE 8 2 | 0 S B BE | B EE B FYARTRT S LN
File—Link Previous File J
File—Link All Files
File—Link Next File

The files will be linked together.
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2.3 Linking Data Files

Link Dual Interval Waveform

Paired data files with different intervals using the dual interval measurement mode (GX/GP/
GM) can be linked with all previous and subsequent files and displayed in two windows.
The second window is displayed using the display format of the file displayed earlier
(waveform, digital, circular, or list).

1

2

Select the first data file that you want to link, and click Open. Or, double-click the file.
The data appears in the window.

On the File menu, click Link dual interval waveform. Or, click the 2 putton.

A separate window opens, and the files of the other half of the pair are displayed.
The files are displayed in the same format as the first file (file opened earlier).

Explanation

There are three types of data files measured in dual interval measurement mode depending
on the combination of the recording mode: Free+Free, Free+Trigger, and Trigger+Trigger.
This software can only recognize Free+Free files as “dual interval file pairs.”

Link dual interval waveform is described using the following three examples. We assume the
first data file is file 2 of interval 1.

1. Files 1to 3 and also files Ato | are linked and displayed in separate windows. Even if
any of the files from A to | is missing, the files are linked and displayed.

Interval 1 (1 sec) (Free) 1 2 3
AlBlc|p|lEe|[F]e]H] 1

Interval 2 (100 ms) (Free)

2. Files 1to 4 are linked, but because “Free+Trigger” was used to acquire data, files Ato F
and G to | are not considered the other half of the pair and are not displayed.

Interval 1 (1 sec) (Free) | 1 | 2 | 3 | 4 |
[A[Blc|pf[efF] [GH] 1]

Interval 2 (100 ms) (Trigger)

3. Because there are no files that can link to file 2, no files are linked. And because
“Trigger+Trigger” was used to acquire data, the files of the other half are not displayed
either.

Interval 1 (1 sec) (Trigger) | 1 | | 2 | | 3
Lalls] [c] [of[F] [E]

Interval 2 (100 ms) (Trigger)

When Link All files or Link dual interval waveform is in use, files before the first file are linked

with the following precedence.

 File after the start file to the last file are linked.

» File before the start file to the last file are linked.

* When Link dual interval waveform is in use, files in the other half of the pair are linked
from the beginning to end. However, if a file in the group of files in the other half is already
displayed, the display ends before that file. (See 4 on the next page.)

4. When file 2 and file F are open, if Link dual interval waveform is performed from file 2,
file 3 and then file 1 are linked. Then, files A to E of the other half of the pair are linked,
file F, which is already displayed, is activated, and the link operation ends.

Displayed
Link2 | Link1
/_H /_H
Interval 1 (1 sec) (Free) 1 2 3
Interval 2 (100ms) (Free) | A| B|c [ D|E|[F|c|[H ||
Link 3
Displayed

2-14
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2.3 Linking Data Files

2.3.2 Linking Files from a Dialog Box

You can link data files using the File Configuration dialog box.

You can link previous and subsequent data files while looking at the status of the displayed
data file.

If a file is displayed via GA10, the display target file configuration is the data folder on

the server side. Files on the GA10 server side are downloaded to a temporary folder and
displayed, but the folder is deleted when the viewer is closed.

Procedure

T Open the first file that you want to link.
From the Window menu, click File Configuration.

The File Configuration dialog box appears.
Link icons are displayed next to the files that comprise the data file that is currently displayed.

Prev Click Make.

Link the previous file.

Save destination folder—

Lack

[~ Displays components and link candidates
Next All Timestamp of Timestamp of
Link the next file. Link all files. the first data entry the last data entry

Missing file

Data file component
currently displayed

Link icon

Link candidate files {

Holdef:D:\Users! \Desktop\PATAD
( ] [ ] Tiake Al
21616004, dbe 2009/12/15 15:00:00,125 2009412715 16:00:00.000
21516004, dbe 2009/12/15 16:00:00.125 2009412715 17:00:00.000
&= 21517009, dbe 2009/12/15 17:00:00.125 200941215 18:00:00.000
&= Lack
&= 21520009, dbe 2008/12/15 20:200:00.125 2009/12/15 21:00:00.000
&= 21521004, dbe 2008,/12/15 21:00:00,125 2009412715 22:00:00.000
15210034, dbe 2009,/12/15 21:00:00.125 2009412415 22:00:00.000 — Duplicate
&= 21522004, dbe 2009,/1215 22:00:00.125 2009/12/15 23:00:00.000 data files
15220034, dbe 2009,/12/15 22:00:00.125 200912715 23:00:00.000 (orange)
&= z1523009. dbe 2009,/12/15 23:00:00.125 2009/12/16 00:00:00.000
= 21800004, dbe 20091216 00:00:00,125 2009412716 01:00:00.000
E@Sz]ﬁﬂlﬂﬂﬁ.dbe 2008/12/18 01:00:00.125 2009/12/16 02:00:00.000
Lack
1604003, dbe 2009/12/16 04:00:00.125 2009412716 05:00:00.000
1605003, dbe 2009/12/18 05:00:00.125 2009/12/16 0B:00:00.000 -
2. Click Make.

The link candidate files is displayed.

3 Click Prev, Next, or All to link the appropriate files.

Prev: Links the previous file
Next: Links the next file
All: Links all files

The relevant files will be linked together.

Explanation

The File Configuration dialog box shows the folder containing active data files and the
information of those files.

File Configuration

The background of the names of active data files is gray, and link icons == are shown next
to the names.

Duplicate Data Files

You can identify duplicate data files in the same folder (files with different names that contain
the same data).
The background of the names of duplicate data files is orange.

IM 04L61B01-01EN
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2.3 Linking Data Files

Missing Data Files

You can identify which data files are missing from the set of data files that is currently
displayed.

The names of missing data files are indicated as “Lack,” and the background is gray.
Information about how many files make up a missing section is not displayed.
Information about missing data files before and after the set of data files that is currently
displayed is not displayed.

Candidate Data Files for Linking

Candidate data files that can be linked to the set of data files that is currently displayed are

displayed. The background of the names of candidate data files is gray. Link icons are not

displayed.

Candidate files are those that meet the following conditions.

» The data file is a component of a single recording data file that is also composed of the

data files that are currently displayed.*
» There will be no missing data when the data file is linked.
» The recording data file is in the same folder as the data files that are currently displayed.
*: Asingle recording data file is composed of data files that are created through one recording

session (from recording start to recording stop). Files whose recording was stopped cannot be
linked.

Linking Data Files

You can link data files by linking the previous file, linking the next file, or linking all files.
When you link the previous file, the file containing data before the active data is linked.
When you link the next file, the file containing data after the active data is linked. When you
link all files, all candidate data files are linked.

2-16
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2.3 Linking Data Files

233 Saving Link Information Files
You can save the link information of the linked data files that are currently shown.

Procedure

1 After linking data files in the File Configuration dialog box, from the File menu, click
Save Display Setting As.

=)

File | Edit Timedxiz Y-fxis
& Open.
E‘i Search Open..
Cloze
B Save Display Settine
Save Dizplay Setting He.

A Save As dialog box appears.

2. Click Save.
The link information file is saved in the same folder as the individual files.
The file name will be the original file name with the .Idx extension. You can also specify a different
name to save the file.

Nofte

» Files with the .Idx extensions contain link information and display conditions. To open the
files again in a linked condition, the original data files must be in the same folder as the link
information file.

« If there are missing files in the middle of a batch data file, you cannot save the link information
file.

» To save the link information file, use the Save Display Setting As command. Using Save Display
Setting will not save the link information file (*.Idx).

» For details on saving display conditions, see section 4.1, “Saving Display Conditions”.
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2.4 Viewing Data File Information

You can view information on active data files by selecting About Document from the

Information menu. You can also specify the header information that is printed.
» 43 Printing” on page 4-6

241 Displaying File Information

1 On the Information menu, click About Document....

Universal Viewer

tert | Information | Sienature  Help

g About Document... »
Setting Informat ion.[..%

The Basic Information tabbed page of the File Information dialog box appears.
Display Data File or Event Data File

Basic bl
& Fie Hame ADDOMS_ 150808 136338 GO%
W7 Devien Tyee Gx1n
& Seraiiis
& e Message
7 Time Correct tang
B starng Cond. Manus
& Diviang Cona. Yanuw
& messcn 4
b wamcn a
& commen L]
& Data Count “
& sampie ve 2050 sec
& Start Tiee 20150826 135238 000 (UTC0R 00)
&4 Siop Time D01S/0826 13.54.08 000 (UTC08 00)
W Trigger Tem 2015/082% 13:54.08.000 (UTC08.00)
57 Trigger Mo “
7 Damage Check it Comaged
F Siarted by oy ]
7 Siopped by ey i)
&7 Caltention Carrested Ch Hone
& comment

oK cancel |

Copying Calibration Correction Settings to the Clipboard

This operation is performed on the Calibration Correction tab.

2 Click the Copy button.

The settings on the Calibration Correction tabbed page are copied to the Clipboard in text format.
You can paste it to another application and use it.

Copy button
Print button

1
2
1
i

2 R8T L) 2881 62150 20000 2 8300 B.ang
o 0230 22222 00050 - - 1200

Printing the Calibration Correction Settings

This operation is performed on the Calibration Correction tab.

3 Click the Print button.
The settings on the Calibration Correction tabbed page are printed.
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2.4 Viewing Data File Information

Explanation

The File Information dialog box consists of multiple tabbed pages.

The following tabbed pages appear only when there is information to be displayed.
» Batch Info. tabbed page

» Batch text tabbed page

+ Signature Info. tabbed page

» File Comment tabbed page

+ Calibration Correction tabbed page

On each tabbed page, items that do not have information to display are hidden, and
subsequent items are shifted up.

On each tabbed page, items whose check boxes are selected will be used as headers in
printouts.

Items on the Basic Information Tabbed Page

Item Description

File Name File name

Process Type ' Process type during recording (batch, continuous)

Device Type Model that sampled the data

Serial No. Serial number of the instrument that sampled the data

File Message File message that was added during recording

Time Correction Whether the time was corrected during recording

Starting Cond. Start conditions for recording (manual, restart after blackout, auto, triggered
restart, running, over write, FPGA, unknown)

Dividing Cond. End conditions for recording (manual, black out, auto, triggered stop, running,
data count, interrupted, FPGA, unknown)

Meas Ch. Number of measurement channels on the instrument that sampled data

Math Ch. Number of math channels on the instrument that sampled data

Ctrl Ch. Number of control channels on the instrument that sampled data

Ext. Ch. Number of extension channels on the instrument that sampled data

Comm Ch. Number of communication channels on the instrument that sampled data

Data Count Data count

Sample Int. Sample interval (s)

Start Time Start time of recording For data files recorded on the GX/GP/GM/GA10,

Stop Time Stop time of recording time zone information is shown in parentheses.

Triggered Time Time of trigger

Trigger No. A relative number of the data at the triggered time in reference to the first data

entry of the first file (if there are missing files in the middle of a batch file, the
data entries in the missing sections are counted)

Damage Check Data file status (normal, error)

Internal Data Whether there is data that was saved through key operation (yes, no)

Cali(Br?t)ion Corrected|Names of channels on which calibration correction was performed

Ch.Note

Started by User that started recording, or the started condition. (See the table on the next
page.)

Stopped by User that stopped recording, or the stopped condition. (See the table on the next
page.)

Comment Comment for printouts (up to 128 characters)

1

Nofte

In GX/GP/GM, “Process Type” is called “Sign in type,” and “Continuous” is called “File.”

In case the active data file is made by GX10, GX20, GP10, or GP20 (those of firmware version
1.xx), the information for the Calibration Corrected Ch. is not displayed. We recommend that
you update the recorder firmware to the latest version.

Items on the Basic Information are not always displayed depending on the recorder model or
the information the file includes.

For data files recorded by DAQLOGGER or DAQ32PIlus/DAQ32, “Start Cond” and “Dividing
Cond” are displayed as “—” and “Started by” and “Stopped by” as “None.”

IM 04L61B01-01EN

uonesadQ oiseg



2.4 Viewing Data File Information

Items and Descriptions of Start by and Stopped by

Item Description
Key In Start or stop through key operation (touch operation) on the main unit
Remote In Start or stop through remote control
Comm. In Start or stop using a communication command
Event In Start or stop through event action
System In Start or stop through auto control
Serial In Start or stop through control via serial communication
EXTERNAL Start or stop through Modbus or other control
WEB Start or stop through the Web application
Data Count Stop according to the specified data count
Running Power failure, auto save, end of sampling
Username The name of the logged-in user that performed start or stop
None None
Unknown Input other than above
None Data files recorded by DAQLOGGER or DAQ32Plus/DAQ32

Items on the Batch Info. Tabbed Page

Item Description
Batch No. Batch number
Lot No. Lot number
Comment 1 The user who entered comment 1, the time when it was entered, and the content.

If the device that sampled the data is a yR10000 or pR20000, “Start Printout1” is displayed.

If start printout is not assigned, “End Printout1” is displayed. If neither is assigned, nothing is
displayed.

Comment 2 The user who entered comment 2, the time when it was entered, and the content
If the device that sampled the data is a yR10000 or uR20000, “Start Printout2” is displayed.

If start printout is not assigned, “End Printout2” is displayed. If neither is assigned, nothing is
displayed.

Comment 3 The user who entered comment 3, the time when it was entered, and the content
If the device that sampled the data is a yR10000 or uR20000, “Start Printout3” is displayed.

If start printout is not assigned, “End Printout3” is displayed. If neither is assigned, nothing is
displayed.

Items on the Batch text Tabbed Page

Item Description

Title Title string of the batch text

If the device that sampled the data is a yR10000 or uR20000, “Start Printout1” to “Start
Printout5” are displayed for Title1 to Title5. And, “End Printout1” to “End Printout5” are displayed
for Title6 to Title10.

Description String of the batch text description

If the device that sampled the data is a yR10000 or yR20000, “Start Printout1” to “Start
Printout5” are displayed for Batch Text1 to Batch Text5. “End Printout1” to “End Printout5” are
displayed for Batch Text6 to Batch Text10. If neither is assigned, nothing is displayed.

Items on the Signature Info. Tabbed Page

Item’ Description

Signature 1 The signing time of signature 1, user that signed, and signing result (no sig.,
pass, fail)

Signature1Comment |Comment at time of signature 1

Signature 2 The time of signature of signature 2, user that signed, and sign result (no sig.,
pass, fail)

Signature 2 Comment |Comment attached to the signature of signature 2

Signature 3 The time of signature of signature 3, user that signed, and sign result (no sig.,
pass, fail)

Signature 3 Comment |Comment attached to the signature of signature 3

* If sign in titles are specified on the recorder, they are displayed instead of “Signature 1,” “Signature
2,” or “Signature 3” for the files created on the GX/GP.
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2.4 Viewing Data File Information

Items on the Calibration Correction Tabbed Page

The calibration modes and calibration values of all channels that are using calibration
correction are displayed.

Mode Displayed value

Linearizer approximation
Linearizer bias

Input values, Ouput values

Correction factor Uncorrected value, Instrument correction factor, Sensor correction
factor

Items on the File Comment Tabbed Page

Comment titles and strings are displayed for data files. Comments 1 to 8 in data files created
by Data Logging Software GA10 (*.dld) and those created by DAQLOGGER (*.mld) are
displayed.

A File Comment tab is not displayed for data files created by DAQ32Plus/DAQ32.

TLOG File Information Dialog Box
If the data file is a TLOG file, the TLOG File Information dialog box appears.

Fle Information B

W File Hame 1 22321509.dtg

M Device Type : DX100P

b serial No. . 12A718723

W File Message :11-5

p Meas ch, 4

M Math ch, o

M Interval Up ;400

M TLOG Start o 200812122 12:29:52.625

¥ Damage Check : Not Damaged

I Timer No. 1

I Comment : | |
I 0K ] I Cancel I

The following items are displayed. Use the check boxes in front of the items to specify the
items you want to print.

Item Description
File Name File name
Device Type Model that sampled the data
Serial No. Serial number of the instrument that sampled the data
File Message File message that was added during memory sampling
Meas Ch. Measurement channels on the instrument that sampled data
Math Ch. Math channels on the instrument that sampled data
Interval Up Data sampling count of the data file
TLOG Start Start time of memory sampling
Damage Check Data file status (normal, error)
Timer No. Timer numbers displayed on active tabbed pages on the TLOG file
display window
Comment Comment for printouts (up to 128 characters)

IM 04L61B01-01EN
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2.4 Viewing Data File Information

2.4.2

Displaying Setting Information
Selecting Setting Information from the Information menu starts Hardware Configurator from
this software* and displays the setting information of the data file that is displayed. The
following example is for a GX/GP/GM data file.

* A Hardware Configurator that supports the data file must be installed in advance. The setting
information that is used during data acquisition can be displayed for display data files and event
data files that use the advanced security function (/AS option). (See Note.)

Related item: section 3.6.2, “Starting the Hardware Configurator and Viewing Operation
Logs”

Procedure

1 Display the data file in the window.

2 On the Information menu, click Setting Information....

| Information
! About Document...
|

Setting Information. ..

SMARTDAC+ Hardware Configurator starts and displays the device settings.

el @ 2 e
§

3
[
(4

Note

» Hardware Configurator is a software application for creating setup data for the recorder. If
the application is not installed in the same PC as Universal Viewer, the Setting Information
command cannot be used.

» The appropriate Hardware Configurator varies depending on the device that collected the data.

Model Hardware Configurator File Type (Extension)
GX10, GX20, GP10, GP20, GM10 with the SMARTDAC+ STANDARD *.GSD, *.GSE

/AS option (*.GSD, *.GSE) Hardware Configurator

DX1000, DX2000 with the /AS1 option DXA120 DAQSTANDARD *.DSD, *.DSE

(*.DSD, *.DSE) Hardware Configurator

DX100P, DX200P (*.dbd, *.dbe) DXA120 DAQSTANDARD *.dbd, *.dbe

DX-P Hardware Configurator

Install DXA120 DAQSTANDARD Hardware Configurator in the same folder as Universal Viewer.
To specify the installation folder, set Setup Type to Custom. Universal Viewer is installed in the
following default folder.
System drive: \Program Files\Yokogawa Electric Corporation\SMARTDAC+ STANDARD
Universal Viewer\

« For details on how to use Hardware Configurator, see the relevant user’s manual.

2-22
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2.5 Signing Data Files

251 Applicable Models and Files

You can include signatures (approval information) in the following files.

Model Data File Name Extension
GX10, GX20, GP10, GP20, GM10 *.GSD, *.GSE

DX1000, DX1000N, DX1000T, DX2000, DX2000T *.DSD, *.DSE

DX100P, DX200P *.dbd, *.dbe

2.5.2 Operation Overview
You can sign data files by performing the following three steps.
Step 1. Check the data
Step 2. Log in to the data files
Step 3. Sign the data files

Data File Type and Signing

There are two types of data files: batch data and continuous data.

Batch data refers to data recorded with Process Type set to Batch.

You can collectively sign all the data files that have been saved from the start to the end of
recording.

Continuous data refers to data recorded with Process type set to Continuous. You sign each

data file.
* In GX/GP/GM, “Process Type” is called “Sign in type,” and “Continuous” is called “File.”

Checking the Data

First, you need to open the data files and check their content. For batch data, you need to
open all component data files and check them. For continuous data, you need to open the
data file you want to sign. You can also sign multiple consecutive data files simultaneously.

Logging In to the Data Files

Log in to the data files using the user information contained in the data files. If you are using
the password management function, log in using the user information registered on the KDC
server.

User Invalidation due to Login Failure

If you fail to log in the specified number of times, the user account is invalidated. You cannot
sign using an invalidated user. If you close the login dialog box before the user is invalidated,
the number of failures is reset.

Nofte

You can sign a unit of data when:
» You are logging in as a user with signature privileges.
* The data has not already been signed in the same place.
* A signature with the same privilege can only be attached once. You cannot overwrite a
signature.
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2.5 Signing Data Files

253 Signing In

1 On the Sign in menu, click Sign in. Or, click the corresponding button on the toolbar.
The Signature dialog box opens.

2 Fill in the User Name, User ID, and Password boxes, and click OK.

Signature @

User Name:

User ID:

Password:

f oK ] [ conce |

An Apply signature dialog box opens.

3 Select Signature No. and Result, and fill in the Comment box (up to 32 characters).
Click OK.

Apply signature[000065_140410_154545.GSE] =]

User Hame: User001

Signature No.. . Signature1
‘& Signature2

% Signatured

Result: @& Pass ‘o Fail

Comment: |

f oK ] [ conce |

If the target file is a single file
A confirmation dialog box appears. Click OK. The Apply signature dialog box closes.
You are finished.

If multiple files have been signed collectively
A Check signature files dialog box opens. Proceed to step 4.

Check signature files =]
All signable files are listed below Do you want to sign all possible files?
User Name: User001
Signature No.: Signature1
Result: Pass
Comment: sample data
Folder: C:Users\00110996\Documents\0_Job_ongeing\20140319_ViewerDatafiles\GX\20140410

000066_140410_154516.GSE
000067_140410_155313.GSE
000068_140410_160313.GSE
000065_140410_161313.GSE

000070_140410_162313.GSE
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2.5 Signing Data Files

4 Check the signature information in the Check signature files dialog box, and click OK.
The Apply signature and Check signature files dialog boxes close, and a Signature results dialog

box opens.

Signature results

User Name:
Signature No.:
Result:
Comment:

Folder:

The signature results are indicated below.

User001
Signature1
Pass

sample data

CAUsers\00110996\Documents\0_Job_ongoingi201403158_Viewer\Datafiles\GX\20140410

(=]

000066_14041

.GSE

000067_140410_155313.GSE
000068_140410_160313.GSE
000065_140410_161313.GSE
000070_140410_162313.GSE

Succeeded
Succeeded
Succeeded
Succeeded
Succeeded

5 Click close.

The Signature results dialog box closes.

uonesadQ oiseg
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Chapter 3 Displaying and Converting Data

3.1 Displaying Waveforms

You can display data sampled on different channels of a recorder as waveforms on graphs
that display time on the horizontal axis and values on the vertical axis (Y-axis).

3.1.1 Waveform Display Window
When you open a display data file and an event data file, the data is first displayed as
waveforms. To open a window that you closed before, follow the procedure below.

Procedure

1 To open the waveform display window, on the Window menu, click Graph. Or, click
the Graph button.

I%lﬂ% ke

E Graph
Open the Graph Window

Waveforms will appear.

Show or hide alarms.
Show or hide cursor values.
Select the Y-axis display mode. TRIG mark
| r Select the grid.

7 Lwersad viewer - [Duaciey pe Craonewaa] s ases] v aezi paoy

A e P vam
¥

o P — .
m.E.hsﬂl:_Tia‘ JAOE =0 b o & ¥

Tabbed page
(Select the tab of
the group to display.)

} Color overview

Horizontal splitter
(Drag vertically

to display the
color overview.)

Cursor value

Vertical splitter
(Drag horizontally
to change the width
of the Y-axis area.)

Alarm display area

Y-axis area

Graph area Mark note Time axis

Waveform display example (light style)

Waveform display example (dark style)
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3.1 Displaying Waveforms

Color Overview Display

pcEEsmm—s=——=_ Shows cursors, marks, and triggers

Shows waveforms whose displays are turned on

The color overview display shows the measured values of the entire data source using
different colors. Values between the minimum and maximum values of the scale are mapped
to 50 different colors, and measured values are displayed using these colors.

For display data, the maximum and minimum values are displayed, respectively, in the top
row and bottom row in the space allotted for the waveform. For event data, instantaneous
data is displayed in a single row.

If you move the cursor over a color bar, the waveform number will appear. If you click or drag
the color bar, the corresponding section of the waveform appears in the waveform display
area.

Nofte

By default, the color overview is hidden.
To show it, drag the horizontal splitter at the top of the tabbed page down.

TRIG Mark Display

The trigger mark indicating the trigger position in the data file is displayed as TRIG.You can
show or hide the TRIG mark by selecting TRIG Mark from the View menu.

TRIG

Nofte

Marks (messages, triggers) that are saved in the data file are displayed in orange. Marks and mark
lines that you add with Universal Viewer are displayed in green.

Backfill Mark Display

If backfill took place in a data file acquired with Data Logging Software GA10, marks are
displayed to indicate the backfill. “Backfill Start” is displayed at the start point, and "Backfill
End” is displayed at the end point.

Back Fill Start Eack Fill End

N AN
/ N /
\ / \ /
N N

3-2
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3.1 Displaying Waveforms

2-Value Channel Display

For input that takes on two values, such as OFF and ON or 0 and 1, setting the Y-axis type
to 2 Value” is convenient.
Hereafter, a channel whose Y-axis type is set to 2 Value will be referred to as a 2-value
channel.
* This is set in “3.1.2 Setting Display Group Details” on page 3-4.
» The waveform is displayed using a rectangular wave.
» 2-value scales and values are displayed on the Y-axis. You can set the scale display to
Digits or Label. See “Changing the 2-Value Channel Scale”.
» 2-value grid lines are displayed on the waveform. You cannot set trip lines.
* You cannot expand, reduce, or move the scale (see “3.1.5 Setting the Y-Axis” on page
3-14).

Y axis Waveform
1
Start
> .
= Grid
o —
(=] [=]
o o
S 5
Stop
0J
-~
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3.1 Displaying Waveforms

3.1.2 Setting

Display Group Details

To assign channel data to waveforms, use the Display Group Setting dialog box. This dialog
box enables you to set channel groups and how to display the window.*
* The items that you set in this dialog box apply to the tabbed pages of the waveform display,
digital display, and circular display. They also apply to the data display of the respective
windows. For details on the display locations that these settings apply to, see the note on

Procedure

1 To configure display group settings, on the View menu, click Display Group Setting.
Or, click the Display Group Setting button.

iz T-fxiz Wiew  Window
IE == ]

Al B R
£X Group Setting
Display group setting

5 3

8

gzdzues

2 Click the tab of the group you want to configure.

Group tab number
Display Group Setting

Group Mame ;. |GROUP 1

34
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3.1 Displaying Waveforms

3 Edit the setup data as necessary. (For details on each setting, see the explanation.)

Group tab number
Specify the group name.
Register channels.

Select normal or exponential display.

Enter the display ranges.

Enter the display positions.
B =

Specify the Y-axis.

Trip line 1

Waveform No. —|_j -

Select to show.

Select to
show.

Enter values.

Select the
color.

number to select
the waveform.

B BE SR

o (o e v v o e

A

Specify the Y-axis grid line spacing.
Leave unselected to use the default grid line spacing.
To specify the grid line spacing, select the check box
and enter a value.

You can also click to change the color.

Display Group

ejeq Bunuaauoq pue Buiheidsiq

Trip3

Value  Color
20000
20000
20000
20000
20000
20000
5000
5000
5000

Scale Zone Tript Tripz N
i mAx M MAX Value  Color Value /

M vt -2.0000 20000 00 1000 00000 0.0000
R 02 -2.0000 20000 00 1000 0.0000 0.0000
A oz -2.0000 20000 00 1000 0.0000 0.0000
B ving. -2.0000 20000 00 1000 0.0000 0.0000
M s -2.0000 20000 00 4000 00000 0.0000
M s -20000 20000 00 1000
w7 22000 22000 00 1000
s 22000 22000 00 1000
[T 22000 22000 00 40080

00000
22000
22000
22000

0.0000
-22.000
-22.000
-22.000

e o s s o
1 1 s o
[ 1 o s o |
1 1 s o
1 1 s o

4 Click OK at the bottom of the dialog box to apply the settings to the display.
Nofte

The setup data that first appears in the dialog box are those that were used on the recorder when
the data was sampled. If you want to apply the setup data that you edited the next time you open
the data file, be sure to save the setup when you close the file.

Explanation

The Display Group Setting dialog box consists of multiple tabbed pages.
The spreadsheet on each tabbed page shows the settings of each waveform in rows and the
setup items in columns.

W ct | V-Axis = Seale
. nannec o, WMode  Type Title: ki

Zone Trip1
. M MAX MIH - MAX Value Color
B i CHOD v = Detsil & Linear® |4 F& -2.0000 20000 00 1000 [ 0.0000

Waveform number

In this dialog box, you can edit the setup data in the following ways.

» Set each setup item individually.
» Specify a range of items and set them at once
» Copy setup data between waveforms

To set multiple items at once or to copy setup data, you must use the action bar of the dialog
box. For these procedures, see the later half of this section.

This section explains how to set each setup item individually.

IM 04L61B01-01EN 3-5



3.1 Displaying Waveforms

Showing and Hiding Columns

Hide icon Show icon
— @)
- | Scale | Grid EI) Zone Z : : m“ Scale | Zone g
i MIN MAX Value MIN  MAY MIN MAX MIN  MAX
& 00 1000 [ 10 00 100 & 0.0 1000 00 1000 [m
't/ 0o 2000 r 1.0 00 100 't/ 00 2000 0o 1000 ’_
+ nn 4anan in nn 4nn & an 4nn n An 4nnn m

If you move the pointer over a column title, a hide icon appears. Click it to hide the column.
When you hide a column, a show icon will appear in the upper right of the page. Click this
icon to show the hidden columns.

Changing the Active Display Group

When you open a data file, you can set which group to display in front. Click the group tab
No. that you want to display in front, and click OK.

Assigning Display Group Names
Enter the display group name in the Group Name box, and click OK.
The name is applied to the title of the display group tab of the window.

For each waveform, you can set the items shown in the following table.

Item Description

No. Show or hide each waveform

Channel Channel to assign to the waveform

Y-axis No. Y-axis to share between waveforms

Y-axis Mode Display mode (detail, compact)

Y-axis Type Scale display (Linear, Log (logarithmic), 2 Value)
Y-axis Title Title

Form. Display format for Y-axis scale values and data (Normal, Exponential)
Scale MIN Minimum value on the Y-axis scale

Scale MAX Maximum value on the Y-axis scale

Zone MIN Lower limit position for Y-axis display

Zone MAX Upper limit position for Y-axis display

Trip 1 to 4 usage

Whether to use trip 1, 2, 3 and 4.

Trip 1 to 4 Values

Values of Trip 1 to Trip 4

Trip 1 to 4 Colors

Colors of Trip 1 to Trip 4

Grid line spacing usage

Whether to set the grid line spacing

Grid Value

Value to use for grid line spacing

Color

Waveform display color

Turning Waveform Displays On and Off

To display a waveform, select the waveform number check box. To hide it, clear the check
box. Click OK to apply the setting to the d”splay window.

3-6
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3.1 Displaying Waveforms

Registering Channels

You can assign channels to waveforms.
Click the channel cell of a waveform that you want to edit. The Channel dialog box opens.

Group Mame : | GROUP 1

{ 0z 04 05 06 OF 05 03 10 M

" /- ) W-Axis = Scale Zone
o anne lio. Mode  Type Title: arm, M MAX Ml MAX
=R CHOOT v » Detal * Linear® |4 Fé& -2.0000 20000 00 1000
b winz CHODZ w2 = Detal ® Linear® 14 Fé -2.0000 20000 00 1000
e CHOO Y03 ¥ Detal * Linear® 14 Fi -2.0000 20000 00 1000
M 4 \.cHoog / w4 = Detal ® Linear® 14 F -2.0000 20000 00 1000
N —g
x
l one
[ CHOOT ) CHODZ ]
[ CHOOZ )i CHOD4 )
[ CHODS )[f CHOOG ]
[ CHIO? )[f [ ]
[ CHOOG )i CHIMO )
[ CHO11 )[f CHD1Z )

Select the channel to assign to the waveform. The result is applied to the Display Group
Setting dialog box. To not assign a channel, select None.

Specifying the Y-Axis (No., display mode, type, and title)

Click to enter the title string.

03 04 05 06 07 08 09 1 20 21 22 23 2425 26 ERERE
Scale Zone

lo. Channel oo e TR

Wit 4 F \z -2.0000 2.0000 00 1000 p 1.4000
8 a2 CHOD * Linear®: 14 F -2 0000 20000 00 1000 R 1.4000
A iz i & Linear®: 14 Fd -2.0000 20000 00 1000 B 1.4000
R wind, CHO & Linear®, 14 Fé& -2 00nn 20000 00 1000 A 1.4000
[ | w05 CHOS @ Linear® 14 Fd -2.0000 20000 00 1000 [ 0.0000

WiE HODG: & Linear® 14 F& -2 0000 20000 oo oo [ 0.0000
[ w07, n & Lineard® 14 Fd 22,000 22000 00 1000 [ 22,000
[ ] w08 one. & Linear® I Fd 22 000 22000 00 4000 [ 22000
[ wig one: * Lineard®: 14 Fé& 22 000 22000 oo Aoon [ 22000

Select the Y-axis number |— Click to select Linear, Log, or 2 Value.

from the list. Click to select Detail or Compact.

* No.
You can specify the Y-axis to share between waveforms.
If a Y-axis was shared among multiple waveforms, consistency in their reference will be
checked.
For example, if waveform A is using the Y-axis of waveform B, and waveform B uses the
Y-axis of C, waveform A is changed automatically to use the Y-axis of C.

* Mode
Set the Y-axis display to Detail or Compact. In Compact mode, scale values are not
displayed.

+ Type
Set the type of scale to assign to the Y-axis to Linear, Log, or 2 Value.

+ Title
Enter a title of your choosing. Up to 30 characters can be displayed. If you do not specify
the title, the channel number, tag number, or tag comment assigned to the waveform is
used as its default title.

IM 04L61B01-01EN
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3.1 Displaying Waveforms

Specifying the Value Display Format

{01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 18 20 21 22 23 24 25 26 2T

Group ame s [GROLP 1 | Click here.
1
Ho. Channel Lhxs - ormy Scale Zore

Hlo. WMode  Type Title (1] MAX Ml MAX
M CHoo o * Detal & Linear® |4 F& -2.0000 20000 0.0 1000
WA iz CHOOZ w0z » Detsil & Linsard 14 Fé -2.0000 20000 00 1000
e CHOOE Y03 v Detal & Linear® |4 F -2.0000 20000 00 1000
M g CHOD4 w04 = Detail  * Linear® |4 [/ -2.0000 20000 00 1000

Click the appropriate icon in the Form. column to select F (normal) or E (exponential).
The scale and trip values in the same line will be displayed in the specified format.

In exponential display, the grid line spacing value is invalid.

When you click the OK button, the values displayed in the window (Y-axis scale, cursor
value, and trip value) will be changed to the specified display format.

Specifying the Display Range (Scale)
Click the scale value display area to enter values.
The input range and decimal place are as follows.
¢ Minimum and maximum values
When the Y-axis scale is linear: -1E16 to 1E16.
When the Y-axis scale is log: 1E-16 to 1E16.
» Decimal place of values
When the Y-axis value display is F (normal): Decimal place that was used when the data
was sampled
When the Y-axis value display is E (exponential): Fixed to 4 digits

Specifying the Display Position (Zone)

You can set the waveform display position by setting the upper and lower boundaries as
percentages of the waveform display area. The lower edge of the waveform display area is
0%, and the upper edge is 100%. Click the zone display area to enter values.

The input ranges are as follows:

* Lower boundary: 0 to 99%

» Upper boundary: 1 to 100%

» Decimal place: Fixed at 1

Trip1to4

You can set up to four trip lines for each waveform. Only the trip lines of the active waveform
are displayed on the waveform display screen. Select the check boxes for the trip lines you
want to display. Click the value display area to enter values. You can also specify colors.

In the waveform display window, you can drag trip lines to change their positions.

Trip cannot be specified for channels whose Y-axis Type is set to 2 Value.

Specifying the Y-Axis Grid Line Spacing

You can display Y-axis grid lines at the specified spacing.

Select the grid line spacing check box. (If unselected, the default grid line spacing will be
used.) Click the value display area to enter values. Click OK to display the Y-axis grid lines
at the specified spacing.

This cannot be specified for channels whose Y-axis Type is set to 2 Value.

Note

When you specify the Y-axis grid line spacing in the Display Group Setting dialog box, the Y-axis
grid setting on the menu and toolbar will be voided.

3-8
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3.1 Displaying Waveforms

Specifying Waveform Colors

You can assign colors to waveforms. To assign a color, click the appropriate color cell to
display the Color Setting dialog box. Select from the basic colors available. To assign a
custom color, click Define Custom Colors in the dialog box. The procedure is the same as
that for the standard Windows color setting dialog box.

Nofte

The items in the tabbed pages of the Display Group Setting dialog box apply to the tabbed pages
of the waveform display, digital display, and circular display. The table below shows the setup
operations that affect and the results that are applied to these tabbed pages. When each operation

is performed, the displays marked as “Yes” are affected. o
Displays Affected by the Operation %_’

Setup Operation WS." gfor Circular Display  Digital Display  Cursor Value ‘ns’_
isplay Display 5

Change the active display group Yes Yes Yes Yes «Q

Edit the display group name (tab title Yes Yes Yes Yes %

name) o

Turn waveform displays on and off Yes Yes Yes Yes 9

Register channels (assign channels to Yes Yes Yes Yes 3

waveforms) (2]

Specify the Y-axis to share between Yes Yes g‘

waveforms «Q

Set the Y-axis display mode (detail or Yes Yes nU)

compact) =

Set the Y-axis scale type (linear or Yes Yes

logarithmic)

Edit the Y-axis title Yes Yes

Set the display format of wa-veform Yes Yes Yes Yes

values (normal or exponential)

Set the Y-axis scale range Yes Yes

Specify the Y-axis display position Yes Yes

(zone)

Display trip lines Yes Yes

Specify the Y-Axis grid line spacing Yes Yes

Specify waveform colors Yes Yes Yes Yes
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3.1 Displaying Waveforms

Collectively Edit Setup Data

You can select a range of setup data of several waveforms and use the action bar to
collectively edit the data. In the example below, W02 to W04 will be set to the same Y-axis at
once.

Procedure

1 Click the line (waveform number) that you want to select.
The position that you clicked will be the starting line.

Click the data number that you want to select.

Mode  Type
= Detal & Linesr® 14
Detail Linzar ' [4 - 0.0 0000
" F

Detail & Linear® 14 Fé& -210000 20000 00 1000
Detail & Linear® §4 F& -2.0000 20000 00 1000

Value  Color

The line will be selected.

In this example, the W02 line is selected.

2 Drag the cursor to W04, and release the mouse button.

Tript

Mode  Type i M Value  Color l
Detail & Lineard, 14 -2.0000 20000 00
Lingar 2 14 E [

{ 00
Linear - €4 - 00
Linear®, |4 20000 00

Drag
The lines up to the point where you release
the mouse button will be selected.

W02 to W04 are selected.

3 On the action bar, click Grouping Lu |

Y-axes whose unit is the same are grouped together.

s | Pk cowe aom 200m
et PoE o Gowe  amw 20000
et | Fod o e o S0000
= ven [ T N1 0o
e, L R 1000
) FE o e e fo000
v A mo o so000
T FE e e o0
) Pl ome om 10000
Fon vt T 1000
ot T e o 10000
s ¥ oo i 0000
[ent. r& 0000 o 100
Lot [T T 10000
o FE e o S0
) [T ST 10000
L T T 10000
[ T I T 10000
[ T B 10000
PR pme e oo
Fb ame e so000
[ T T T oo
FE o ame e sa000
T T 0000
rd mme wa 10000
P b pow 0560 0o
[ T T facen
& wme e 1000
re om o 100

Click the button on the action bar.

WO02 to W04 are set to the same Y-axis, namely Y2.
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3.1 Displaying Waveforms

Explanation

To collectively edit setup data, you must select the target setup data and then click a button
on the action bar, which is at the bottom of the window. The result varies depending on the
type of button you press on the action bar.

Button Type Result

o Switch the check box state between selected and unselected

Assign consecutive channel numbers by taking the first waveform in the
selected range to be the reference

++

I Reset the value to default
u Group channels that have the same unit and assign the same Y-axis within each
group
U+ Group channels that have the same unit and scale and assign the same Y-axis
within each group
- ythe value of the first waveform in the selected range to the other waveforms
Switch between selected and unselected for items to be pasted when copying

between waveforms The items are normally selected (pasted). Clicking one of
these buttons causes the corresponding item to become unselected and will not

be pasted.

In addition to dragging the cursor to select the setup data of multiple waveforms (step 2 in
the procedure), the following methods are available.
* Using the Shift key
After selecting the starting line, hold down the Shift key, and click the ending line.
+ Selecting All Lines
Click No. (the title) to select all setup data.

Copying Data between Waveforms

You can copy setup data by using the Copy and Paste buttons at the bottom of the window.
Select a range of setup data to copy, and click Copy. Select a range of setup data to paste
to, and click Paste to paste the copied contents.

You can also select which items to paste using the copy flag icon "

When you copy, if a Y-axis number does not exist in the options of a paste destination, the
Y-axis number specific to the waveform at the paste destination will be used.

Automatically Calculating Scale Values

The software can automatically calculate the display range values for multiple data sources.
To do so, select the range of setup data that you want to edit, and click Scale Calc at the
bottom of the window.

The scale values will be set to the maximum and minimum values in the measured data of
the channel assigned to each waveform.

IM 04L61B01-01EN

3-11

ejeq Bunuaauoq pue Buiheidsiq H



3.1 Displaying Waveforms

3.1.3 Setting the Time Axis

Selecting Absolute or Relative Time Display

You can switch the time axis display between absolute time and relative time.
To switch, use the TimeAxis menu.

» Absolute Time Displays the date and displays the time axis using data timestamps (e.g.,
h:m:s: 18:26:59).

+ Relative Time  Displays the time axis using times in reference to the first data entry
(e.g., DAY h:m:s: 00:00:53).

Switching the Time Zone
You can change the time zone for displaying time by clicking Time Zone on the View menu.
This menu command is valid only when data from the GX/GP/GM or Data Logging Software
GA10 is displayed. The available time zone options are shown below.

» Data: Time is displayed using the time zone of the data file. (Default value)

« PC: Time is displayed using the time zone of the PC displaying the data.
The time zone selected here also applies to printing.

All Display
If you select All from the TimeAxis menu, the time axis is expanded or reduced so that all
the data is displayed.

Grid Display
You can show or hide the grid by clicking Grid on the TimeAxis menu. The grid is hidden
when there is no check mark next to Grid.

Changing the Grid Density (X-axis)
Select a density from the TimeAxis menu, or click the corresponding button on the toolbar.
You can select the grid line density from five levels.

B Univer

File Edit TimeAxis Y-Axis View Window Convert Information Signature Help

@RE AN Tssoss BE QS H Ik ) S

i 85 07 Bu 0% | 0P fin eP) e x|

: . ey

E i e 0 e Xl

- 5
Event File-Graph[B2 :1; =)

ixal

[IGROUP 1 (RIS

Zooming in on or out of the Time Axis

You can zoom in on or out of the area around the cursor.

If there is no cursor, zooming is performed in reference to the left edge of the displayed
waveform.

Use the TimeAxis menu, or click the corresponding buttons on the toolbar.

Click here‘ to select. Expand Reduce
File  Edit Timefxis Y-fxiz Miew Window Convert  formation  Sie

ERE 0 N =g s IEEE@D H
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3.1 Displaying Waveforms

314 Displaying and Searching for Alarms
Turning the Alarm Display On and Off

Procedure

1 On the View menu, click Alarm. Or, click the corresponding button on the toolbar.

|—Click here to select.
File  Edit Timefxiz -fxiz  Miew  Window  Conwert  Info

=S R | b oo et o S ||.

L— Show or hide alarms.

Alarm bars appear in the alarm display area.

N NN Y
\ /AN /A
N\ \\\i )

e

cHOD1 Y]

L~

\

“ e }Alarm display area
w7 Thznzel
1T

L Alarm bar

Alarm bars are displayed in order from the top: alarm 1, alarm 2, alarm 3, and alarm

4. When alarm bars overlap, alarm bars are displayed from the front with the following
precedence: the active waveform, waveforms with the same Y-axis as the active waveform,
and waveforms in the same display group with smaller waveform numbers.

Searching Alarms

You can search for alarms and move the cursor to the found positions.

On the Edit menu, click Search Alarm. Or, click the corresponding button on the toolbar.
The cursor moves in accordance with the selected command.

— Click here to select Search Alarm.
;‘} Universal Viewer

File Edit Timefxiz Y-#fxiz Wiew Window Convert  Information  Signature  Help

%G N pete S5 @E 2K |1 i) d
s &% Bs &% | o fin e Fie

":Ef"-l

L]

Search {—
bar

I— Move the cursor to the alarm change point.

A list of alarm information can be viewed on the Alarm To tabbed page.
For details on the Alarm To tabbed page, see section 3.4.
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3.1 Displaying Waveforms

3.1.5 Setting the Y-Axis
Switching Waveform Display Zones
Use the Y-Axis menu, or click the corresponding buttons on the toolbar.
Slide zone Auto zone
Full zone Free zone
File  Edit Timefxiz Y-fxiz  Miew Window Convert  Information
=g )= Rtz sS @EE 22 5 )
Click here to select.
» Full Zone: Displays all waveforms over a full zone
» Slide Zone: Displays each waveform cascaded from the top to the bottom of the
waveform display area
Full zone Slide zone
GROLF 1 [FXNTIRN GROUP 2 GRODP 3 GROUP
- - - . 29 -
? ? ? 2 2 9 5
(I R 17 1 . N
= |2 =2 |= = 12 1= |=
2 o0z 4 04z 04 s 12 Mz = o
z |2 |8 |3 ¢ = |2 |2 |2 ¢
_1_ _ o [}
T Y e L IS R
) ed el gl S Y
- S
(1 bl 0 0
» Auto Zone: Divides the waveform display area into equally spaced zones in accordance
with the number of displayed waveforms and displays the waveforms
» Free Zone: Displays waveforms in user-specified zones
You can change the size of zones in Free Zone mode by manually adjusting the Y-axis in
the window.
Drag a zone edit area (the top or bottom boundary of a zone) to expand or reduce its
Y-axis. Place the cursor over a zone so that its shape changes and drag to move the
Y-axis to the desired position. You can move Y-axes only in Free Zone mode.
Auto zone Free zone
—_ = ==
Zo 1A
DE u_ R
= -i- | Drag azone edit
= ;E: area vertically to
= 4 expand or reduce.
-:-E 0
5 11 .
‘%: In this condition, - = o
E 14 4 you can drag to I
¢4 ¥ move the Y-axis. £ =
= -2
T -1
U -
- o
= 1 Mz 1
:.E |:|— é 14
T -14 & -1
2 _2_
-a ;2_
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3.1 Displaying Waveforms

When you move the cursor into the Y-axis area, the Y-axis becomes editable, as shown in
the figure below.

l_ Click to switch to Compact mode.

Lo cffa E|¢_ «— Reset scale values. '54— Click to o o
Scale value = Scale | ]| changeto
<0< expand/reduce button Detail mode.
Qul<« In this condition, turn
the mouse wheel to 15 14
Scale Iine_1l_ Lo | move the scale values 1
vertically.
= 5 0
= == = = z
Hlz qz 4=+ =1
Title = [EI[Z]¢ &
Use the > Vertical splitter N o
View menu Expand or reduce
to switch. the Y-axis area
-l -l 4 4 1
_a
_ Y-axis Y-axis
sl =] = scale value scale
= . Compact mode ———— change area movement
Detail mode - ) ) area
Active waveform icon

Compact Mode and Detail Mode

There are two Y-axis styles: compact mode and detail mode. You can switch between the
two by clicking the icon at the top of the Y-axis area. In compact mode, scale values are
hidden, narrowing the width of the Y-axis.

Expanding and Reducing a Y-Axis Scale

When you move the cursor into the scale value edit area, the cursor changes as shown in
the figure.

Clicking in this condition shows a scale expand/reduce button.

Click an arrow or spin the mouse wheel to expand or reduce the scale.

This operation cannot be performed for channels whose Y-axis Type is set to 2 Value.

Scrolling a Y-axis Scale

When you move the cursor into the scale edit area, the cursor changes as shown in the
figure.

Spinning the mouse wheel in this condition causes the Y-axis scale to scroll, maintaining the
difference between the upper and lower limits of the scale.

The scale values will take on the values at the new position.

This operation cannot be performed for channels whose Y-axis Type is set to 2 Value.

Changing the Active Y-Axis

In the Y-axis area, click a Y-axis to activate it.

The active waveform icon moves below the new active Y-axis.

When a Y-axis is shared among multiple waveforms, the waveform with the smallest number
in the display group will become the active waveform.

Switching Y-Axis Titles
On the View menu, click Channel, Tag No., or Tag Comment to change the type of
character string used for Y-axis titles.

IM 04L61B01-01EN
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3.1 Displaying Waveforms

Changing the Grid Display (Y-axis)
i 2 Universal Viewer - [Event File

File Edit TimeAxizs Y-Axis View Window Convert Information Signature Help

PRE D R S RS ﬂﬂnlﬂn”l@}i =

A A B
+@ @+ +§

£

R EHE

» o7 | Al fin e Fe

=

GROUP 1 [gesisjils

T T RGN /7T HBN

Select a density from the Y-Axis menu, or click the corresponding button on the toolbar.

To change the density of the grid lines on the time axis (X-axis), select a density from the
TimeAxis menu, or click the corresponding button on the toolbar. You can select the grid
line density from five levels.

The density of the Y-axis grid lines are not applied to channels whose Y-axis Type is set to 2
Value.

Nofte

In the following situations, only the grid lines that correspond to the scale lines on the Y-axis are

displayed.

» If you specified the grid line spacing in the Display Group Setting dialog box

»  When the Y-axis scale is set to exponential display

In addition, how the Y-axis grid is displayed varies depending on the Y-axis zone mode as follows:

* In Full Zone or Slide Zone mode, the grid lines for the Y-axis of the active waveform are
displayed.

* In Auto Zone mode, the grid lines for all the displayed Y-axes are displayed.

* In Free Zone mode, the grid lines for the Y-axis of the active waveform are displayed. If there

are other Y-axes above or below, the grid lines for those axes are also displayed.

R

Waveform Display Limit (Clip)
On the Y-Axis menu, click Clip. Or, click the corresponding button on the toolbar.

le  Edit Timefwxiz Y-fxiz Miew Window Convert  Information  Sienature  Help

Ei
EEE B X g BEE R s jhi_a

Click here to select. Clip

When you apply the waveform display limit, the Y-axis display range is limited to the
minimum and maximum values that you specified using Scale in Display Group Setting.
Measured values that are less than the minimum value of the scale are set to the minimum
value, and values that are greater than the maximum value are set to the maximum value.
Example when display limit is applied = Example when display limit is not applied

(N \

:dbin 1138000 11366200 12:00:00 12:06:00 12310 11:45:00 11:50:00 11:85:00 12:00:00 12:05:00 1

Changing the 2-Value Channel Scale

On the View menu, click 2 Value and select Digits or Label.

If Digits is selected, “0” and “1” are displayed on the scale. If Label is selected, the label set
on the recorder is displayed on the scale (if a label is not set, “0” and “1” are displayed). This
setting applies to all windows.

3-16
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3.1 Displaying Waveforms

3.1.6 Operations That You Can Perform from the Legend

Switching the Legend Display

To hide or show the legend, use the View menu, or click the corresponding button on the
toolbar. The legend has two display modes: channel and axis. You can switch between the
two by using the button in the top left of the legend.

Click here to select.

File Edit Timefxiz Y-fxis Mew Window Convert Information  Signaturs  Help

Display mode switch button L_ Show or hide the legend.
Legend for Legend for
the channel display mode the axis display mode

01 o -3 CHOD1[WF— Axis title

+ Ml cHooz L o[
J . CHOOS Channel title o _a CHOOZ[]

' [l cHooa L7 W crooz
:; Ml croos o - CHOD3(Y]

CHODR

[ Channel _—| Ll M croos

check icon o = cHOD4]

Click to switch between show and hide. I—-e;;;? B cHoo4
Axis check icon——— & —a CHODS[

Ll W croos
o -4 CHOOEY]

Ly O cHooe

Simultaneous Waveform On/Off

You can simultaneously show and hide waveforms and axes by clicking the Simultaneous
Waveform On/Off icon. If there is any waveform that is hidden, all waveforms and axes will
be shown. If all waveforms are shown, they will be hidden.

Channel Mode ﬂ

Only the waveforms that are assigned to channels in the active display group are displayed.

Click a green check icon to hide the corresponding waveform data. If the Y-axis is not shared
with other waveform data, it will also be hidden. Click a light-green check icon (hidden state)
to show the corresponding waveform data.

Axis Mode

Only the waveforms that are assigned to channels in the active display group are displayed.
Waveforms are displayed in groups that use the same Y-axes. Click an axis check icon to
hide all waveform data that share the axis.
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3.1 Displaying Waveforms

3.1.7 Moving Trip Lines

You can drag trip lines to change their positions.

Clicking a trip line value changes the color of the frame and the characters to black. You can
drag in this condition to move the trip line to the desired position. The trip line value will take
on the value at the new position.

............................................ ]_DUDD
............................................ D.S?D4

............................................ _].DUDD

............................................ _E.DUDD
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3.1 Displaying Waveforms

3.1.8 Setting Cursors

Specifying Cursors

Procedure

1

Note

To position Cursor B outside the displayed data range, drag the cursor outside the graph area on
the left or right. The displayed data will scroll toward the cursor.

Click a location in the graph area.

VIRV /A\\

&\\

7/ I\

_

/

N\ 77\ |/
\ \

T T T T T T T
11:45:00 11:50:00 11:85:00 12:00:00 12:05:00 12:10:00 12:15:00

Cursor A appears.

Drag the cursor and release the mouse button.

x\

.
A
L~

\ /
)
/

N/ N\ |/
N N\

T T T T T T T
11:45:00 11:50:00 11:85:00 12:00:00 12:05:00 12:10:00 12:15:00

Cursor B appears at the released position. The cursor positions will be set to the closest data

positions.

Selecting All Data Points

On the Edit menu, click Select All. Cursor A will move to the beginning of the data, and
cursor B to the end.

Clearing Cursors
On the Edit menu, click Erase Cursor.

Moving Cursors by Searching
You can search for alarm transition points or mark positions and move the cursors to the

found positions.

On the Edit menu, click Search Alarm or Search Mark, and select the position. Or, click the
corresponding button on the toolbar.

> Searching for alarms and marks (“3.4 Displaying a List of Alarms, Marks, and Image Marks”
on page 3-45)

;_9 Universal Viewer
File —_Edit Timefxiz Y-fxiz  Wiew Window GConvert  Information  Sienature  Help

& @a R et oot & 5| @E9) & R | G5 Bag 00| [

fo o7 %o -@'3| L e —
I

Move the cursor to the alarm change point. = Move the cursor to a mark.
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3.1 Displaying Waveforms

Showing and Hiding Cursor Values in the Graph Area

Procedure

1 On the View menu, click Cursor Value. Or, click the corresponding button on the
toolbar.

Click here to select.

File  Edit Timefxiz Y-fxiz  View Window GConvert  Information  Sienature  Help

T IR [E TR LR R

Fohoo /7!

Show or hide cursor values.

Waveform color

Title

Minimum value

Intersection Maximum

value

CHO02

“M2ART =02
| [
CHOO3

‘ 07432 = -0.7330
T[]

CHDD4 .

=1L2056 == -1 AR9E

B

Transparent display Opaque display

Cursor values will appear.
Remove the check mark to hide them.

2 On the View menu, click Cursor Transparency to select the transparency to use.

Explanation

» Cursor values are usually displayed to the right of the intersection between a cursor and
a waveform.
If they cannot be displayed to the right or they overlap the cursor on the right, they are
displayed to the left of the intersection. If they cannot be displayed to the left either, they
are not displayed.

» |Ifacursoris at a skip, error, undetermined, or power-failure data position, values are not
displayed.

* If the cursor values of multiple channels overlap with each other, the values of only
the front-most cursor are displayed. Cursor values are displayed with the following
precedence: the active waveform, waveforms with the same Y-axis as the active
waveform, and waveforms with small waveform numbers.

 If the data file is an event data file, instantaneous values are displayed.

Note

If you set, clear, or reset cursors or markers in the waveform display window, the result of the
operation is reflected in the circular and digital display windows.
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3.1 Displaying Waveforms

3.1.9 Displaying Cursor Values and Statistics

Control

The Control dialog box shows values at cursor positions and value differences between
cursors. You can also move cursor positions, show alarm information, and copy data to the
clipboard.

Procedure

1 On the Window menu, click Control. Or, click the corresponding button on the toolbar.
Click here to select.
|

= | Universal Viewer

File Edit TimedAxiz Y-fxiz View Window Convert Information  Signature  Help

BRE B BEE S R (] S, R D ()R k8 @ R

Open the Control window

The Control dialog box appears.

The values of cursors A and B

—— on the waveform display screen
Control[000020_121201_114242.DAD:GROUP 1] X
=
Copy button

Cursar A Cursor B N Difference
Dt o 252 0 BEE Cursor movement
ahsolte Time g | 2z onzzonooa || buttons
Channel Value A Value B Value B-A 1=
CHOD Mex I 1sds7 [ 14827 0.4560
1] win |0~ -19s2s [I 1 47es 0.4750
CHOOZ2 Mex [l 1seso [ -17sss 0.2322
1] win |0~ teser [H 1770 0.2247
CHO03 Max I 1oors I 1 o4s7 00413
[¥] win (M0 -toize [I 195 00399
CHOD4 wex I -1eser [IH 19980 03113
[¥] win |0~ -1eseo [H 19087 -0.3027
CHOOS wex ([l 13511 [ 19079 -0.5563
1] win |0~ -13ess [ @ 1 -0.5487
CHO0G wax [ -0szss [ 18887 07633
1] win ([0 09389 ([0 -1 B350 07571 [
[Alarm display (displays the conditions of

alarms 1, 2, 3, and 4 from the left)

Explanation

The Control dialog box lists the waveform display window’s cursor A and B values and their
differences. Clicking a cursor movement button changes the cursor A and B position values
and the cursor positions. When the alarm display is on, alarm conditions are displayed.
Alarms that are activated are displayed in red, and those that are not are displayed in green.
Clicking the Copy button copies the contents of the Control dialog box to the clipboard. You
can paste the contents to a tab separated text file or to an Excel spreadsheet.

Digital Value Display of Error Data
Error data is displayed in the following manner.
Display Description

+OVER Measured or math data is over the positive limit.
-OVER Measured or math data is below the negative limit.
SKIP Skip data

LACK Calculation error or missing data

INVALID Invalid data
BURNOUT Burnout data
ILLEGAL lllegal data

Nothing Data during a power-failure period or if data could not be acquired due to some
communication error.

Note

If no cursors are displayed in the waveform display window, the Cursor Value area will be blank.
Differences between cursors will be indicated as “INVALID.”

IM 04L61B01-01EN 3-21
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3.1 Displaying Waveforms

Statistics

The Statistics dialog box shows calculated results for values between the cursors.
You can move cursor positions, update calculation results, copy data to the clipboard, and
printing.

Procedure

1 On the Window menu, click Statistics. Or, click the corresponding button on the
toolbar.

Click here to select.
|

o] | Uriversal Viewer

Eile Edit Timefxis Y-Axiz Wiew Window Corwert IDnformation Sienature  Help

BRI N e GEE KK s R DO ﬁ/ Qa0 @

Statistics
The Statistics dialog box appears.

Number of the first data point in the computed region (cursor A)
Number of the last data point in the computed region (cursor B)

Recompute
— Copy
Statistics[Data-0003.dld:Group 01 . X
Time
v v «— Print
Section | 137| - | 489 201901001 14:54:53.000 201901001 15:00:25.001
.
Channel MIN MAX P-P. Mean (B RMS -y
CHO001[V] -1.9999 1.9999 3.9008 -0.074; 1.4455
CHO002[V] -1.9999 1.9999 3.9908 -0.1085 1.4190 Column show
[TEN -1.9999 19999 3.9998 -0.1355 1.3907 butt
CHOOO04MW -1.9999 1.9999 3.9998 -0.1532 1.3682 u .On
CHOD05[V] -1.9999 19508 3.9597 01605 1.3581 (This appears
CHODOE[V] -1.9999 19993 3.9992 -0.1569 1.3632 when the column
CHIOOT[V] -1.9999 19999 3.9998 -0.1425 13822 is hidden.)
BT -1.9999 1.9999 25 Column hide button* ’
CHODO9[V] -1.9999 1.9999 3.9998 -0.0863 14374 |
CHO010[V] -1.9999 1.9999 3.9998 -0.0483 1.4588 |7}

Explanation

The minimum, maximum, P-P, mean, and rms values for each waveform in the range
specified by cursors A and B are calculated and displayed. (In the default conditions of the
statistics display, all data values are selected.)

Clicking the Copy button copies the contents of the Statistics dialog box to the clipboard.
You can paste the contents to a tab separated text file or to an Excel spreadsheet.
Clicking the Print button prints the statistics.

Showing or Hiding Columns

When you move the cursor over a column title, a hide button appears. Clicking the hide
button hides the target column. To show a column, click the show button.

Note

« Calculated results are not synchronized to the cursor positions or waveform group. If you
change the cursor A or B position or the display group, click Re-calc. to update the calculated
results.

» The formula for calculating the rms value is as follows:

RMS = 1/1 Y %)
N k=0

n : Number of data
Xk : value

*  When the number of channel data points exceeds 100,000, a progress bar will be displayed.
If you click Cancel while computation is in progress, computation stops, and only the statistics of
the channels whose computation has been completed are displayed.
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3.1 Displaying Waveforms

3.1.10 Adding, Editing, and Deleting Marks

Adding a Mark
You can add a mark when cursors A and B are at the same position.

1

Click the position where you want to add a mark.

N

LN /)

Cursor A appears.
On the Edit menu, click Append Mark. Or, click the corresponding button on the
toolbar.

Click hlere to select.

S

File Edit Timefxiz Y-fxiz  WMiew

@&d ff&-{:»r!

Add a mark.
The Mark Settings box appears.
Edit the mark information.
Marlk Settings | 2|

Select whether to

& Al Groups ‘e Group on Display 1

that are displayed.

Mark title Mark String | |
(up to 70 characters)
Type |Center (‘J -+ Click to select
the display position.

Select to r Time

show timestamps

with marks. [ 0K ] [ Cancel ]

LS &

Note

.

—— When you are finished selecting, click OK.

Click OK to add a position mark at cursor A.

add the mark to all groups
|~ or only to the groups

The time display shows absolute times or relative times from the first data point, depending on

the time axis setting. If you set Type to flag, no time information is displayed.

To change an existing mark, double-click the mark to open the Mark Settings dialog box. Then,

follow the steps from step 3 to edit it.

You can only change the display position and time display for marks that were added during

recording.
Marks and mark lines that you add with Universal Viewer are displayed in green.

IM 04L61B01-01EN
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3.1 Displaying Waveforms

Deleting Marks
Marks added on a recorder with the advanced security function or a DX100P/DX200P

cannot be deleted.

Procedure

1 Specify cursors A and B so that the marks you want to delete fall between the cursors.

Display position: Left Display position: Center Display position: Right Flag

"GROUP 1

12 20 cenaee o
Mark center

S S o
Mark left ht —_— ]
2 \ /

CHID1 (Y]
o

N \_/

09 Q‘U:UU 03:4‘5 Qi) [z} SIU {11) UE:S‘S:UU AL UIU 0o 10 U‘S:UU 01 ‘U Qi) 10 1'5 {11) AL E‘U 0o
Absolute Time [rim:s]
Select the range with cursors A and B.

2 On the Edit menu, click Delete Mark. Or, click the corresponding button on the toolbar.

Click here to select.

57

Eile dit  Timefxiz  Y-fxiz  Yiew

TR m-:-a

Delete marks.

All the marks within the cursor range (including those at the cursor positions) are deleted.

Resetting the Marker Display
On the Edit menu, click Reset Mark to delete all marks. Marks (messages and triggers)

saved in data files are not deleted.

Note

If you select Delete Mark from the menu, the marks between cursors A and B, the marks at the
cursor positions, and the marks saved in the data file are cleared from the display. If you reset the

marks, only the marks saved in the data file are displayed.

IM 04L61B01-01EN
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3.1 Displaying Waveforms

Searching for Marks

You can search for mark positions and move the cursors to the found positions.

On the Edit menu, click Search Mark, and select a position. Or, click the corresponding
button on the toolbar.

r Click here to select Search Mark.
|

Universal Viewer

File  Edit imefxis  Y—fxis  Mew indow Convert  Ihformation  Signature  Help

EmE B N oo L8 @EH 21 8 55 H

Search —= 9, .8, 8| i fin &fl fie

Move the cursor to a mark.

> Searching for alarms and marks (section 3.4)

Changing the Display Order of Marks

If multiple marks overlap and you want to change their display order, hold down the Shift key
and click a mark. Each time you click, the mark switches between being displayed in front
and back.

IM 04L61B01-01EN
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3.1 Displaying Waveforms

3.1.11  Adding, Editing, and Deleting Mark Notes

Adding a Mark Note
You can add mark notes to any position you like in the waveform display window.
For each mark note, you can enter a title and comment.

Procedure

1 Click the position where you want to add a mark note.
Cursor A appears.

2 On the Edit menu, click Append Mark Note. Or, click the corresponding button on the

toolbar.
A mark note is added to the cursor A position.

Click here to select.

File Edit Timefxiz Y-fxiz  Wiew ‘Window Convert Ihformation  Sienature  Help

M TEE O N | LE LT

Add a mark note—— L Deleting mark notes.

Mark note (normal display when added) Mark note (when editing the comment)

yd N
, / N
Click to switch ——(my " Titls @( '
the display / ¥ n i

position between =
left and right.

I——

Reduced display: Click to return to normal display
L——» Reduce button: Click to reduce.

3 Double-click the title area of the mark note or the comment area.
The cursor blinks, and you can enter characters.

4 After you enter the characters, click anywhere outside the current text area.
The characters are applied.

Nofte
* You can enter up to 60 characters for titles and 250 characters for comments. If the characters
do not fit in a display area, the overflowing characters are replaced with an ellipsis.
» To edit an existing mark note, follow steps 3 and 4.
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3.1 Displaying Waveforms

Switching Display Positions

Clicking the button shown in the figure will switch the display position of the corresponding
mark note between left and right.

Clicking the compact button changes normal display to compact display.

Mark notes are displayed in order from the back as they are created. This order cannot be
changed.

Moving a Mark Note

To move a mark note up and down, drag it in the desired direction. To move it to the opposite
side of the cursor position, drag it in the desired direction.

Deleting Mark Notes

Specify cursors A and B so that the mark notes you want to delete fall between the cursors.
On the Edit menu, click Erase Mark Note. Or, click the corresponding button on the toolbar.

IM 04L61B01-01EN
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3.1 Displaying Waveforms

3.1.12

Displaying, Copying, and Printing Image Marks (Freehand messages)

You can display freehand messages in a data file and copy them to the clipboard or print
them. In the following explanation, freehand messages are referred to as image marks.

Displaying Image Marks
You can set the image mark display mode to Normal or Compact. When set to Compact,
only the image buttons are displayed. You can change the size of displayed image marks.

1

If the data file contains image marks, marks (==, image buttons) that indicate them
are displayed at the top area of the waveform display. Click an image button.

The image mark appears.

Or, on the View menu, click Image Mark and then Normal.
All image marks in the waveform display area are displayed.

Image button

[ View - Image Mark (compact display)
I [e——— -
Lie  [dn Timehss r&a- Gorvert  ormation  Glenstas  Helo
SmE S A Gpley o Seree. |yl L5 PR DGO ke GOS8

B 4% By o | 0] fon ] el @ e

[ie-Cranh (000724 123000 1.5}
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v | " I
i - I cHeno2
! bormat " Wl CHeDd
L Lompact .k " Wl Crams
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a | o B cancs
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| ot _ma B crance
' | _ T —-—
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The image mark appears, and the image button color changes.

Image button

[ (normal display)

=],
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o | T \_#-_ _
*-.\\\__/
T L
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3.1 Displaying Waveforms

2 To change the display size, on the View menu, click Image Mark Size and then the
appropriate size. You can set the display size to Small, Normal, or Large.
The display size of all image marks in the waveform display area will change.

Note

* Image marks are displayed semi transparently.
» Moving the cursor over an image mark or image button highlights the image mark.

3 When image marks are overlapped, you can change the display order of image marks
as follows.
Click the image button or image mark to move the image mark to the front; or hold
down the Shift key and click to move it to the back.

o O =1 L |

- Click a mark to move to the front.

L— Hold down the Shift key and click to move to the back.

4 To close all image marks, on the View menu, click Image Mark and then Compact.
To close an individual image mark, click the x button in the upper right of the image

mark.

The image mark will close.

Explanation

The table below describes the different display conditions.

[Image Button

Status

Compact display. Only the image button is displayed.

Normal display. Image mark is displayed semi transparently.

Highlight display. The close button is displayed.

—

Image Mark dialog box is displayed.

IM 04L61B01-01EN
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3.1 Displaying Waveforms

Copying Image Marks to the Clipboard

Procedure

1 Move the cursor over an image mark, and click the button () in the upper right. Or,

double-click the image mark.
An Image Mark dialog box opens.

Image Mark [14:18:36 - 14:20:14] =
|
126§
' 45.2]
. . ' 32.8)
Click this button or
. 85.2)
double-click the e
. 52.8)
image mark to
display the Image =
Mark dialog box. .
B2.86}

2 Click the copy button () in the upper left.
The image mark is copied to the clipboard.

3 Click the x button to close the Image Mark dialog box.

Printing Image Marks

Procedure

1 In the Image Mark dialog box, click the print button () in the upper left.
A Print dialog box appears.

2 Specify the print settings, and click OK.
The image mark is printed.

3 Click the x button to close the Image Mark dialog box.

3.1.13 Changing the Waveform Thickness
Select the waveform thickness from three options (Normal, Middle, and Thick).
On the View menu, click Line Thick, and select the thickness you want.

3.1.14 Copying Waveforms
You can copy the screen image of the waveform display window to the clipboard.
On the Edit menu, click Copy. Or, click the corresponding button on the toolbar.

Click here to select Copy.

-
f‘;‘ | Universal Viewe
File  Edit Timefxiz Y-fxiz Yiew Window  Conwert  formation  Sienature Help
=L Y| %ﬁx oot S S @EE 2K I
Copy
Nofte

The window screen image can also be copied in the circular display window.
You can paste the image copied to the clipboard to another application for use.
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3.1 Displaying Waveforms

3.1.15

Appending a Comment to a Time Range (Text comment line)

You can add comments by specifying a time range. These comments are called text
comments.

Appending a Text Comment Line
Text comment lines are added only to the active display group.

Procedure

1 Drag the cursor on the waveform display window to specify the time range to add a
comment.
Cursors A and B appear.

2 On the Edit menu, click Append text comment line. Or, click the corresponding
button on the toolbar.
The text comment line appears.

Click here to select.

File Edit TimeAxis Y-Axis View Window Convert Information Signature Help

=Y 2 | ot X ot oo @ E & K | 1 % 2|50 Bl Bl
Append a text comment line. L Delete text comment lines.

Time range to add the comment (cursor A, cursor B)

A

| Perooot
1

\

Yash

10:37:00 10:38:00 10:32:00 10:40:00 10:41:00 10:42.00 10:43:00

CHUDUT
-1.1070

Text comment line  Comment string
Double-click to enter a comment.

3 Double-click the comment string area, and enter a comment.
Up to 50 characters can be entered.
Click outside the comment string area to confirm the entered comment.

Editing a Text Comment Line

Procedure

1 When the pointer changes to [ near the horizontal line indicating the range, drag the
pointer in the Y-axis direction.
The text comment line will move in the Y-axis direction.

2 When the pointer changes to «— near an arrow indicating the range, drag the pointer in
the time axis direction.
The time range will be expanded or reduced.

3 Double click the comment.
You will be able to edit the comment.

G
(

i
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3.1 Displaying Waveforms

Deleting Text Comment Lines

1

Drag the cursor on the waveform display window so that text comment lines that you

want to delete is encompassed.
Cursors A and B appear. Text comment lines will be deleted if any portion of the lines is between
the cursors.

Time range over which comments
will be deleted (cursor A, cursor B)

v v
bl

CHo00T
1.824;

Comment 2

Comment 1

THO00"
07474

T T T T T T T
10:37:00 10:38:00 10:38:00 10:40:00 10:41:00 10:42:00 10:43:00

On the Edit menu, click Delete text comment line. Or, click the corresponding button

on the toolbar.

If the specified range contains a single text comment line, the line is deleted.

If the specified range contains several text comment lines, a Delete text comment line dialog box
appears.

In the Delete text comment line dialog box, check that the check boxes for the text
comment lines that you want to delete are selected. Clear the check boxes from those
you do not want to delete.

d

Dalata taxt commant line

724,000 - 20140 103827 000
37 52000 - 014IE 14112000

4 Click Delete.

The text comment lines are deleted, and the Delete text comment line dialog box closes.
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3.1 Displaying Waveforms

3.1.16 Displaying Waveforms Using Superimposed Display
The superimposed display function can be used to display data from different files in the
same window with separate time axes. You can move data at the file level or move the data
together by changing the display mode of the time axis. You can also scroll the time axes
separately to compare waveforms from different files.

Procedure

To use superimposed display, you need to assign the data you want to view to the
Waveform1 and Waveform2 groups.

1 Open the original data files you want to display superimposed.

2 On the Window menu, click Superimposed display. Or, click the &} | button.
The superimposed display start window appears.

| = Sttt ks oy

% W

3 Make group assignments. On the Edit menu, click Group assignment. Or, click the &
button.
An Group assignment dialog box appears.

4 Assign files and groups to Waveform1 and Waveform2.
This assignment can also be carried out using Legend on the superimposed
display window. For details, see the following pages.

Select a file.
Group assignment '
Waveform1 [o00003_1z0m19 170807605 (=) [GROUP1 =]
Waveform2:  [000003_120918_170607.605 =] [erovr1 (=

[
Select a group.

5 ciick oK.
The superimposed display window of Waveform1 and Waveform2 appears.
= D000 12091 TTHOT.CIS/I00004 120915 171607 605 =
b ed o wod| | LT | Pam.\ !
iF =
I olE o N7, N |
% . e T 174000 mzwm:m“‘fpl:‘;: WARR 171 Y e
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3.1 Displaying Waveforms

Group Assignment

The two groups (Waveform1 and Waveform2) of the superimposed display can be assigned
from the Group assignment dialog box or Legend on the start window. Select the files and

groups for Waveform1 and Waveform2.
Up to 50 channels can be assigned to Waveform1 and Waveform2. Y-axes with the display
turned on are all displayed. There are no limitations to group assignments. The same group
from the same file can be assigned. To change an assigned group, you can change it in the

same manner as when you make assignments.

Assign from the dialog box

Select a file Select a group

Group assignment @

@)EmmE)

Waveform1: |000003_12091 9_170607.GDS

Waveform2:

|000003J2091 9_170807.GDS

= | [eroup1 =]

=0

Cancel |

Assign from Legend of the start window

C]

lllustration of when the first waveform is assigned using Legend.

Item Name Description Initial Value Note

Waveform1: Waveform name Select the file of None If there is no file
Waveform1. being displayed, you
Names of the displayed cannot specify the
waveforms and None are file.
displayed in a list.

Waveform1: Group name Decide on the group Group displayed If Waveform1 is set
name of the file selected currently from the to None, you cannot
for Waveform1. Select selected file specify the group
the group name from the name.
displayed list.

Waveform2: Waveform name Select the file of None If there is no file
Waveform1. being displayed, you

Names of the displayed
waveforms and None are
displayed in a list.

cannot specify the
file.

Waveform2: Group name

Decide on the group
name of the file selected
for Waveform2. Select
the group name from the
displayed list.

Group displayed
currently from the
selected file

If Waveform2 is set
to None, you cannot
specify the group
name.
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3.1 Displaying Waveforms

Item Name Description Initial Value Note

OK Click to show the -- This button appears
superimposed display in the dialog box.
of the groups of the
specified files.

Cancel Closes the dialog box. -

Same as above

Waveform Display Positions

In superimposed display, waveforms are displayed using the time axis and display settings
of the waveform assigned first. When you assign the second waveform and the two sets of
data have the same timestamp, that timestamp is displayed superimposed. If they do not,
the location displayed on each trend display are displayed.

During this process, the display location and the magnification of the time axis of the
waveform assigned first do not change.

Display Settings

For the following display settings (Display Group Setting on the View menu), the settings
in the assignment source file are reflected. If you change the settings of the original file,
the settings also change accordingly on the superimposed display. You cannot change the
individual displays on the superimposed display window.

Item Name Description

No. Show or hide each waveform

Channel Channel to assign to the waveform

Y-axis No. Y-axis to share between waveforms

Y-axis Mode Display mode (detail, compact)

Y-axis Type Scale display (Linear, Log (logarithmic), 2 Value)
Y-axis Title Title

Form. Display format for Y-axis scale values and data (Normal, Exponential)
Scale MIN Minimum value on the Y-axis scale

Scale MAX Maximum value on the Y-axis scale

Zone MIN Lower limit position for Y-axis display

Zone MAX Upper limit position for Y-axis display

Trip 1 to 4 usage

Whether to use trip 1, 2, 3 and 4

Trip 1 to 4 Values

Values of Trip 1 to Trip 4

Trip 1 to 4 Colors

Colors of Trip 1 to Trip 4

Time Axis

When two groups are assigned in superimposed display, the time axis is displayed using the

ejeq Bunuaauoq pue Buiheidsiq H

magnification of the group assigned first.
For example, if Waveform2 is assigned first from the two waveforms below, the time axis of
the superimposed display is set to 1 month/div.

Waveform 1: 10 min/div
Waveform 2: 1 month/div

Even if the assignment of Waveform2 is changed to a 10 msec/div group later, the display
will remain at 1 month/div.
Related item: P> “Display mode” on next page.

Y-Axis
The only available Y-axis display zones in superimposed display are Full Zone and Free
Zone.

Legend
The setting operation of items other than the group assignment function is the same as that
of normal display.
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3.1 Displaying Waveforms

Display Mode

There are two time axis display modes in superimposed display: Synchronous mode and
Individual mode.

The default mode is Synchronous mode. The mode can be switched from the Time Axis
menu or the corresponding button on the superimposed display toolbar. (If two waveforms
are not assigned, only Synchronous mode is available.)

Synchronous Mode (Initial mode) £,
TimeAxis menu —Display Mode — Synchronous Mode

L]

In Synchronous mode, the time axes are moved simultaneously while retaining the
differences in the time axes of the two superimposed groups. Only the time axis of
Waveform1 is displayed even when Waveform1 and Waveform2 are assigned. If only
Waveform1 or Waveform2 is assigned, the time axis of the assigned group is displayed.
If a group is assigned or changed and the data of Waveform1 and the data of Waveform2
contain the same timestamp (such as data acquired in dual interval measurement mode),
the timestamps are aligned. If they do not, the location displayed on each trend display
are displayed. The time axis magnification is set to the magnification of the group already
assigned.

Individual Mode *2,

TimeAxis menu —Display Mode — Individual Mode
ol

In Individual mode, the waveforms of the two superimposed groups are displayed using
individual time axes. The time axis and scroll bar are displayed separately for Waveform1
and Waveform2. The scroll bar of Waveform1 only moves the waveform of Waveform1,
and the same holds true for Waveform2.

Align with First Data £,

If you click Align with first data in Individual mode, the first data points of Waveform1 and
Waveform2 are aligned.

Align with Time &

If you click Align with time in Individual mode, the data timestamps of Waveform1 and
Waveform2 are aligned and displayed. However, if the same timestamp does not exist in
the data ranges of Waveform1 and Waveform2, the Align with time button is unavailable.
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3.1 Displaying Waveforms

Cursor

Cursors can be placed on time axes that have Waveform1 or Waveform2 data. Circles are
displayed at timestamps where data exists. In Individual mode, if you scroll the time axis,
cursors are cleared.

Cursor Value
Cursor values are displayed at timestamps where data exists (a circle is displayed above the
cursor).

Cursor Value Dialog

In the cursor value dialog box of superimposed display, the cursor values of Waveform1 and
Waveform2 are displayed in top and bottom halves. Values are displayed only if data exists
at the corresponding timestamp. Cursor values cannot be moved at the data number level.

T A B (5 7] E F
Cursor A Cursor B Dference
Diana Ho, 201 280 7
Abschde T 09280 10470 01190

1

2

3
| 4 Ghannei vale A Vale B Value B-A
| 5 CHAD1I[V Max a7 558 187

4 CHADI[V Min #9554 185

7

9 Data o 201 260 i

9 Mbsoine T 09200 10470 01180
| 1o Channel Valwe A Value B Value B-A
| 1 CHADDT["CMax 64 188 125
| 12 CHADOT["CMin 63 |E 123

e

When cursor values are copied from the cursor value dialog box, the data is copied with a
row inserted between Waveform1 and Waveform2 as shown in the figure.

Mark
In superimposed display, marks created in the original assigned file are displayed, but you
cannot edit them or add new ones.

Mark Note

In superimposed display, mark notes created in the original assigned file are displayed, but
you cannot edit them or add new ones.

You cannot switch between normal display and compact display of mark notes either.

Image Mark
Image marks are not displayed in superimposed display.

Text Comment
Text comments created in the original assigned file are displayed, but you cannot edit them
or add new ones.

Waveform Being Logged
If a waveform being logged is assigned, the waveform is updated to the latest data in sync
with the waveform display window and displayed.

Nofte

* You cannot convert data from the superimposed display.
» For saving the display conditions of superimposed display, see”4.1.2 Saving the Display
Conditions of Superimposed Display” on page 4-2.
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3.2 Displaying Waveforms on a Circular Chart

You can display data sampled on different channels of a recorder as waveforms on a circular
chart.

3.21 Circular Display Window

Procedure

1 To open the circular display window, on the Window menu, click Circular. Or, click the
Circular button.

£ |0 TARTRT
ﬂ Gircular t

Open the Circular Yindow

The circular chart appears.

Cursor Display trip lines
(red and blue broken lines)

Y-axis grid line Time axis grid line

I—I
Tabbed page s
(Select the tab of
the group to display.)

« W cHons
' [ CHong
«# W CHooS
«# D cHoog

CHOOT[¥]

10:20:00

Vertical splitter —{ (|
(Drag horizontally
to change the width
of the Y-axis area.)
,7 —e

Y-axis area

[JT [ | [201d772/08 o [hinis]

Graph area

Absolute Display time per cycle
or relative time Alarm display area

Circular display example (light style)

Circular display example (dark style)

This section explains display setting operations that are different from the waveform display
window.
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3.2 Displaying Waveforms on a Circular Chart

3.2.2

3.2.3

Setting Display Group Details

To set channel groups and how to display waveforms, use the Display Group Setting dialog
box. In the circular display, the following items in the dialog box are different from the
waveform display.

Trip Lines
You cannot drag trip lines to the circular display.
You can change trip line positions by changing the corresponding values in the Display

Group Setting dialog box.
| 2 Setting display group details (section 3.1.2)

Setting the Time Axis

Use the TimeAxis menu to set the X-axis.
In the circular display, the Y-axis spans from the center of the circle to its perimeter, and the
X-axis runs along the perimeter, as shown in the figure below.

Y-axis direction [

- Eile  Edit | Timefxis | ¥Y-fixiz 4
l_ - .~ 2 G B |[V] Bosolute Time
Time axis & i : (Y et i
$ @ @ N
direction = V1 hour

-
B 2 hours
2 G hours

8 hours

z Rl Select the display

lmge time per cycle.
1 Day

2 Days
1 week

2 weeks

4 weeks

) ) . V' | Standard Grid
Time axis grid line Dense Gridl
Y-axis gl'ld line Dense Grid2
Denze Gridd
Dense Gridd
a
,g Zoom Cut

Changing the Display Cycle
To change the display cycle (the length of time per cycle), select the cycle that you want to
display from the TimeAxis menu.

Switching the Time Zone

If data from the GX/GP/GM or Data Logging Software GA10 is displayed, you can change
the time zone for displaying the time by clicking Time Zone on the View menu.

For details: P> » Switching the Time Zone” on page 3-12
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3.2 Displaying Waveforms on a Circular Chart

3.24

3.2.5

Displaying Alarms
You can select where to display alarms: on the inside or the outside.
On the View menu, click Alarm Inside or Alarm Outside.

Alarms 1, 2, 3, and 4 are displayed in ascending order from the outside to the inside of the
circular display.

10:20:00
00308360
00205160

0050101 00350301
B2 Thim:s] B [henes]

Alarm inside Alarm outside

Displaying Cursors and Marks

The way to specify cursors in the circular display window is the same as in the waveform
display window. Click a location in the graph area to display cursor A. Drag the cursor and
release it at a different location to display cursor B. However, you cannot place cursor B
outside the current display range.

The way to add, delete, and reset marks in the circular display window is the same as in

the waveform display window. A mark on a circular display is shown with a pointer and
line (see the figure below).

Cursors Aand B

A mark in the data file
(displayed in orange)

A mark added on Universal Viewer
(displayed in green)

Note

If you set, clear, or reset items in the circular display window, the result of the operation is reflected
in the other displays.
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3.3 Displaying Digital Values

You can display data sampled on different channels of a recorder in a spreadsheet, with
data entries arranged by their timestamps.

3.31 Digital Display Window

1 To open the digital display window, on the Window menu, click Sheet. Or, click the
Sheet button on the toolbar.

=0 )% ke | 44

Sheet
Open the Sheet Window

Digital values will appear.

— Waveform label (select from channel No., tag, and tag No.)

ejeq Bunuaauoq pue Buiheidsiq

Tabbed page Data number .
(Select the tab of — Active waveform mark
Waveform — Cli
. . Click here to make
the group to display.) | ~Min. —Max. .
—| color the selected waveform active.
— value | value
GROUF 1
lu @ 1] CHo02 [V] CHOO3 [V] CHOO4 [V] *
Absolute Timeflo.] — _ _ _
201102423 21:08:00.000j00000000] 1.6763 1.8793 1.9916 1.9923 1.9696 1.9711 1.8126 1.8162
201102423 21:08:02.000[00000001 ] m 18793 1.8852 1.9923 19938 1.9865 1.9696 m 1.8051 18126
Absolute or 201102423 21:08:04.000[00000002] m 1.8852 1.8910 m 1.9938 1.9951 m 1.9832 19665 m 1.7975 1.8051
201102423 21:08:06.000[00000003] 1.6310 1.5966 1.9351 1.9962 1.95595 1.9632 1.7895 17975
relative time 201102423 21:08:08,000(00000004] 1.8966 1.9021 1.9962 1.9972 1.9562 1.9998 1.7820 1.7898
201102423 21:08:10.000[00000005] 1.9021 1.9074 1.9972 1.9980 1.9525 1.9562 1.7740 1.7820
201102423 21:08:12.000[00000006] m 1.9074 19126 m 1.93380 1.9987 m 1.9487 19525 I]E 1.76858 17740
201102423 21:08:14.000[00000007] m 1.9126 19176 m 1.9987 1.9933 m 1.9447 1.9487 m 1.7576 17658
201102423 21:08:16,000[00000003] 1.9176 1.9225 1.9993 1.9996 1.9405 1.9447 1.7492 17576
201102423 21:08:18,000[0000000%] 1.9225 1.9272 1.9996 1.9999 1.9362 1.9405 1.7407 1.7492
201102423 21:08:20.000[0000001 0] 1.9272 19316 1.9393 2.0000 19318 1.9362 1.7320 1.7407
201102423 21:08:22.000[00000011] m 19318 1.9362 m 1.83293 2.0000 m 1.9272 19316 m 1.7232 17320
201102423 21:08:24.000[0000001 2] 1.9362 1.9405 1.9998 1.9939 1.9225 19272 1.7143 17232
201102423 21:08:26,000[0000001 3] 1.9405 1.9447 1.9993 1.9996 1.9176 1.9225 1.7052 1.7143
201102423 21:08:28.000[0000001 4] 1.9447 1.9487 1.9987 1.9993 1.9126 19176 1.6960 1.7052
201102423 21:08:30.000[0000001 5] 1.9487 19525 1.9380 1.9987 1.9074 19126 16367 1.6960
201102423 21:08:32.000[0000001 6] m 1.9525 1.9562 m 19972 1.9980 m 1.8021 1.9074 m 16773 16867
201102423 21:08:34.000[0000001 7] 1.9562 13596 1.9962 1.9972 1.6966 1.9021 1.6677 16773
201102423 21:08:36,000[0000001 5] 1.9595 1.9632 1.9351 1.9962 1.8910 1.5966 1.6580 1.6677
2011402423 21:08:38,000[00000019] 1.9632 1.9665 1.9938 1.9951 1.8892 1.8910 1.6482 1.6980
201102423 21:08:40.000[00000020] m 1.9865 19696 m 1.9923 19938 m 16793 1.8852 I]E 16383 16482
201102423 21:08:42.000[00000021] 1.9896 19725 m 1.9907 1.9923 m 1.8733 1.8793 m 16282 16383
201102423 21:08:44.000[0000002%] w 1.9725 19753 1.9590 1.3907| 1.6671 1.8733 1.6180 1.6262
i ~— ™
Alarm display | Only instantaneous values are displayed for an event data file.

Red indicates alarm occurrence.
(displays the conditions of

alarms 1, 2, 3, and 4 from the left) Digital display example (light style)

CHOD [U] CHooZ [u] CHOD3 (V] CHODA[N]
Min Max ) i t Min Max

1
1
1
1
1
1
1
1
1
1
1
1.
1
1
1
1
1
1
1
1
1
1
1

Digital display example (dark style)
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3.3 Displaying Digital Values

3.3.2 Setting Display Group Details

The settings in the Display Group Setting dialog box that affect the digital display are as

follows:

» Active display group

» Display group name (tab title name)
»  Waveform display on/off state

» Channels (assignment of channels to waveforms)
» Display format of values related to waveforms (Y-axis scale, cursor values, and trip line

values)
» Waveform colors
> Setting display group details (section 3.1.2)

3.33 Setting the Time Axis

On the Time menu, click Absolute Time or Relative Time. Then, on the Time menu,
click Format, and select the display format. Clear the Data No. check box to hide it.

P

FEile  Edit | Time | Yiew Window Convert  Information

Absolute Time[Ho.]

201102423 24:08:00

201102023 21:05:02 1

2011/02023 21:05:04 1

201102023 21:05:06

2011/02/23 21:05:05 |

= Gw B ||V Aosolute Time gt X &=
A _AB Relative Time
R )
»
Eormat v | rYMMDD

Mmoo

Hone

V|| HHEMMES 555
HHMMES
HH:Mb

v | Data Mo,

Switching the Time Zone

If data from the GX/GP/GM or Data Logging Software GA10 is displayed, you can change

the time zone for displaying the time by clicking Time Zone on the View menu.

For details: P> » Switching the Time Zone” on page 3-12
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3.3 Displaying Digital Values

3.34 Setting Cursors

To specify cursors on the digital display window, select lines in the spreadsheet.

1 Click the line where you want to set a cursor.
The line is selected, and cursor A is set.

2 Drag the cursor to the line where you want to set cursor B, and release the mouse

button.
The line where you release the mouse button will be the cursor B position.

Edit—Erase Cursor to

clear the range selection. _ Click a line.
|

= J [ —— Ty =
Bk Edn Time Vew Wrdo Conve prormatn Gentre beb

GREB A gl JERE QR [ G E R el W Re &P
o of Yo o¥ | Wl im0 Fin

2001127 21

20102123 21.09,04 000} [ | S | — Cursor A

Selected
range
Drag and
release.
— Cursor B

3 To clear the cursors, on the Edit menu, click Erase Cursor.
The range selection will be released.

Note

You can use the keys below to move the display range.

* Press the UP ARROW key to scroll a line up and the DOWN ARROW key to scroll a line down.

* Press the PAGE UP key to show the previous page and the PAGE DOWN key to show the next
page.

» Press the RIGHT ARROW key or LEFT ARROW key, respectively, to move one channel to the
right or left.

Selecting All Data Points

On the Edit menu, click Select All to move cursor A to the beginning of the data and cursor
B to the end of the data.

Copying Data
On the Edit menu, click Copy to copy the data between cursors A and B.
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3.3 Displaying Digital Values

3.3.5 Adding a Mark

In this window, click a line to add a mark.
For details, see “3.1.10 Adding, Editing, and Deleting Marks” on page 3-23.

Procedure

1 Click the line where you want to add a mark.
Cursor Ais set.

2 On the Edit menu, click Append Mark. Or, click the corresponding button on the

toolbar.
The Mark Settings box appears.

3 Edit the mark information, and click OK.
A mark is added to the cursor A line.

| 201241209 10235212, 000[00000002]
(W e e S e e O -1.9850 -1.49828

Mark 2012412709 10235 16,000 [D0000004] -1,9850

Nofte

If you set, clear, or reset cursors or markers in the digital display window, the result of the operation
is reflected in the other displays.
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3.4 Displaying a List of Alarms, Marks, and Image
Marks

When a display data file or event data file is open, you can view information related to
alarms, marks, image marks, events, control operations, and operation log entries in list
form.

To convert and save this information, see “3.10 Converting Data” on page 3-74.

3.41 List display window

1 To open the list display window, on the Window menu, click List. Or, click the List
button on the toolbar.

E ke | ) £

B List ’_

800.DAD] Open the List Window

The List window opens.

2 Universal Viewer o= ox

ejeq Bunuaauoq pue Buiheidsiq

Eile Edit Time Yiew Window Gonvert [formation Sienaturs  Help

R A MR A | e e a == v | ] ke |4 €4 (2 | @ B
A A

% %o o7 | AR fin 8fl Fie

Display File-List[000021_121207_134056.DAD] o= x

201212107 13:41:50.000[00000027]
201201 2107 13:44: 20.000[00000102]
201201 2007 135001 8.000[00000251]
20121207 13:51:48 000[00000326]
201212107 13:52:50,000[00000357]
201212107 13:55:20,000[00000432]
2012112107 14:03:18.000[00000671]
2012112007 14:04:48.000[00000716]
201212107 14:05:50.000[00000747]
2012112007 14:08:20.000[00000822]
201201 2107 14:14:15.000[0000 001
201201 2007 14:15:45.000[0000 0d6]
20121207 14:16:50.000(00001 077]
201212107 14:18:20,000[00001152]
20121207 14:27:18.000[00001 391]
2012112007 14:26:48.000[00001 436]
2012112007 14:28:50.000[00001 467
201212007 14:32:20.000[00001 542]
2012112107 14:38:18.000[00001 721
201211 2107 14:3545.000[0000 7E6]
201211 2007 14:40:50.000[0000 757]

Channel
CHOO3
OFF CHOO1 L1
on CHO04. L4
On CHOO2 L2
OFF CHOD4. L4
OFF CHODZ2 Lz
on CHOD3 L3
on CHOO1 L1
OFF CHOO3 L3
OFF CHOO1 L1
on CHO04. L4
onl CHO02 Lz
OFF CHOO4 L4
OFF CHODZ2 Lz
on CHODZ L3
on CHOO1 L1
OFF CHOD3 L3
OFF CHOO1 L1
on CHOD4. L4
onl CHO02 Lz
OFF CHO04. L4

-

FF-FIIIIFCr--IIIICCCCIX

D I Rl IR I I A

| Reaty | P NUM| SO

The List window consists of the following tabbed pages.

» Alarm List

* Mark List

* Image Mark List

* Event List

» Ctrl Alarm List

» Ctrl Status List

* Operation Log List

The Alarm List and Mark List tabbed pages are always displayed, but whether the other
tabbed pages are displayed depends on the model and feature of the recorder that sampled
the data.

For details on the Event List and Ctrl Status List tabbed pages, see section 3.5. For details
on the Operation Log List tabbed page, see section 3.6.

P Files that can be displayed and their extensions (section 1.1.1)
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3.4 Displaying a List of Alarms, Marks, and Image Marks

3.4.2 Alarm List

r Alarm List tabbed page Cursor selection

Alarm List Mark List
Status j—Stetus Channel Level | Type \ Absolute Time -
w CHOO3 L3 H t 2012412/07 13:41:50.000[00000027]
Alarm occurrence OFF L H ot 201201207 13:44:20,000[00000102)
agn ON L4 L 3 201242007 13:50018.000[00000281]
or release condltlon ON L2 L 4 2012412/07 13:51:48.000[00000326]
L 4 201212007 13:52:50.000[00000357]
L 4 201242007 13:5520.000[00000432]
Channel =-
o
Channel on which g
H 1
the alarm occurred oG
L+
L 4 201211207 14:15:45.000[00001046]
OFF CHOD4 L 3 20121 2/07 14:16:50.000[00001077]
Level EE. HOO! L L 4 20124207 14:19:20.000[00001152]
. ON CHOO3 L3 H t 2012112007 14:27:18.000[00001331]
Position where on cHOO1 L1 H T 2012A207 14:26 45 000[00001 436]
OFF CHOO3 L3 H t 201241207 14:29:50.000[00001 467]
the alarm occurred .. oo L ks
ON CHOD4 L4 L 20124207 14:38138.000[00001721]
ON CHOOZ L2 L 4 2012112/07 14:3%:48.000[00001 766]
L| 201242107 14:400:50.000[00001 737]

The specified alarm type Time of alarm occurrence or release

The Alarm List tabbed page lists the alarm information (changes in the alarm status during
recording) in the data file. The table below describes the displayed items.

Status

Display Description

ON Alarm occurrence

OFF Alarm release

ACK Alarm ACK operation

Level

Display Description

L1 Alarm 1

L2 Alarm 2

L3 Alarm 3

L4 Alarm 4

ALL Alarms 1 to 4

Alarm Type

Display Description

OFF Alarm off

H high limit alarm

L low limit alarm

dH Difference high limit alarm

dL Difference low limit alarm

RH High limit on rate-of-change alarm
RL Low limit on rate-of-change alarm
tH Delay high limit alarm

tL Delay low limit alarm

PVH Measurement high limit alarm
PVL Measurement low limit alarm
DVH Deviation high limit alarm
DVL Deviation low limit alarm
DVO Deviation out limit alarm

DVI Deviation in limit alarm

SPH Setting high limit alarm

SPL Setting low limit alarm

OTH Output high limit alarm

OTL Output low limit alarm

ETC Other CX alarm

27?7 Other non-CX alarm

7?7 Alarm Ack [ALL](when all alarms are acknowledged)
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3.4 Displaying a List of Alarms, Marks, and Image Marks

Procedure

Sorting Data

On the Alarm List tabbed page, click a title item to sort the list by the item.

The first time you click, the list is sorted in ascending order; the second time you click, in
descending order.

Copying Data

Specify the cursor range. Click a line to select cursor A and drag to cursor B. (The method is
the same as in the digital display window.)

On the Edit menu, click Copy to copy the data between cursors A and B to the clipboard.
The status, channel, level, type, and time information is copied. For the type, only the
character string is copied. The data numbers in the Time column are not copied.

In addition to the operations above, you can specify the following settings on the Alarm List
tabbed page.

» Switch the channel string (View menu)

» Switch between absolute and relative time (Time Axis menu)
+ Switch the time display format (Time Axis menu)

» Switch the time zone (View menu, GX/GP/GM and GA10 data only.)
» Show or hide data numbers (Time Axis menu)

» Search for alarms (Edit menu or search bar)

» Clear cursors (Edit menu)

+ Select all data (Edit menu)

» Add marks (Edit menu or toolbar)

» Delete marks (Edit menu or toolbar)

* Reset marks (Edit menu)

» Search for marks (Edit menu or search bar)

Note

If you set, clear, or reset items in the Alarm List tabbed page, the result of the operation is reflected
in the other displays.
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3.4 Displaying a List of Alarms, Marks, and Image Marks

3.4.3 Control Alarm List

Control Alarm List tabbed page lists the control alarm information in the data file acquired
using the GX/GP/GM (PID control module). The table below describes the displayed items.

Status Loop Type

i g el

Loop

Level Time of control alarm occurrence
Status
Display Description
ON Alarm occurrence
OFF Alarm release
ACK Alarm ACK operation
Loop
Display Description
LOO01 to L652 Loop number
This changes to tag number or tag string depending on the
display format in the menu.
Level
Display Description
L1 Alarm 1
L2 Alarm 2
L3 Alarm 3
L4 Alarm 4
ALL Alarms 1 to 4
Type
Only character strings are displayed. Icons are not displayed.
Display Description
OFF Alarm off
PVH PV high limit alarm
PVL PV low limit alarm
SPH SP high limit alarm
SPL SP low limit alarm
DVH Deviation high limit alarm
DVL Deviation low limit alarm
DVO Deviation out limit alarm
DVI Deviation in limit alarm
OTH Output high limit alarm
OTL Output low limit alarm
PVR PV velocity

Absolute Time
Display Description

yyyy/mm/dd hh:mm:ss.[Memory sample number]  Time of control alarm occurrence.
Example: 2017/02/10 17:43:33.000[00000240]
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3.4.4

Mark List

Mark List tabbed page _ Time when the
Click to S\llvitch the page. Cursor Mark type mark was added.

1 ark List
[ Asolute Time: I Mark I User [ orow [ Joed ] Operation Time

1. EWENT [Ewent In] All Groups: 20121 2007 13:50.00 000]

20 21 207 14:00:00.000[00001145] 1 EWENT [Evert In] All Groups 201201 2107 14:00:00 000

20121 2/07 14:40:00.000(00003545]
20121 2/07 14.40.:54.000[00003599] TRIG

T
Timestamp of the data entry
that the mark was added to.

[Evenit In Al Groups ] 201201 2007 14:40:00 000
[Mane] &l Groups

|_Disp|ay group
where the mark was added

Mark string that
was added. Name of the user that added the mark.

The Mark List tabbed page lists mark information (marks added during recording and marks
added on Universal Viewer) in the data file. The displayed items are described below.

Mark

If the mark string is too long and does not fit in the display area, the overflowing characters
are replaced with an ellipsis.

User

Display Description

Key In Input through key operation (touch operation) on the main unit
Remote In Input through remote control

Comm. In Input using a communication command

Event In Input through event action

Serial In Input through control via serial communication

System In Input through auto control

EXTERNAL Input through Modbus or other control

WEB Input through the Web application

Username The name of the logged-in user that performed the operation
None None

Unknown Input other than above

Group

Display Description

All Groups Mark that applies to all groups

Group a, Group b, Group c, etc. Displays the applicable group number*

*

When the applicable group is one group: Group a

When the applicable groups are multiple groups: Group a, Group b, Group ¢

* a, b, c: Group numbers The number of digits is not fixed. The numbers are shown in ascending
order.

» If the group string is too long and does not fit in the display area, the overflowing characters are

replaced with an ellipsis.

Type
Display Description
Trigger position
Message created on the recorder and saved in the data file
@ Mark added on Universal Viewer
E Mark added on the data logging software GA10
Nofte

Marks cannot be added during recording to data recorded by DAQLOGGER or DAQ32Plus/
DAQ32. As such, only the trigger positions are displayed when the data file is opened.
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3.4 Displaying a List of Alarms, Marks, and Image Marks

Procedure

Copying Data

Specify the cursor range. Click a line to select cursor A and drag to cursor B. (The method is
the same as in the digital display window or the Alarm List tabbed page.)

On the Edit menu, click Copy to copy the information between cursors A and B to the
clipboard. However, the icons under the mark Type column are changed to the following
character strings.

Display Recorder Model That Created the Data File String That Is Copied
— TRIG
DX100, DX200 DX
MV100, MV200 MV
CX1000, CX2000 CX
DX100P, DX200P DXP
FX100 FX
DX1000, DX2000 DX-Adv.
DX364 DX-Adv.
MV1000, MV2000 MV-Adv.
FX1000 FX-Adv.
FW1000 FW-Adv.
AX100 AX
GX10, GX20 GX
GP10, GP20 GP
GM10 GM
puR10000 or yR20000 with the /EM1 option uR
@ — Viewer
Data Logging Software GA10 PC Soft

In addition to the operations above, you can specify the following settings on the Mark List
tabbed page.

+ Switch between absolute and relative time (Time Axis menu)
+ Switch the time display format (Time Axis menu)

» Switch the time zone (View menu, GX/GP/GM and GA10 data only.)
» Show or hide data numbers (Time Axis menu)

» Search for alarms (Edit menu or search bar)

» Clear cursors (Edit menu)

+ Select all data (Edit menu)

* Add marks (Edit menu or toolbar)

» Delete marks (Edit menu or toolbar)

* Reset marks (Edit menu)

» Search for marks (Edit menu or search bar)

Note

If you set, clear, or reset items in the Mark List tabbed page, the result of the operation is reflected
in the other displays.
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3.4.5

Image Mark List

Mark List tabbed page
Click to switch the page.
‘ Time when the image mark was added

Image Mark List )

Absolute Time | Creation Time. | Image Mark | User | Group
L 2012/10/02 14:10:41.000{00000104] — ;
2012110/02 141321 ] 2012/10/02 14:1513.760__| i [Key In] Al Groups
li
2012/10/02 14:15:21.000[00000334] ¥ =
201211002 14:16:44.000[00000467] 201211002 14:19:58.510 II [Key In] All Groups
‘ |

Timestamp of the data entry Image mark that was added Display group where

that the image mark was added to the image mark was
Name of the user that added the image mark added

The Image Mark List tabbed page lists image mark information (freehand messages added
during recording) in the data file. The displayed items are described below.

Image Mark

Reduced image marks are displayed.

User

Display Description

Key In Input through key operation (touch operation) on the main unit
Remote In Input through remote control

Comm. In Input using a communication command

Event In Input through event action

Serial In Input through control via serial communication

System In Input through auto control

Username The name of the logged-in user that performed the operation
None None

Unknown Input other than above

Group

See the description for the Mark list tabbed page.

Procedure

Copying Data
The procedure is the same as that for the Mark list tabbed page. Images of freehand
messages are not printed.

Image Mark Dialog Box

Double-click a line to open the Image Mark dialog box. You can copy or print the image
mark from the Image Mark dialog box. For the operating procedure, see “3.1.12 Displaying,
Copying, and Printing Image Marks (Freehand messages)” on page 3-28.

In addition to the operations above, you can specify the following settings on the Image
Mark List tabbed page.

» Switch between absolute and relative time (Time Axis menu)

» Switch the time display format (Time Axis menu)

» Switch the time zone (View menu, GX/GP/GM and GA10 data only.)

» Show or hide data numbers (Time Axis menu)

» Specify cursors

» Clear cursors (Edit menu)

» Select all data (Edit menu)

» Delete marks (Edit menu or toolbar)

Nofte

If you set, clear, or reset items in the Image Mark List tabbed page, the result of the operation is
reflected in the other displays.
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3.5

Listing Event Information and Control Modes

You can display event information and control mode information for display data files and
event data files whose data has been sampled on the GX/GP/GM (PID control module) or
the CX1000 or CX2000.

These two sets of information are displayed on the Event List tabbed page and Ctrl Status
List tabbed page in the alarm/mark display window (section 3.4).

3.5.1 Event List

The Event List tabbed page lists events that occurred during memory sampling.

1

To open the list display window, on the Window menu, click List. Or, click the List
button on the toolbar.

Elﬂl@[% ke | 4 &
B List ’_

800.0AD] Open the List Window

The List window opens

2

Click the Event List tab.

Event source information

Time when the event occurred

Event List Time when the event ended
|
Ewverit List I
| hame [ Level [ Type | Evert ON | Evert pFF
KTIHE EVENT L02  TH (@ [2010/05/11 16:14:24.000 53] [2010/05/11 16:14:25.250( 54]|
INT-02 LO1 PYH T 2010/08/11 16:14:24,000 [00000053]  2010/05/11 16:14:25.250 [00000054]
INT-03 L03  PYH T 2010/08/11 16:14:24,000 [00000053]  2010/05/11 16:14:25.250 [00000054]
INT-03 L02  PYH T 2010706711 16:14:24,000 [00000053]  2010/06/11 163 14:25.250 [00000054]
TIME EVENT L02  TM D 2010/06/11 16:14:35,500 [00000055]  2010/05/11 16:14:36. 750 [00000060]
INT-02 L01T  PYH +  2000/05/11 1R:14:35.500 [00000054] 201070511 162 14:36. 750 [000000R0]
INT-03 03  PYHt  2010/06/11 16:14:35.500 (00000058]  2010/06/11 16:14:36. 76000000060
INT-03 2010/05/11 18:14:35.500[00000053]  2010/05/11 16:14:36. 7560 [00000080]

Event level

Sorting Data

Event type

On the Event List tabbed page, click a title item to sort the list by that item.
The first time you click, the list is sorted in ascending order; the second time you click in

descending order.

The table below shows the ascending sort rule.

Title Ascending Display Order

Name Time event, PV event. PV events are sorted by the displayed character strings.

Level Ascending order from LO1 to L16

Type Off, time event, measurement high limit, measurement low limit, deviation high limit,
deviation low limit, deviation out limit, deviation in limit, setting high limit, setting low
limit, output high limit, output low limit

Event ON Ascending order by event on time, space

Event OFF Ascending order by event off time, space
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Copying Data

Specify the cursor range. Click a line to select cursor A and drag to cursor B.

On the Edit menu, click Copy to copy the data between cursors A and B to the clipboard.
The name, level, type, event ON, and event OFF information is copied. For the type, only
the character string is copied. The data numbers in the Time column are not copied.

In addition to the operations above, you can specify the following settings on the Event List
tabbed page.

» Switch between absolute and relative time (Time Axis menu)
» Switch the time display format (Time Axis menu)

» Show or hide data numbers (Time Axis menu)

» Search for alarms (Edit menu or search bar)

» Clear cursors (Edit menu)

» Select all data (Edit menu)

» Add marks (Edit menu or toolbar)

» Delete marks (Edit menu or toolbar)

* Reset marks (Edit menu)

» Search for marks (Edit menu or search bar)

Explanation

The items on the Event List tabbed page and their descriptions are provided below.

Name
Display Event Type Tag Number Loop Type Description
Available?
TIME EVENT Time event TIME EVENT
[ TagNo ] Yes Tag number string
INT-[ LoopNo ] PV event No Internal INT-[loop number]
EXT- [ LoopNo ] External EXT-[loop number]
Loop numbers are displayed in two digits. A zero is inserted in the tens digit for numbers
less than 10.
Level

Displays LO1 to L16.

Type

Display Description

OFF Event off or event setting release
™ Time event

PVH Measurement high limit

PVL Measurement low limit

DVH Deviation high limit

DVL Deviation low limit

DVO Deviation out limit

DVI Deviation in limit

SPH Setting high limit

SPL Setting low limit

OTH Output high limit

OTL Output low limit

7?7 Displayed in cases other than the above

Event ON and Event OFF

Displays the time an event occurred and the time the event was released in the specified
format.
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3.5 Listing Event Information and Control Modes

3.5.2

Ctrl Status List

The Citrl Status List tabbed page displays control mode information.
The method to show this page is the same as that for the Event List tabbed page. On the
Window menu, click List and then the Ctrl Status List tab.

Data Display Example on the GX/GP/GM (with the PID control module)

Name

Status
|

Absolute Time

Pattern01 TMESZOFF 201710210 15:42. 16 F5UUH000515]
Pattern01 TME1 OFF 20170210 15:42:16.450[00000515]
Loop082 Run 201770210 15:45:08.630[00000600]
Loop0s2 Aute 201770210 15:45:10.230{00000602)
Pattern01 TMEZ2 ON 201702110 15:46:17.550[00000636]
Pattern01 THE1 OH 201710210 15:46:17.550{00000636]
Pattern01 SPL PVE32 ON 20170210 15:46:17.650[00000636]
Pattern01 ADVANCE 2017702110 15:47:08.950{00000660]
Pattern01 PVH PVE32 OFF 201710210 15:47.07.050{00000661]
Pattern0 TME32 OFF 2017102410 15:47:15.450{00000865]
Pattern01 TME1 OFF 201702110 152 50[00000665)
Pattern01 PROG RESET 20170210 15:47:15.450[00000665]
Loop081 Stop. 201770210 15:47:15.530{00000665]
Loop0s2 Stop. 201710210 15:47:39.130[00000677)

Explanation

The following table shows the contents displayed in the Ctrl Status List on the GX/GP/GM

(with the PID control module).

Name

Status Absolute Time

Loop number '

LOCAL Time of control status

occurrence.
REMOTE
PROGRAM
AUTO
MANUAL
CASCADE
RUN
STOP
AT [PID Number] ON
AT [R] ON
AT OFF
STAND-BY ON
STAND-BY OFF

Pattern number 2

PROG RUN
RESET
HOLD ON
HOLD OFF
WAIT ON
WAIT OFF
ADVANCE

Pattern number, Loop number, Type E
Example: Pattern 0 Loop 092DVO

PVE [PV event number] ON *
PVE [PV event number] OFF

Pattern number

TIME [TIME event number] ON °
TIME [PV event number] OFF

abhwnN

Loop name on the View menu can be used to switch between Loop number, Tag No., and Tag

string.

Pattern on the View menu can be used to switch between Pattern number and Pattern name.

For Type, the control alarm type on page 3-48 is displayed.
PV event number is a number between 1 to 32.
TIME event number is a number between 1 to 32.
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Display Example of a CX1000/CX2000 Data File

Time when the control mode Run condition Program run/stop
was changed Control mode Program hold
| Control SP Program wait
] Il
TR s | |
[Absolute Time Name | Loy - | posan, s
[ Guomgb [ Came) [ Csp) [ #unmesh [ Crow ) [ Covar )
200407705 17:45:00.000[00000000] ] Program =Run= OFF OFF
200407 /05 17:45:00.000[00000000] INT-01 Run At =Program=
200440705 17:45:00.000[00000000] INT-01 <Run= Auto Program
2004407 /05 17:45:00.000[00000000] Program <Reset= OFF OFF
200440705 17:45:00.000[00000000] INT-01 Stop Auto <Local>
2004407 /05 17:45:00.000[00000000] INT-01 =Stop= Auto Local
200440705 17:45:00.000[00000000] INT-02 <Run= Mzl Local
200407705 17:45:00.000[00000000] INT-02 =Run= Manual Local
200407705 17:45:00.000[00000000] Program Run OFF =0N=
200407705 18:01:00.000[0000001 8] Program Run OFF =0FF>
200407705 18:01:00.000[0000001 8] IMT-0; =Stop= Manual Local
20040705 23:02:00.000[00000317] =Run= Manual Local
20040706 00:01:00.000[00000378] Run OFF =0N=
2004407 /06 00:06:00.000[00000381 ] Run OFF <OFF>
2004407 /06 00:06:00.000[00000381 ] INT-02 =Stop= Mzl Local

L_The name of the loop in which the control mode changed or
whether or not the mode change was due to program control

Explanation

The items on the Ctrl Mode To tabbed page and their descriptions are provided below.

Time
Time when the control mode was changed The display format is the same as that of the
windows and tabbed pages of other list formats.

Name

The name of the loop in which the control mode changed or whether or not the mode
change was due to program control

If the event is a control mode change, the display format varies depending on whether there
is tag information.

If the event is program control, “Program” is displayed.

Display Control Type Tag Number Loop Type Description
Available?
Programs Program control
[ TagNo ] Yes Tag number string
INT- [ LoopNo ] Control mode No Internal INT-[loop number]
EXT- [ LoopNo ] External EXT-[loop number]

Ctrl—Run/Stop
Nothing is displayed for program control.

Display Description
Run Running
Stop Stopped
Red characters enclosed in angle brackets. Indicates that the state has changed.
Black characters not enclosed in angle brackets. Indicates that the state has not changed.

Ctrl—A/M/C

Indicates auto, manual, or cascade control mode.
The meaning of the character color and the angle brackets are as described above.

Ctrl—SP

Indicates whether the SP value is in remote, local, or program mode.
The meaning of the character color and the angle brackets are as described above.

Display Description
Local Indicates local mode.
Remote Indicates remote mode.
Program Indicates program mode.
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3.5 Listing Event Information and Control Modes

Program—Run/Stop
Nothing is displayed for control mode.

Display Description
Run Program control is running.
Stop Program control is stopped.
Red characters enclosed in angle brackets. Indicates that the program condition has changed.
Black characters not enclosed in angle brackets.|Indicates that the program condition has not changed.

Program—Hold

Indicates program control hold and release condition.

The meaning of the character color and the angle brackets are as described above. Nothing
is displayed for control mode.

Display Description
ON Indicates program control hold.
OFF Indicates program control hold release.

Program—Wait

Indicates program control wait and release condition.

The meaning of the character color and the angle brackets are as described above. Nothing
is displayed for control mode.

Display Description
ON Indicates program control hold.
OFF Indicates program control hold release.

Copying Data

Specify the cursor range (row range). Select cursor A (row), and drag to cursor B (row).
On the Edit menu, click Copy to copy the data between cursors A and B to the clipboard.
The time; name; ycontrol mode; control's A, M, or C; control SP; program mode; program
hold; and program wait information is copied. However, data numbers in

the time column are not copied. On the Edit menu, click Erase Cursor to clear the cursor
range (row selection).

Converting Data

The event information in the data file that is currently displayed can be converted and saved
in Excel or ASCII format. On the Convert menu, click Ctrl Mode To to open the Ctrl Mode
To dialog box. Set the conditions for converting and saving the file in this dialog box.

| 4 Converting data (section 3.10)

In addition to the operations above, you can specify the following settings on the Ctrl Mode
To tabbed page.

» Switch between absolute and relative time (Time Axis menu)
» Switch the time display format (Time Axis menu)

» Show or hide data numbers (Time Axis menu)

» Search for alarms (Edit menu or search bar)

» Clear cursors (Edit menu)

+ Select all data (Edit menu)

* Add marks (Edit menu or toolbar)

» Delete marks (Edit menu or toolbar)

* Reset marks (Edit menu)

» Search for marks (Edit menu or search bar)
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3.6 Listing the Operation Log (DX100P/DX200P,
DX1000/DX2000 with the /AS1 option, or GX10/
GX20/GP10/GP20/GM10 with the /AS option)

You can display operation logs of display data files and event data files that have been
sampled on the DX100P; DX200P; DX1000, DX1000N, DX1000T, DX2000, or DX2000T
with the /AS1 option; or the GX10, GX20, GP10, GP20 or GM10 with the /AS option.
Operation logs are displayed on the Operation Log List tabbed page in the List window
(section 3.4). The file name extension is .GSD, .DSD, or .dbd (display data files) or .GSE,
.DSE, .dbe (event data files).

3.6.1 Operation Log List

The Operation Log List tabbed page lists operation log information in data files.

1 To open the list display window, on the Window menu, click List. Or, click the List
button on the toolbar.

Eﬂl%l% ke | 4 £
B List ’_

800.DAD] Open the List Window

The List window opens.
2 Click the Operation Log List tab.

Serial number of operation log entries

Absolute or relative time
Switch by selecting Absolute Time or Relative Time from the View menu.

TR
Logtio. ' AusouioTine I == e I e At o

(00000545} 20060111 152415200 Acknind Keyin
00000548 00BN 152434300 Acknind Keyin
[00000547] 200801 152435000 Acknind Keyin
00000548 00BN 152448800 Acknind Keyin
00000543 0081 162508800 Ackmind Keyin
"
"

Display.
Disglay,

[o0000s50] 00BN 152548500 Acknin Keyin
00000551 200801 152802200 Acknin Keyin
[00000552] 20080101 15:26:24.200 Enor(System)

[00000553] 2008101101 152924 800
[00000554] 2008101101 152930800
[00000555] 200810101 152933400

Enor(System)

User that executed Operation method Display button
the operation Displays detail information

For log entries that have detail information, the Display button is enabled.

3. Click Display.

Detailed Info.-No.00000537 =7
Absolute Time 401421 13:34:32 430
Operation Error261
Kind SYSTEM

User

E0261
Wrong user ID or passwiord.

The Detailed Info. dialog box appears.
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3.6 Listing the Operation Log

Note

If there are log entries of setting changes on the recorder that sampled the data, such entries are
emphasized with text shadowing.

For these entries, you can start the configuration software from Universal Viewer to check all the
settings of the recorder after the change. For instructions on how to start the configuration software,
see section 3.6.2.

You can also perform the following operations on the Operation Log List tabbed page.

» Switch between absolute and relative time (Time Axis menu)
» Switch the time display format (Time Axis menu)

» Select all data (Edit menu)

* Reset marks (Edit menu)

» Sort data (Clicking on a title item)

 Filtering data (User, Kind, Operation)

» Copy data (Edit menu)

Filter Function

You can apply filters to the user, kind, and operation items.
The selected items are hidden from the list.

T Click the filtering icon (@l ) of each title.
A filtering dialog box appears.

2 Select the check boxes for the items you want filtered, and click OK.

e ary Lt

120005407 FOINI0T 124414 740 Search

0005410 2181002 124510040 =

o001 2019°0002 124733370 "

1000054 18] 20101502 126504 139 B UsacObl

1000018 20101502 125022500 2 Userbi?

100000432] 20191002 125835 40 &

10008438 20191002 13:00:18.000 & Usertiy

10005443 20181002 120557 835 & Userbbd

1a0ussE] 20181002 131022200

F000M4H 0191002 131147580

RO0DM5T AT ITTSING | —
100008455] sz nzoamee | (%] ([feeel ] (Selecl A1) folect Nond

Filtered items are hidden from display.

Converting Data

The operation log information in the data file that is currently displayed can be converted
and saved in Excel or ASCII format. On the Convert menu, click Operation Log To to open
the Operation Log List dialog box. Set the conditions for converting and saving the file in this
dialog box.

Converting data: P section 3.10
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Explanation

The items on the Operation Log List tabbed page and their descriptions are provided below.

Log No.

Serial number of operation log entries

Time

Time when the operation took place

User

Displays the user name

Kind

Displays the type of information according to the recorder product
In case of an error or alarm, “Error” or “Alarm” appears followed by the type of error or alarm
in parentheses. For example, if an error occurred when a key was pressed, “Error(Key In)”

appears. If an alarm occurred when a key was pressed, “Alarm(Key In)” appears.

Device Type (DX100P/DX200P DX1000/DX1000N/DX2000
with the /AS1 option

Display Key In Key In

Remote In Remote In

User Key In. Comm. In

Comm. In Event

PC Software System

Meas. Srv.(Monitor) PC Software

FTP Server Warning

Test Srv.(Setting) Error

Test Srv.(Monitor) Unknown

Serial Comm.

Auto

Warning

Error

Unknown

Device Type [GX10/GX20/GM10
with the /AS option
Display OPERATE Touch operation on the recorder (including operations by barcode
input)
REMOTE Input by remote control
COMMU Input via communication (including operations through Web
application)
ACTION Operations by event-action function
SYSTEM Operation conducted by the recorder automatically
SERIAL Operation via serial communication
EXTERNAL Operation via Modbus, etc.
WEB Operation via the Web apllication
PC User is locked because of wrong operation on the PC.
Operation

The type of operation that took place is displayed. Operations vary depending on the model.
The table below shows the operations that are displayed on the Operation Log List tabbed

page.
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3.6 Listing the Operation Log

List of Operations by Model
DX100P, DX200P

Operation What Appears on the Screen (Bold words are displayed
on the screen. Non-bold words are explanations.)

Login Login

Logout Logout

Invalid password Password refused

Memory start Start memory

Memory stop Stop memory

Alarm acknowledgment Alarm ACK

Message Message

Manual sample Manual sample

Trigger Trig

Start computation

Start Math function

Stops computation

Stop Math function

Reset computation

Reset Math data

Computation dropout acknowledgment

No Math data ACK

Snapshot Snapshot
Start mail Start mail
Stop mail Stop mail
Save display data Save Display Data

Save event data

Save Event Data

Load display data

Load Display Data

Load event data

Load Event Data

Change settings

Change configuration [setting file sequence number]

Before time change

Before time change

Before time adjustment

Before time adjust

After time adjustment or change

After change(adjust) time

Power failure

Power failure occurs

Recovery after power failure

Restart after Black Out

Load login information

Load login information

Execute clear 1 Clear 1
Execute clear 2 Clear 2
Execute clear 3 Clear 3

Set batch number

Set batch number

Set lot number

Set lot number

Invalid password

Password refused

Save system mode configuration

Save configuration (system mode)

Save engineering mode configuration

Save configuration (engineering mode)

Load system mode configuration

Load configuration (system mode)

Load engineering mode configuration

Load configuration (engineering mode)

Change system mode configuration

Change configuration [setting file sequence number]
(system mode)

Change engineering mode configuration

Change configuration [setting file sequence number]
(engineering mode)

Change the engineering mode and
system mode configurations

Change configuration [setting file sequence number]
(system mode & engineering mode)

Change login information configuration

Change configuration [setting file sequence number] (Login
information)

Change the system mode configuration
and settings related to user registration

Change configuration [setting file sequence number]
(system mode & Login information)

Login to A/D calibration mode

Login(A/D calibration mode)

Execute A/D calibration

Execute A/D calibration

Acknowledge unauthorized access

Set user refused ACK

Change password

Change Password

Shutdown

Shutdown

Upload file

File Upload

Download file

File Download

Change the number of calibration
correction points

Input calibration point change (CH Channel
number:previous number of points->new number of points)

Change the calibration correction value

Set Point is changed (CH Channel number No.Calibrated
point:Value)
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3.6 Listing the Operation Log

Operation

What Appears on the Screen (Bold words are displayed
on the screen. Non-bold words are explanations.)

Reset computation

Reset Math data (CH Channel number)

Start gradual time adjustment

Start of time adjustment [Difference from the time to change
to (+/-, minutes, seconds, milliseconds, microseconds)]

Adjust time using SNTP

Time adjustment by the SNTP server.

Switch in or out of daylight saving time

Summer or winter time change.

Save data from internal memory

Manual data save to removable media.

Change the engineering mode
configuration and settings related to
user registration

Change configuration [setting file sequence number]
(engineering mode & Login information)

Change the engineering mode and
system mode configuration and settings
related to user registration

Change configuration [setting file sequence number] (all)

DX1000/DX1000N/DX1000T/DX2000/DX2000T Models with Release Number 4

and the /AS1 Option

Operation

What Appears on the Screen (Bold words are displayed
on the screen. Non-bold words are explanations.)

A/D calibration mode

A/D calibration mode

A/D calibration

A/D calibration

Power off Power off
Power on Power on
Login Login
Logout Logout
Invalid user Invalid user

Change password

Change Password

Acknowledge unauthorized access

Unauthorized access ACK

Start memory

Start memory (when the batch group number is invalid)

Start memory [Batch group number] (when the batch group
number is valid)

Stop memory

Stop memory (when the batch group number is invalid)

Stop memory [Batch group number] (when the batch group
number is valid)

Acknowledge alarm

Alarm Ack [ALL] (when all alarms are acknowledged)

Alarm Ack [CH Channel number/Lvl Alarm level](when not all
alarms are acknowledged)

Reset alarm display

Alarm Display Reset

Message

Message (when the batch group number is invalid)

Message [Batch group number] (when the batch group
number is valid)

Manual sample

Manual Sample

Start computation

Start Math function

Stop computation

Stop Math function

Reset computation

Reset Math data (when the batch group number is invalid)

Reset Math data [Batch group number] (when the batch
group number is valid)

Acknowledge computation data dropout

No Math data ACK

Snapshot Snapshot
Start mail Start mail
Stop mail Stop mail

Save display data

Save Display Data (when the batch group number is invalid)

Save Display Data [Batch group number] (when the batch
group number is valid)

Save event data

Save Event Data (when the batch group number is invalid)

Save Event Data [Batch group number] (when the batch
group number is valid)

Manual data save to removable media.

Manual data save to removable media.

New time after time change or
adjustment

New time after time change or adjustment

Change time

Time Correction

Start time adjustment

Time adjustment start [Difference from the time to change to
(the text in the data file is displayed)]

Stop time adjustment

Time adjustment stop
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3.6 Listing the Operation Log

Operation

What Appears on the Screen (Bold words are displayed
on the screen. Non-bold words are explanations.)

Change time using SNTP

Time adjustment by the SNTP server.

Switch in or out of daylight saving time

Switch between normal and daylight saving time

Set batch number

Set batch number (when the batch group number is invalid)

Set batch number [Batch group number] (when the batch
group number is valid)

Set lot number

Set lot number (when the batch group number is invalid)

Set lot number [Batch group number] (when the batch group
number is valid)

Writing to a batch text field

Writing to batch text field (when the batch group number is
invalid)

Writing to batch text field [Batch group number] (when the
batch group number is valid)

Second display update rate

Second display update rate

Standard display update rate

Standard display update rate

Modbus client manual recovery

Modbus client manual recovery

Modbus master manual recovery

Modbus master manual recovery

Reset timer

Timer Reset [ALL] (when all timers are reset)

Timer Reset [Timer number](when not all timers are reset)

Reset the match time timer

Match time timer reset [Timer number]

Switch on the event level switch

Event level switch on [Switch number]

Switch off the event level switch

Event level switch off [Switch number]

Event edge switch

Event edge switch [Switch number]

Change to setting mode

Change to setting mode

Change to basic setting mode

Change to basic setting mode

Change to operation mode

MoveOpe

Write to a communication input channel

Writing to communication input channel[CH Channel
number and set value (the text in the data file is displayed)]

Execute Modbus client exchange

Modbus client exchange execution[CMD Channel number
and set value (the text in the data file is displayed)]

Execute Modbus master exchange

Modbus master exchange execution[CMD Channel number
and set value (the text in the data file is displayed)]

Save settings in setting mode

Settings saved in setting mode

Load settings in setting mode

Settings loaded in setting mode

Load settings in basic setting mode

Settings loaded in basic setting mode

Clear 1 Clear 1
Clear 2 Clear 2
Clear 3 Clear 3
Clear 4 Clear 4

Calibration correction complete
Calibration correction period expiry

Input calibration finished
Due date for the next input calibration is over

Change setting mode settings

Change configuration [setting file sequence number](Set
mode)

Change basic setting mode settings

Change configuration [setting file sequence number](Basic
setting mode)

Change settings related to user
registration

Change configuration [setting file sequence number](Login
information)

Change setting mode settings and
basic setting mode settings

Change configuration [setting file sequence number](Basic
setting mode & Set mode)

Change the setting mode settings and
settings related to user registration

Change configuration [setting file sequence number](Set
mode & Login information)

Change the basic setting mode settings
and settings related to user registration

Change configuration [setting file sequence number](Basic
setting mode & Login information)

Change settings [No] (all)

Change configuration [setting file sequence number](all)

Set an alarm

AlarmSet [CH Channel number/Lvl Alarm level]

Change a calibration correction point.

Input calibration point change [CH Channel number/Pt
Calibration point]

Change a calibration correction value.

Input calibration value change [CH Channel number/Pt
Calibration point]

Sets an alarm delay

AlmDIaySet [CH Channel number]

Select a message

Set message [Message number]

Set the data save destination folder

FolderSet

3-62

IM 04L61B01-01EN
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GX10/GX20/GP10/GP20/GM10 Models with the /AS Option

Operation What Appears on the Screen (Bold words are displayed
on the screen. Non-bold words are explanations.)

Error Error [ErrorNo]

A/D calibration ExecA/DCal

Power off PowerOff

Power on PowerOn

Login Login

Logout Logout

User invalidation UserLocked

Password change ChgPasswd

Mode change ChgMode

Time change ChgTime

New time NewTime

Time adjustment start TRevStart

Time adjustment stop TRevEnd

SNTP time change SetSNTPtime

Daylight saving time start DSTStart

Daylight saving time end DSTEnd

Unauthorized access acknowledge UserLockedACK

Alarm acknowledge AlarmACK

Message writing

Message [MessageNo] (Preset messages)

MessageF [MessageNo] (Free messages)

MessageHnd (Freehand messages)

Recording start

Record Start

Recording stop

Record Stop

Manual sample

ManualSample

Math start MathStart
Math stop MathStop
Math reset MathRST
Computation data dropout MathACK
acknowledgment

Mail start MailStart
Mail stop MailStop
Modbus manual recovery RefModbus
Display data save SaveDisp
Event data save SaveEvent
Manual data save ManualSave
Snapshot Snapshot
Batch number setting SetBatchNo
Lot number setting SetLotNo
Batch text field setting SetTextField
Display update rate change ChgRate

Timer reset

TimerRST [A/ll (When all timers are specified.)

TimerRST [Timer No.] (When a single timer is specified.)
TimerRST [Timer No.1, Timer No.2,...] (When multiple timers
are specified.)

Match time timer reset

MTimerRST [A/ll (When all timers are specified.)
MTimerRST [Timer No.] (When a single timer is specified.)
MTimerRST [Timer No.1, Timer No.2...] (When multiple
timers are specified.)

Communication channel writing (GX/GP |WriteComm
operation only)

DO channel writing (for manual WriteDO
operation)

SW writing (for manual operation) WriteSW
(GX/GP, communication, serial)

Report save SaveReport
Scale image save SaveScale
Custom display save SaveCustom
Certificate save SaveCert
Parameter save SaveParameter
All settings save SaveAll
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3.6 Listing the Operation Log

Operation What Appears on the Screen (Bold words are displayed
on the screen. Non-bold words are explanations.)

Report load LoadReport

Scale image load LoadScale

Custom display load LoadCustom

Parameter load LoadParameter

Certificate load LoadCert

All settings load LoadAll

Key creation GeneKeyDone

Key creation GeneKeyCancel

Key creation GeneKeyStart

Installation of certificate InstallServCert

Certificate creation CreateCert

Touch screen adjustment ExecTouchCal

initialization Initialize

Sign in Sign In

Key lock enabled LockHardwareKey

Key lock released

UnlockHardwareKey

Bluetooth On

BluetoothOn

Bluetooth Off

BluetoothOff

Clear Bluetooth connection list

ClearBTCnctList

Fixed IP address mode

FixedIPAddressMode

Collectively storing unsaved data SaveManual
Setting change SetParameter
Alarm setting change SetAlarm
Alarm delay setting change SetAlmDelay
Calibration correction/set point change |SetCCModePnt
Calibration correction value change SetCCValue

Save directory change

SetDirectory

Recipient address change

SetRecipient

Source address change SetSender
Subject change SetSubject
Login change SetlLogin

Module update

UpdateModule

Module disconnection

RemoveModule

Modules installed

AttachModule

Module information InfoModule

Module activation ApplyModule

Reconfiguration ConfigModule

Updating UpdateWeb

SLMP recovery RefSLMP

Multi batch change MultiBatch

Expiration Expiration

Schedule setting SetSchedule [Number] (The number is two-digit number.)

Calibration factor setting

SetCFactor

Analog output retransmission AO re-Trans

Analog manual output AOManual

Module calibration CalModule

lindividual setting initialize Indv Init [recording channel settings, display group
settings]

SetComment SetComment

SetDiff SetDiff

Variable constant setting

Variable constant setting
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3.6 Listing the Operation Log

Detail Information

When detailed information, such as error occurrence and setting changes, is available in the
operation log, the Display button is enabled.

The button will not appear for DX100P or DX200P.

Clicking Display opens the Detailed Info. dialog box.

Basic information area

Detailed Info.-No.00000537 22
Absolute Time #01/21 13: 34'327{30
Operation Error261
Kind SYSTEM

User

E0261
Wrong user ID or password

L

/ =)

7
Change details area

When differences are shown Diff display
Detailed Info.-No.00000444 X
Absolute Time 2019/10/02 13:05:57 680
Operation Set Difference
Kind OPERATE
User User003
Setting file name 000084_191002_130018.GSL
000085_191002_130557.GSL

The following items are displayed in the basic information area. For the definitions of
“Operation” and “Kind,” see the previous list of operations by model.

* [Absolute Time] Time when the operation took place.
» [Operation] Operation that was executed.

» [Batch] Batch number (only when available.)

* [Kind] Operation method.

» [User] Name of the user that executed the operation.

Specific details of changes, channel numbers, slot numbers, errors, and the like are
displayed in the change details area.

When the operation is Set Difference, a Diff Display button appears.

When you click this button, Hardware Configurator starts, and the difference display
appears. (Hardware Configurator must be installed to use the difference display.)

3.6.2 Starting the Hardware Configurator and Viewing Operation Logs

Procedure

1 On the Operation Log List tabbed page, double-click an entry that is emphasized with
text bolded (operation log entry of setting change).

ﬁuouoom 3] 2000/05/06 19.56:45 625 , Admin ey In Change configuration[G]isystem mUdE)J
[0000001 4] 2000506 19:56:51.000 |\Admin1 Hey In Logout

Double-click a setting change operation log entry (bolded).

Hardware Configurator starts and displays settings.
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3.6 Listing the Operation Log

Explanation

You can use the configuration software to view all the settings of the recorder that took effect
after changes were made.

The table below shows the types of operations in a log that enable you to start the
configuration software.

Model Display

DX100P, DX200P Change settings [No]

Change settings [No] (system mode)

Change settings [No] (engineering mode)

Change settings [No] (system and engineering modes)

Change settings [No] (login information)

Change settings [No] (system mode and login information)
Change settings [No] (login information and engineering modes)
Change settings [No] (all)

DX1000, DX1000N, DX1000T, DX2000, [Change settings [No] (setting mode)

DX2000T Change settings [No] (basic setting mode)

with the /AS1 option Change settings [No] (login information)

Change settings [No] (basic setting mode and setting mode)
Change settings [No] (login information and setting mode)
Change settings [No] (basic setting mode and login information)
Change settings [No] (all)

GX10, GX20, GP10, GP20, GM10 Change settings
with the /AS option SetDiff

Configuration changes to devices that have collected data are always saved in the setting
data files of those devices. To start the configuration software from an operation log, you
need the setting data file and the appropriate configuration software for the device (see the
table below).

» Do not move the setting data file of a device from the folder containing the data file that is
being displayed.

 Install Hardware Configurator in the same folder as Universal Viewer. To specify the
installation folder, set Setup Type to Custom.

* Install DXA120 DAQSTANDARD Hardware Configurator in the same folder as Universal
Viewer. To specify the installation folder, set Setup Type to Custom. Universal Viewer is
installed in the following default folder.

System drive: \Program Files\Yokogawa Electric Corporation\SMARTDAC+ STANDARD
Universal Viewer\

Model Hardware Configurator Setting Data File
(Extension)
DX100P, DX200P DXA120 DAQSTANDARD *PPL
DX-P Hardware Configurator
DX1000, DX2000 with the /AS1 option DXA120 DAQSTANDARD * PEL

Hardware Configurator

GX10, GX20, GP10, GP20, GM10 with the /AS option SMARTDAC+ STANDARD *.GSL
Hardware Configurator

Nofte

Hardware Configurator will not start if:

» The entry you double-clicked is not a log of configuration changes.

* Hardware Configurator was not installed when you started Universal Viewer.

» Hardware Configurator is not installed when you double-click the list.

* The setting data file of the device is not in the same folder as the data file that is being displayed.
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3.7

3.71

Timer that was used to sample data

Displaying and Converting a TLOG File (CX1000/
CX2000, DX100/DX200/DX200C, DX100P/DX200P,
MV100/MV200 or FX100)

You can display TLOG files created by a CX1000/CX2000, DX100/DX200/DX200C,

DX100P/DX200P, MV100/MV200 or FX100. TLOG files have .dtg extensions.

TLOG File Display Window

The TLOG file display window shows data of different timers collected during TLOG memory
sampling. Digital values are grouped by timers and displayed on separate tabs.

Procedure

1 Open a TLOG file.

On the File menu, click Open to select the TLOG file you want to open. You can also
click Open on the toolbar.
Data will appear.

Three timers can be used during TLOG memory sampling. The data of the timer with the smallest
number is displayed on the front-most tab.

— Time when the data entry was sampled

Channel information

Channel name, unit, waveform color, and time values

- CHO1 CHZ CHO3 CHO4 CHOS CHOS CHO? CHOS
1mne
& ) [2010/05/12 16:37:16.000[[0000] -0.427 -0.431 -0.437 -0.443 -0.443 -0.452 -0.454 -0.453
2010/05/12 16:39:16.000 [0001] -0.426 -0.429 -0.435 -0.441 -0.447 -0.451 -0.452 -0.458
2010/05/12 16:41:16.00Q[0002] -0.427 -0.432 -0.437 -0.443 -0.443 -0.452 -0.455 -0.451
r
|—Flag L Data number

Explanation

Switching the Channel String
On the View menu, click Channel or Tag No. to select the display mode.

Switching the Time Display Format
On the View menu, click Date or Time to select the format.

Showing or Hiding Data Numbers

On the View menu, turn on Data No. to show data numbers after timestamps.

hide them.

Showing or Hiding Flags

One the View menu, turn on Flags to show the following status information.

Turn it off to

Display

Description

Stopped TLOG computation.

The recorder’s date and time were changed during TLOG computation.

&
e}
|62

Power failure occurred during TLOG computation.

If multiple flags are present, they are displayed overlapped with the following precedence
from top to bottom: stop, time change, and power failure.
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3.7 Displaying and Converting a TLOG File

Displaying TLOG File Information

On the Information menu, click About Document to view information about the displayed

TLOG file.
Viewing data file information: P section 2.4

3.7.2 Converting a TLOG File

The sampled data in a TLOG data file can be converted and saved in Excel or ASCII format.
Use the Convert Data dialog box to specify the settings for the data conversion.

Procedure

1 On the Convert menu, click Convert Data.
The TLOG Convert Data dialog box appears.

2 Specify the settings for the file conversion.

The sampled data is saved in groups of timers. Select which timer to convert

the data of.
Convert Data
? Timer 1
Specify timer —< K Timer2
numbers.
? Timer 3

File Type: [ Excel 7-2003 workbook "xs) (=]

File: D:\Users\ \Desktop!.. \z2321509 dtg.xls

o ) |

Cancel

)

1 Select the file format.

—

Click here to select

the file name and

Path and file name

3 After you finish configuring the settings, click OK.

The data will be converted.

save destination.
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3.8 Viewing Report Files

3.8.1 Report File Display Window

You can view data in report files as digital (numeric) values.

The report file display window displays data from files with .DAR or .GRE extensions.

Procedure

1 On the File menu, click Open. Or, click Open on the toolbar.

2 Select the report file that you want to display.

The report will appear. The figure below is an example of a report file containing hourly and daily
reports displayed in horizontal format.

Click to switch between horizontal and vertical displays.

[
fie Ve Wndow Helr

LT

BRE BN ST o FEE QS E

Urrversal Viewsr -

e, B OROME EE K EaD BT

Serind No © SSET0NE29
Start tina : 201 1OSEM 151707

Header area (file information)

—  Channel

ome
20000
-2.0000
47001000

03658
18871
RE

(3005
20000
10375
5 S4EETREIR

1 DEI0E

12081
20000
03523

L

View—Date Format to select the format.

Explanation

The report file display window consists of a header area and multiple tabbed pages described
below. Data in a file are displayed in different tabbed pages according to their type.

L Status display

Hourly tab Displays hourly reports in the file in a spreadsheet
Daily tab Displays daily reports in the file in a spreadsheet
Weekly tab Displays weekly reports in the file.

Monthly tab Displays monthly reports in the file in a spreadsheet

Batch Report tab

Displays batch reports in the file in a spreadsheet

Daily Custom tab

Displays custom daily report data in the file in a spreadsheet

Free tab

Displays free data in the file in a spreadsheet

All tab

Displays in a spreadsheet hourly, daily, weekly, monthly, batch, and
custom-daily reports and free data.

Column Bar tab

Displays the sum of each tabbed page above in a stacked bar graph
format.

Batch Info tab

Displays batch information when the file contains batch reports and
batch information.

Note

Not all the tabbed pages are displayed, only those whose data is included in the report file.
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3.8 Viewing Report Files

You can perform the following operations on the report file display window.

Switching the Channel String

On the View menu, click Channel, Tag No. or Tag Comment to select the channel display
mode. This also changes the channel names in the legend on the Column Bar tab.

Switching the Time Display Format

On the View menu, click Date Format to select the date format. This also changes the date
format of the time axis on the Column Bar tab.

Switching the Sheet Display Direction

Click the horizontal/vertical display switch button to arrange the channels vertically (vertical
display) or arrange the channels horizontally (horizontal display).

Sheet’s Data Display Area
The data display area shows the following information.

Status

The events that occurred during the creation of the report are displayed using icons and
text.

Display [Status Description

Er Error A measurement or computation error occurred during the period

over which the report was created. For reports (*.rbi) recorded by
DAQLOGGER or DAQ32PIlus/DAQ32, the following error data is
simply displayed as “Er”.

lllegal, Invalid, Error, No Ch, Sp In, Unknown

Ov Over A range-over or computation overflow occurred during the period
over which the report was created. For reports (*.rbi) recorded by
DAQLOGGER or DAQ32PIlus/DAQ32, the following error data is
simply displayed as “Ov”.

+Over, -Over, Data Under, Data Over, Exp Under, Exp Over

Pw Blackout A power failure occurred during the period over which the report was
created.

Cg Time Correction |The time was changed during the period over which the report was
created.

Bo Burnout A burn out occurred during the period over which the report was
created.

Ave

The average value during the period over which the report was created.

Max
The maximum value during the period over which the report was created.
Min
The minimum value during the period over which the report was created.

Sum
The sum value during the period over which the report was created.

Inst
The instantaneous value when the report was created.

Total

The accumulated sum value during the period over which the report was created. This is
displayed in reports (*.rbi) recorded by DAQLOGGER or DAQ32PIlus/DAQ32.

The Ave, Max, Min, Sum, Inst and Total values are displayed only if they had been
specified in the report file creation settings.
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3.8 Viewing Report Files

Report Type (All tab)

On the All tabbed page, a summary of each tabbed page is displayed.

Therefore, the report type (hourly, daily, weekly, monthly, batch, custom-daily, or free) is
shown next to the time display.

Stacked Bar Graph Display (Column Bar tab)

If the report data contains sum values, stacked bar graphs will be drawn on the Column Bar
tabbed page. In reference to the first channel whose sum value is greater than or equal to
zero, all channels whose unit is the same as the reference channel or all channels whose
sum value is greater than or equal to zero are summed and displayed in a bar graph.
Column bar graphs and legends can be displayed for up to 60 channels.

r Column Bar tab

o opvey pucp Channel
display
_ HLL Horizontal
axis display
s | oo
absolute time Daily report o
For “daily+weekly,” the weekly report is displayed.

Hourly report For “daily+monthly,” the monthly report is displayed.

For “daily+weekly,” the daily report is displayed.
For “daily+monthly,” the daily report is displayed.

The tabs are displayed from left to right in the following order: hourly, daily, weekly, monthly,
batch, custom-daily, and free.

Nofte

*  You cannot change the channel colors of bar graphs.

» The horizontal axis and the time display format vary depending on the file type. You cannot
change them.

» All channels in the report file are displayed in a single window.

» Channels that contain errors, over-range, or negative values are not displayed.

Batch Information Display (Batch Info. tab)

When report data contains batch information, the following information is displayed on the
Batch Info tab.

» [Batch No.]: Batch number in the file.

* [Lot No.]: Lot number in the file.

* [Comment1] to [Comment3]: Displays in order the time, user name, and comment of the
data in the file.

» [Title]: Batch text title.

» [Description]: Batch text.
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3.8 Viewing Report Files

3.8.2 Hourly, Daily, Weekly, and Monthly Report File Display Window (CX1000/
CX2000, DX100/DX200, DX100P/DX200P, MV100/MV200 or FX100)

The hourly, daily, weekly, and monthly report file display window displays data from report
files with .dhr, .ddr, .dwr, and .dmr extensions.

1 On the File menu, click Open. Or, click Open on the toolbar.

2 Select the report file that you want to display.
Data will be displayed using digital values.

Hourly Report File[z2201009.dhr] - =X
HOURLY REPORT (Start = 2008112415 12:50)
Serial Mo, : 124718723, File Message . 11-5
R . = CHo4 CH2 CHOZ CHo4
To Herizental Displ.
i o 0] rel rel v
Status 4;0v e
AVE -0.0m 10133 0,00
ZUUD?”DEEE ML 14938 99399 -99993 1 495
. MR -1.498 -99993 -99993 -1.498
UM -3.563TS3E-02 1.823836E+04 -2 352528400
Status frov fHov
AVE -0.001 a2 0001
ZDE?‘ID?QQ MEK 1.498 99939 -99993 1498
MiN -1.483 -99993 -99993 -1.499
S -3 TOE252E-02 1 462434E+04 -2 225TS1EHO0
Status EH -
AVE -0.0m az7n 0,00
ZUE;”DEEE ML 14938 99399 -99993 1 495
. MR -1.499 -99993 -99993 -1.499

Explanation

The hourly, daily, weekly, and monthly report file display window displays the content of a
report in a header and spreadsheet areas. The following items are displayed.

Display Description
Header area HOURLY REPORT  Report type Hourly report
DAILY REPORT Daily report
WEEKLY REPORT Weekly report
MONTHLY REPORT Monthly report
Serial No. Serial number Serial number of the recorder
File Message File message File header string specified on the

recorder at the time the data file was
created.

Spreadsheet ~ CH [number] Channel number

area [unif] Unit
Date and time Format specified in time display
Status Status Event that occurred during the creation

of data
AVE Average value
MAX Maximum value
MIN Minimum value
SUM Sum value
Nofte

* The displayed information of Status is the same as that in the report file display window.
» You can switch the time display format and the spreadsheet display direction. The strings
displayed for channels cannot be changed.
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3.9

Viewing Manual Sampled Data Files

This section explains how to view data in manual sampled data files.

1 On the File menu, click Open. Or, click Open on the toolbar.

Select a manual sampled data file.
When you open the file, the corresponding data will appear. The figure below shows the window
for files with .GMN and .DAM extensions.

Name and unit of the sampling channel

. Use the View menu to select channel, tag No.,
Date and time that the manual sample was taken. or tag comment.

View—Date Format to select the format.

=

TR TR I —— =
SRE |08 R ot (D R e B DO e 8 e el
N

Values at
each timestamp

M

Manual Sampled Data Files with the .dmn Extension

In a display window showing the contents of a CX1000, CX2000, DX100, DX200, DX200C,
MV100, MV200 or FX100manual sampled data file (.dmn extension), if the file contains data
samples that were sampled under different conditions, they are displayed in separate tabs.

[ Manual Sample File[70117299 dmn] - 8 X

MANUAL SAMPLE DATA
Serial No. : 12A718723, File Message :
1

CHO1 CHO2 CHO3 CHO4 CH31
2003/07/01 17:25:49 0.000 0.000 0.000 0.000 0.000
2009/07/01 17:31:21 -0.001 -0.001 0.000 0.000 -0.001
2009/07/01 17:32:18

Nofte

* The strings displayed for channels cannot be changed.
« If any of the conditions below apply, another tabbed page will be added.
Each time the measurement mode of a measurement channel is changed between SKIP and
another mode
Each time a measurement channel is switched between on and off
Each time a channel unit is changed

IM 04L61B01-01EN
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3.10 Converting Data

3.10 Converting Data

You can convert measured data, alarms, and other additional information included in display,
event data files, and statistics, integration report data to Excel or ASCII format and save
them.

> Converting a TLOG file (section 3.7.2)

3.10.1  Converting Data

Use the Convert Data dialog box to specify the settings for converting the displayed data.

Procedure

1 In the window, display the file that you want to convert and save.
Note: You cannot convert data from the superimposed display.

2 On the Convert menu, click Data To.

£ Universal Viewer
File Edit TimeAxis Y-Axis View Window W
EEEE X oo B8 DataTo... L
s o 8o &% | i Fin 8] fiB Alarm To

- o Mark To...
Bl

The Convert Data dialog box appears.

3 Specify the settings for the file conversion.

— Specify the start and end data numbers.
Convert Data @
Range of data Start [ T 2menons 10316000 The ti
to convert e timestamps for the start
End: 201411015 10:46:15.000 and end points
Set data sampling. —{ st
Click either group — L & >® | - - Enter the first and last groups.
range or channel S chaoacl ) — Enter the first and last channels.
range. fect Header ftem — Select whether to include alarm
Additional Information |Nune - |/ and mark information.
File Type: |Exce| §7-2003 Workbook (* xls) hd | — Select the file format.
|- File Partition 65535
Fie:  CiUsers) = ey s -— Specify the file name and
ox ) (caen ) destination.

Number of lines
for dividing

Converted data file name

Select the header items to include in the output file.

Select Hender [tem ]
e = Clear the check boxes for the items you do not want
A Device T W Faeessape
2 Oivitog Cond to output.
& Comm Cn,
& Trigger Ha
W Sopped by
B Lotsa & Commanti
& Commenty
& T W Tead
& Tms W Tees
&7 Tz o Tied
M Thett W Tee 12
M Toet W Teeit
& TeeiT W Teis
b Toazn & Toam
K T2y o Tee2d
( o, | )
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3.10 Converting Data

4 After you finish configuring the settings, click OK.

The data will be converted.

Explanation

Start and End Points

Specify the range of data to convert.

The range specified by cursors A and B are assigned, respectively, to the start and end
points. If you have not set cursors A and B or have cleared them, the start point data number
will be set to zero, and the end point data number will be set to one less than the total
number of data points.

Step

To keep the data after the conversion from becoming too large, you can sample data.
You can specify sampling in steps. To convert all the data in the specified range, set the step
number to 1.

Group or Channel

If you select Group, enter the range of groups to convert.
If you select Channel, enter the range of channels to convert.

Additional Information

You can select whether to include alarm and mark information in the conversion.
The available options vary depending on whether you selected Group or Channel, described

above.
Group or Channel Additional Information Options
Group The first group and the last group are the same. None, With Alarm/Message
The first group and the last group are different.  None, With Alarm
Channel None, With Alarm

Data File Type

Number of Lines per File
Number of Lines per File

File Type File Name Extension
Input Range
Excel97 to 2003 Workbook 10000 to 65536 xls
Excel Workbook 10000 to 1048576 xlsx
ASCII File — txt
Note

If the amount of data to be converted or the number of channels is large, the number of lines per
file may become smaller than the above input range.

Specifying the File Name and Save Destination

Click the “...” button to change the save destination or the name of the file to save the
converted data. The Change the file name dialog box appears. Select the save destination,
then click OK.
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3.10 Converting Data

The table below shows the default settings.

Setup Item Default Value
Start point Cursor A position or zero
End point Cursor B position or the last data number of the data set

Number of steps

1

Group or Channel

Group

First group number

Currently displayed group

Last group number

Currently displayed group

First channel number

Minimum channel number in the data file

Last channel number

Maximum channel number in the data file

Additional information None
File Type Excel 97-2003 Workbook (*.xIs)
Number of lines for dividing 65536

Converted data file name MNete)

File name shown in the window

Note

* The converted data file name will vary depending on whether the file includes batch information.
If a batch number or lot number is specified, the default file name will include the number.

» Do not specify the external storage medium as the save destination because it will take a long
period of time to save the file.

» Do not specify the root directory as the save destination.

* Make sure you have enough disk space at the destination.

» Specify the output destination so that the length of the converted file path does not exceed the

limit (218 characters).
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3.10 Converting Data

3.10.2 Converting Alarm, Mark, Image Mark, Event, Control Mode, and

Operation Log Information, and Statistics
Additional information (alarm, mark, image mark, event, control mode, and operation log) in
the displayed data file, and statistics can be converted and saved separately.
The example below shows how to convert alarm information.

Procedure

1 In the window, display the file that you want to convert and save the information of.

2 On the Convert menu, click Alarm To.
;9 Universal Viewer

File Edit TimeAxis Y-Axis View Window Convert | Information Signah
EEmd B %tk & DataTo
A &7 %o &% | APl [ BF] i Alarm To. k

= = Mark To...
Boslnl

Operation Log To...

The Alarm To dialog box appears.

3 Specify the settings for the file conversion.

Alarm List |
File Type: [Exccel 97-2003 Workbook (* xis) (/\D Select the file format.

File Partttion: | £5536 |

File: CDocuments and Settinas)., 000021 121207 _134036 DAD. Alarm xls — i
Number of d = = Click here to select

lines for dividing o ) (G ) the file name and

save destination.
Path and file name

4 After you finish configuring the settings, click OK.

The data will be converted.

Explanation

Alarm, mark, image mark, event, control mode, and operation log information in display data
files and event data files can be converted and saved separately.

On the Convert menu, select the information that you want to save. Then, in the dialog box
that appears, configure the settings for the data conversion. The procedure and settings are
the same for all types of information.

Output File Type and the Number of Lines per File
Number of Lines per File

File T File N E i
ile Type Input Range ile Name Extension
Excel97 to 2003 Workbook 10000 to 65536 xls
Excel Workbook 10000 to 1048576 xlsx
ASCII File — txt
Nofte

If you want to list the information in the window, you can use the Alarm/Mark window. For displaying
a list of alarms, marks, or image marks, see section 3.4. For displaying a list of events or control
modes, see section 3.5. For displaying a list of operation log entries, see section 3.6.
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3.10 Converting Data

Conversion Examples

Excel File

B c D E G H | J K
1/Ch.  TagMNo. TagComment Level Type No. Date Time  Sec.
2 |CH003 L3 H 27 2012/12/07 13:41:50  0.000
3 CHOo01 L1 H 102 2012/12/07 13:44:20  0.000
4 |CHO04 L4 L 281 2012M2/07 13:50:18  0.000
5 CHo002 L2 L 326 2012/12/07 13:51:48  0.000
6 CHO04 L4 L 357 2012M12/07  13:52:50  0.000
7 CHO002 L2 L 432 201212/07 13:55:20 0.000
8 CHO003 L3 H 671 2012/12/07 14:03:18  0.000
9 |CHoo1 L H 716 2012/12/07 14:04:48  0.000
10 CH003 L3 H 747 2012/12/07 14:05:50  0.000
11 CHO01 L H 822 2012/12/07 14:08:20  0.000
12 CHO004 L4 L 1001 2012A12/07 14:14:18  0.000
13 CH002 L2 L 1046 2012/12/07 14:15:48  0.000
14 /CHO04 L4 L 1077 2012M12/07  14:16:50  0.000
15 CH002 L2 L 1162 2012/12/07 14:19:20  0.000
16 |CHO03 L3 H 1391 2012M12/07  14:27:18  0.000
17 CHO001 L1 H 1436 2012M12/07 14:28:48  0.000
18 CHO03 L3 H 1467 2012/12/07 14:29:50  0.000
19 CHO001 L1 H 1542 2012M12/07 14:32:20  0.000
20 |CHOo4 L4 L 1721 2012/12/07 14:38:18  0.000
21 CHO02 L2 L 1766 2012112/07 14:39:48  0.000
22 |CHo04 L4 L 1797 2012A12/07 14:40:50  0.000
23
ASCII File
["Status”, "Ch.”,” ", "TagComment ", "Leve|”, "Type”, No.”, Date”, "Time”, "Sec.”
"OFF”, "CHO03” i " 27,72012/12/077,713:41:507, 0.000
"OFF”, "CHO01” 102, 720127124077, "13:44: 207, 0.000
"0N”, "CHOD4” 281,72012/12/077,713:50:187, 0.000
"O0N”, "CHOD2”, 326, 720127124077, 713:51:48", 0.000
"O0FF”, "CHO04” 357, 720127127077, 713:52:507, 0.000
OFF”, "CHO02 432,72012/12/077,713:55:207, 0.000
ON”, "CHO03 671,72012/12/077,714:03:187, 0.000
ON”, "CHO01”, 716,72012/12/077,714:04:48", 0.000
"O0FF”, "CHO03” 747,72012/12/077,714:06:507, 0.000
"OFF”, "CHO01” 822,72012/12/077,714:08:20", 0.000
"0N”, "CHOD4” 1001,72012/12/077,714:14:187, 0.000
"O0N”, "CHOD2”, 1046,72012/12/077,714:15:487, 0.000
"OFF”, " 1077, 720127124077, 714:16:507, 0.000
"OFF”, " 1152, 72012/12/077, "14:19:207, 0.000
1391,72012/12/077,714:27:187, 0.000
1436,72012/12/077,714:28:487, 0.000
1467, 72012/12/077, 714:29:507, 0.000
1542, 720127127077, "14:32: 207, 0.000
1721,72012/12/077,714:38:187, 0.000
1766, 72012/12/077,714:39:48", 0.000
1797, 720127124077, "14:40:507, 0.000

3.10.3 Converting Intergration Report Data

You can convert and output the displayed integration report data to text or Excel format.

The output data range is the same as the screen display range.
The output value is a total value of all channels at a given timing in each group.

You cannot convert data from the the comparison of integration graphs displayed in two

rows.

Procedure

1 In the window, display the file that you want to convert and save the information of.

2 On the Convert menu, click Integration Data to.

;5' Universal Viewer

File View Cnnuerthindnw Help

= @ &

Integration Data To...

The data will be converted.
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3.1

Displaying Intergration Graph, Demand Monitor

This section explains how to display the integration report data of the GA10 and GM10 and
the demand monitor data of the GA10.

3.11.1

Displaying Intergration Graph

Integration report data can be displayed with integration bars or integration trends.

Procedure

1 On the File menu, click Open. Or, click Open on the toolbar.
The Integration Data Open dialog box appears.

2

& Universal Viewer - [Integration Dat - [CAUsers¥ooion
o[ File | View Window  Help

@& Cpen Cui=0
e
P Swaich Open
Integragon Data Open...
bl L
A IS
L]
& Print CirlsP
Print Praview
Frint Setug.

1000087 _161205_154022.G03
2 000000_120101_000000HD CRE
509 _105048.G5D

i_110048.G30

[k

7 000° GED

8000186_120517_154642 G50

Exit

In [Folder], specify the save destination for the report file whose data is to be
displayed.

To specify a range of integration data, select the [Date] check box of [Summation Data

Ran], and specify the start and end dates for an integration graph display.

— Specifying a folder for integration data files

Integration Data Open

Folder: [

Data File: ‘

Integration Data Period: { V ’Date

2019 / 097 27 (=) - [2018 7 077 20 (=)

(

0K

)

(

Cancel

X

] [ )—— Browse for folder

display range

3 When setting finished, click OK.

Intergration graph appears.

— Specifying the integration graph

Calender display

“ 2019F12R 4
B R &% & 2 %

25 26 27 28 29 3

2 3 4 5 6 7
mo2 B oM
6 17 18 18 2 21
23 24 25 2 27 28

BRG oD
©
3

30 N 1 2 3
[J 48: 2019/07/30
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3.11 Displaying Intergration Graph, Demand Monitor

Screen Description

Integration Graph

Integration bar graph example

Toolbar

— Date specify

r Cursor I—Legend, Cursor value

==ml|

LR Bl | P e

.

anl

e —

o —

]

o —

s

e
e

]
1

5
SESREE

i igitinietiii| o Scale

I—‘.

Scale

I— Integration graph Time axisI—TotaI integrated quantity*

* The total integrated quantity is not displayed
in the integration trend.

Item

Explanation

Toobar

The tool bar allows you to select a report type, switch a time display
range, and turn on/off the legend/cursor value display.

Date specify

Specifies the date to display the integration graph.

Cursor

The cursor position is displayed.

Legend, Cursor value

A legend for each channel is displayed.

For the data in the time display range selected with the cursor, the
value for each channel and the total value are displayed.

The legend and cursor value are fixed to the right edge of the display
screen.

Integration graph

An integration bar graph or integration trend is displayed.

Data is displayed in sequence starting from that of the first channel set
in Channel set of Channel settings.

The scale on the Y axis is automatically set from the total data values
of the channels.

Total integrated quantity

The total integrated quantity for the channels is displayed. The total
integrated quantity is not displayed in the integration trend.
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3.11 Displaying Intergration Graph, Demand Monitor

Displaying two graphs on top of each other
You can compare integration graphs of any dates.

|— Toolbar |—Date specify— Date specify (Upper)
S e e \ ’7
7 =
i = e
B

I IR T

-
2
E = =2 2 £z == 3§ o = =
B 3 3 % § B & % 3 i B @ i

| ,
.munlll ||I||| .

Date specify (Lower)

Item Explanation

Date specify (upper) Specify the date of the integration graph to be
displayed at the upper.

Date specify (lower) Specify the date of the integration graph to be

displayed at the lower.

Cursor Value Dislpay

Display example Explanation
Wvio oo The value for each channel is displayed.
LPMOS 0.00
LPMOS 0.00
UPhOT 0.00
LIPMOE 0.00

W Urnios 416
W UPnios 0.34

B uPnios 233
W UPnioz 1.76
| 163

Total 1077

Compare Two Rows

Display example Item Explanation
Lower Uper  Off  Reteoichange  LOWEr  The value for each channel in the lower integration

I uewian 000 000 4000 graph is displayed.

P09 000 0O0 4000 Upper The value for each channel in the upper integration

LIPKDE 0.00 000 +000 graph is displayed.

e oo oo o Diff  The difference of value for each channel between the
B vos 48 415 067 AGED upper and lower integration graph is calculated and
W Uevos 376 084 292 T 6% displayed.
W ez 235 236 +002 +1% Rate of The rate of change in value for each channel between
| |URER 980 9@ O *¥#8% change the upper and lower integration graph is calculated and
. UPhO1 2.26 163 -064 -281% dlsplayed

Total 14.51 1077 -374 -255%
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3.11 Displaying Intergration Graph, Demand Monitor

Description of Toolbar

I— Time display range

2| =) E =] (D) w = =]

i AETIRATRAR

ki

LR@POT't type |_Legend, cursor Date specify
display On/Off
Calender
Compare 2 rows
1 2018%E7H ¥
Integration graph type B B % % & & £

24 25 26 27 28 29 0
1 2 3 4 5 6 7

& 9 1w m o1z 13z 4

15 16 17 18 19 20 21
22 23 24 25 26 27T 28
(i a1 1 2 3
[ Today: 2018/10/09

Date specify for upper

Date specification when displaying | zn018 /07 /23 =
two graphs on top of each other 18 07708 =

Date specify for lower

Item (button) Explanation
Report type Select the report type to be displayed from Daily Report, Weekly
Report, Monthly Report, and Yearly Report.
ﬁ Daily Report An integration graph for one day is displayed.

@ Weekly Report An integration graph for one week is displayed.

r@ Monthly Report An integration graph for one month is displayed.
Ll

m Yearly Report An integration graph for one year is displayed.
Integration graph type Select the graph type for an integration graph to be displayed.
Integration bar Displays the Integration bar graph.
graph

7 Integration trend Displays the Integration trend graph.

E Compare 2 Rows  Displays the integration graphs of the specified dates in the top and
bottom rows.
Legend, cursor display On/Off Turns on / off the legend/cursor values display.
Legend Display Turn on/off the legend display. Clicking this button each time switches
On/Off between Show and Hide.
Even when the legend display is turned off, if the cursor display is
turned on, a legend is displayed.
Cursor Display On/ Turn on/off the cursor value display. Clicking this button each time
Off switches between Show and Hide.
For the data in the selected time display range, the value for each
channel and the total value are displayed.
When displaying two graphs on top of each other for comparison, the
values indicating the difference and rate of change between the lower
row and upper row are displayed.
Time display range The current display can be switched to display the previous or
subsequent time based on the time display range.
Go to Previous The display range from the current display to the display for the
Report previous time is displayed.
Example: When the report type is Daily Report, the data of the previous
day from the currently displayed day is displayed.
Go to Next Report  The display range from the current display to the display for the
subsequent time is displayed.
Example: When the report type is Daily Report, the data of the
subsequent day from the currently displayed day is displayed.

Date specify The integration graph of any date can be specified to be displayed.
Single column display ~ Specify the date of the integration graph to be displayed.
PN AP I
Two-column displa Specify the respective dates of the integration graphs to be displayed
e J07 /= in the upper/lower field.

ELIREI N PP B
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3.11 Displaying Intergration Graph, Demand Monitor

3.11.2 Displaying Demand Monitor Data
The integration values during the demand monitor period can be displayed from the data in
the demand monitor data file.

Procedure

1 On the File menu, click Open. Or, click Open on the toolbar.

2 Select the demand monitor data file that you want to display.
Demand nonitor data appears.

Click to switch between horizontal and vertical displays.
Header area (file information)
—— Channel

#2 Universal Viewer - [Report File[For IM.DRE]] - o x

iB File w ndow Help

o BB R S0 S B S8 i e DB S e ReR s

Total Power 1 Total Power 2 Total Power 3 Total Power 4 Total Power § Total Power & =
[KWh] [KWh] [kWh] [kWh] [kWh] [kWh]

ejeq Bunuaauoq pue Buiheidsiq
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Chapter 4 Saving and Printing Data

4.1

41.1

Saving Display Conditions

You can save the conditions for displaying data files and alarms that you have added on
Universal Viewer as display condition files.

Saving a Display Condition File

If you save display conditions, the next time you open the same data file, the file will open

us

1
2

Th

ing the saved display conditions.

Open a data file, and set the display setting.

On the File menu, click Save Display Setting. Or, click Save Display Setting on the
toolbar.

A display condition file (.vdx extension) will be saved in the same folder as the displayed data file.

File  Edit Timefxiz Y-Axiz  Wiew Window Convert  Inb
Eal 0 X ¢SS @E

fs off Fo B
___| i) 5ave Display Setting {Gtr+5)
Sawe a display setting of the active file
When the data file in step 1 is opened the next time, the same conditions are used

to display the data. For saving the display conditions of superimposed display, see
section 4.1.2.

Note

» Separate display condition files are created for display data files, event data files, and TLOG

data files. The file name will be the same as the name of the data file but with a .vdx extension.

The file will be saved in the same folder as the data file.

« Display condition files (.vdx extension) of Universal Viewer cannot be opened or displayed by
themselves.

*  When you close a data file, if the display conditions have been changed, a message “Save
changes?” will appear. Clicking Yes overwrites the display condition file.

« Display condition files can be overwritten over and over again. You can also delete unneeded
display condition files.

Explanation

e table below shows the display conditions that are saved to display condition files (.vdx

extension).
Display Condition File of Display Data Files and Event Data Files

Conditions That Are Saved

Time axis display mode (absolute or relative)

Alarm display on/off

Channel identification string mode (channel, tag No., or tag comment)

Cursor A and B positions

Color overview display on/off Waveform display

Size of the color overview display area Waveform display

Y-axis clip on/off Waveform display

Cursor value display on/off Waveform display

Cursor value display transparency Waveform display

Image show/hide and size Waveform display

Mark note information Waveform display

Size of the Y-axis display area Waveform and circular displays
Waveform thickness Waveform and circular displays
Y-axis zone assignment Waveform and circular displays
Y-axis grid line density Waveform and circular displays
Legend display on/off Waveform and circular displays
Legend display mode Waveform and circular displays
Time axis grid display on/off Waveform and circular displays
Time axis grid line density Waveform and circular displays

IM 04L61B01-01EN
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4.1 Saving Display Conditions

Conditions That Are Saved

Active waveform

Active Y-axis

Selected group

Alarm display (inside or outside) Circular display
Time axis circular display cycle Circular display
Selected commands on the View menu of the digital display Digital display

Print settings (Print Setup dialog box)

File information item on/off and print comment

Items specified in detailed settings (Display Group Setting dialog box)

Mark information

Text comment line Waveform display

Display Condition File for TLOG Files

Conditions That Are Saved

Channel identification string mode (channel, tag No., or tag comment)
Date and time display settings

Data No. display on/off

Flag display on/off

TLOG file information item on/off and print comment

Timer number for TLOG file data conversion and file conversion format

Saving the Display Conditions of Superimposed Display

The display conditions of superimposed display (section 3.1.16, “Displaying Waveforms
Using Superimposed Display,” on page 3-33) can be saved.

Procedure

1 Open the data files (Waveform1 and Waveform2), and set the superimposed display.

On the File menu, click Save Display Setting. Or, click & .

A superimposed display condition file (.ovd extension) will be saved in the same folder as the
Waveform1 data file. The name of the condition file will be the same as the Waveform1 name
(Waveform2 name if Waveform1 is not specified).

Explanation

When you open a condition file created using step 2 above, the superimposed display is
reproduced.

If you want to specify the save destination of the condition file or the file name, click Save
Display Setting As on the File menu.

Unlike display condition files (.vdx extension) described in section 4.1.1, a superimposed
display condition file (.ovd extension) itself can be opened to reproduce the superimposed
display.

The table below shows the display conditions that are saved to superimposed display
condition files (.ovd extension).

Conditions That Are Saved

File directory File directory in which Waveform1 and Waveform2 are saved.
File name Names of all linked files of Waveform1 and Waveform2
Group Group numbers assigned to Waveform1 and Waveform2
Position Display position,

Cursor positions
Time Axis Absolute time/Relative time

Grid display on/off

Standard Grid/Dense Grid 1 to 4
Zoom

Syncronous/Individual mode.

Y-Axis Full Zone/Flee Zone
Standard Grid/Dense Grid 1 to 4
Clip ON/OFF

4-2
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4.1 Saving Display Conditions

41.3

Conditions That Are Saved

Display Alarm ON/OFF
Channel/Tag No/Tag Comment
Line Thick

Legend ON/OFF
Legend Mode

Cursor Value ON/OFF
Cursor Transparency

Display Condition Files and Precedence

The following types of display condition files are available for Universal Viewer.

Type Extension |Procedure Save Saved Information
Destination

Display .vdx Save Display Setting|Same folder as |Display conditions only

condition file on the File menu or |the data file

Save Display Setting
on the toolbar

Link settings  |.ldx Save Display Setting [Specified Display conditions and file link

file As on the File menu_|location information

Display tdx Save Template on Specified Display conditions excluding

template file the File menu location cursor data numbers, mark
information, and mark note
information

Superimposed |.ovd Save Display Setting [Specified Display conditions and file link

display on the File menu or [location information

condition file Save Display Setting

on the toolbar

When a data file is opened, the precedence of display condition files are as follows:
1. Display conditions included in the link settings file (.Idx)

2. Template file (*.tdx)

3. Display condition file (*.vdx)

The details of data file conditions are provided below.

For a Single Data File

 If there is no display condition file (.vdx) and a template file (.tdx) has not been applied,
the file is displayed with default conditions.

 If there is a display condition file (.vdx), the file is displayed according to it, regardless
of whether a template file (.tdx) is being used.

For Multiple Data Files (Linked files)

 If there is a link settings file (.Idx), and the data files are opened from it, the display
conditions in it is applied, regardless of whether a template file (.tdx) is being used.

 If there is no display condition file (.vdx) for the first data file and a template file (.tdx) is
not being used, the first file is displayed with default conditions.

 If there is no display condition file (.vdx) for the first data file and a template file (.tdx) is
being used, the first file is displayed with the conditions of the template file.
In this situation, if there is a display condition file (.vdx) for any of the subsequent data
files, the mark information in it is applied.

 If there is a display condition file (.vdx) for the first data file, the file is displayed
according to it, regardless of whether a template file (.tdx) is being used.
In this situation, if there is a display condition file (.vdx) for any of the subsequent data
files, the mark information in it is applied.

> Saving display template files (section 4.2)
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4.2 Saving Display Templates

You can save display templates so that you can use them to display data files with the same
conditions on Universal Viewer.

4.2.1 Saving a Display Template

Create a display template that you can use later to show display data files and event data
files.

Procedure

1 Set the display conditions that you want to save as a template.
On the File menu, click Save Template.

=

File | Edit Timefxis Y-fxis View Window

| Open.. CirkO
(@ search Open.

Class

B Save Display Settine Grles

Specify Template..
Use Template

Save Template

42) | Link Previous Fils

A dialog box for saving the template appears.

2. Click Save.

You can also specify the save destination and file name.
A file with the .tdx extension will be saved.

Note

Display templates will not store file-specific information shown below.
* Cursor A and B data numbers

* Mark information

* Mark note information

4.2.2 Applying a Display Template

Specify a display template that you want to apply when showing display data files and event
data files.

Procedure

1 On the File menu, click Specify Template.

File | Edit Timefixis Y-fixiz View lindow
& | oren Cirl+Q
(@8 Search Open

Close

Bl Save Display Setting Gtrls

Spesify Tamplate
Use Template ke

Save Template

A dialog box for specifying the template appears.

2 Select the template you want to use, and click Open.
The template has been specified.

Nofte

Specifying the template only selects the template file.
If you want to use it at all times, perform the procedure in “Using a Display Template” (next section).
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4.2 Saving Display Templates

423

Using a Display Template
Configure Universal Viewer so that the specified template is always used to show display
data files and event data files.

Procedure

1 On the File menu, click Use Template.
The command turns on, and the menu closes.

=
File | Edit TimedAzis Y-Axzis  Mew Window
& Open G0
g Search Open

Glose
B save Display Setting Ctrl+5

Specify Template...

Use Tenplats

Save Template..

If you do not want to use a template, on the File menu, click Use Template again to

turn off the command.

Note

Even when the Use Template command is turned on, if there is a display condition file (.vdx), the
file will take precedence.
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4.3

4.3.1

Printing

You can print display data files (with Statistics), event data files, manual sampled data files,
TLOG files, report files, and lists.

Print Settings

Specify what you want to print before printing.

Procedure

1 In the window, display the file that you want to print.

2 On the Information menu, click About Document....
The File Information dialog box appears.

& Fie Hame ADDOMS_ 150808 136338 GO%

W7 Devien Tyee 10

& Seraiiis

& e Message

7 Time Correct tang

W sty Cond Manus

& Diviang Cond. Wanus

& messcn 4

b wamcn a

& commcn o

& Data Count “

& sampie ve 2050 sec

& Start Tiee 20150826 135238 000 (UTC0R 00)
&4 Siop Time D01S/0826 13.54.08 000 (UTC08 00)
&7 Trigger Tem 20150828 13.94.08.000 (UTC-08 00)
57 Trigger Mo “

7 Damage Check it Comaged

F Siarted by oy ]

7 Siopped by ey i)

&7 Calenton Corrected Ch tione

& comment

[

3 Select the check boxes for the items that you want to print in the header.
(You can enter up to 128 characters for the comment.)

4 On the File menu, click Print Settings.
The Print Settings dialog box appears.

Printout Setup

Print Range:

Print Groups:

Print Graph Format:
Line Thick:

Graph Font Size:

Print Graph Grid:

Image mark occupation:
Split Circular Interval:
Y Axis Column Num:
Graph Legend Position:
Color Mode:

Color:

Comment:

*
All -
215 7 110 = 21| | 42| |17 - 215 7 110 = 22| :|42] 1|18
@ OnDisplay Only & Al U Select Group
‘& 1 page ‘' Multiple Pages
7.5pt -
1hou ¥ | fdiv Sub Grid: | None -4
*
R
‘o BlackWhite ‘& Color
Mark by Recorder l:l Mark by Viewer -
|
[ OK ] [ Cancel ]
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4.3 Printing

If you set Print Group to Select Group, a group selection dialog box appears.

Select Group *
V Group 01 V Group 02 V Group 03 V Group 04 V Group 05 =
% : GROUP 10

V Group 06 Group 07 V Group 08 GR

[ ok ] [ cancel ] [ seectan ] [ Selecthione ]

5 Set the print conditions. (For details, see “Explanation” on the next page.)

6 On the File menu, click Print.
The data will be printed.

Nofte

*  When printing a manual sampled data file or report file, steps 2 and 3 (header specification) are
not available.
Header information details: P> section 2.4, “Viewing Data File Information”

*  When printing a manual sampled data file, TLOG file, or report file, steps 4 and 5 (print settings)
are not available.

Explanation

Print Range
You can select the print range using one of the following three methods.

All: All displayed data (default)
Cursor: Between cursors A and B
Specify Time: Specified time range

+ If you select Specify Time, enter the start and end times. The default value is the data
range of the opened file. In superimposed display printing, the print range is the data
range of Waveform1.

Time range that can be specified: 1990/01/01 00:00:00 - 2037/12/31 23:59:59

» If you specify a time outside the displayed data range and print or preview the print, the
message “The specified time of the print range exceeds the data range. OK?” appears.
Select OK or Cancel.

» For Specify Time in superimposed display, use the time of Waveform1. If Waveform2
is superimposed on the superimposed display at Specify Time, Waveform2 will also be
printed.

+ If you select Cursor but there are no cursors, the start and end times of recording will be
the range.

» When digital values are printed, if a statistics dialog box is displayed, the statistics are
printed on the first page, and the digital values are printed on the following pages.

IM 04L61B01-01EN
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4.3 Printing

Print Groups

The print group setting is applied to the waveform, circular, and digital displays. If
superimposed display is in use, this function is invalid.

If you select On Display Only, only the display group is printed.

If you select All, all valid groups are printed.

If you select Select Group, the groups selected in the group selection dialog box are printed.

Print Graph Format

You can select 1 page to print the specified range in the waveform display on one page or
Multiple Pages to print at fixed pitches. The default value is 1 page.

When Multiple Pages is selected, the times of the waveform graph grid are mapped to the
fixed pitched scale lines and printed.

Line Thickness
Specify the line thickness to use in the waveform and circular displays. Select 0.25pt, 0.5pt,
1.0pt, 1.5pt, or 3.0pt. (The default value is 1.0pt.)

Waveform Font Size

You can specify the font size to use in the waveform display.

You can select 6pt, 7pt, 7.5pt, 8pt, 9pt, 10pt, 11pt, 12pt, 14pt, 16pt, or 20pt. (The default
value is 7.5pt.)

It is applied to the Y-axis, time axis, marks, mark notes, text comments, trips, cursor values,
and legend.

Print Graph Grid

Specify the grid line spacing and auxiliary grid lines to use during waveform display printing.
Set Print Graph Grid first and then Sub Grid. The Sub Grid options vary depending on the
Print Graph Grid setting.

Note that the grid cannot be specified if the aforementioned Print Graph Format is set to

1 page. Printing is performed according to the time axis grid used on the waveform display
screen. (If the time axis grid is hidden, it is not printed.)
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4.3 Printing

The available options for Print Graph Grid and Sub Grid are shown in the following table.

Print Graph Grid options (/div) Sub Grid options depending on the Print Graph Grid option
3months None 1month |15days |10days |5days 1day
1month 15days 10days _ [5days 1day 12hours
7days 1day 12hours _ [6hours 3hours 1hour
1day 12hours _|6hours 3hours Thour 30min
12hours 6hours 3hours 1hour 30min 10min
8hours 4hours 2hours 1hour 30min 10min
6hours 3hours 1hour 30min 10min 5min
4hours 2hours 1hour 30min 10min 5min
3hours 1hour 30min 10min 5min 2min
2hours 1hour 30min 10min 5min 2min
1hour 30min 10min 5min 2min 1min
30min 10min 5min 2min 1min 30sec
20min 10min 5min 2min 1min 30sec
10min 5min 2min 1min 30sec 10sec
5min 2min 1min 30sec 10sec 5sec
2min 1min 30sec 10sec 5sec 2sec
1min 30sec 10sec 5sec 2sec 1sec
30sec 10sec 5sec 2sec 1sec 500ms
20sec 10sec 5sec 2sec 1sec 500ms
10sec 5sec 2sec 1sec 500ms 200ms
5sec 2sec 1sec 500ms 200ms 100ms
2sec 1sec 500ms 200ms 100ms 50ms
1sec 500ms 200ms 100ms 50ms 20ms
500msec 200ms 100ms 50ms 20ms 10ms
200msec 100ms 50ms 20ms 10ms 5ms
100msec 50ms 20ms 10ms 5ms 2ms

Image mark occupation
Image marks are printed in the area where waveforms are printed. Specify the height of the

image mark print area as a percentage of the height of the waveform print area in the range
of 25 to 75%.

Split Circular Interval

Specify the cycle and time-axis auxiliary grid lines to use during circular display printing.
Set Split Circular Interval first and then Sub Split. The Sub Split options vary depending
on the Split Circular Interval setting. The available options for Split Circular Interval and
Sub Split are shown in the following table.

Split Circular Interval options (/rev.) |Sub Split options depending on the Split Circular Interval
option

4weeks None 12hours |6hours _ |3hours 1hour 30min
2weeks 12hours |6hours _ |3hours 1hour 30min
Tweek 12hours |6hours  |3hours  [1hour 30min
2days 2hours __|1hour 30min 10min 5min
1day 1hour 30min 10min 5min 2min
16hours Thour 30min 10min 5min 2min
12hours 30min 10min 5min 2min 1min
8hours 30min 10min 5min 2min 1min
6hours 10min 5min 2min 1min 30sec
2hours 5min 2min 1min 30sec 10sec
Thour 2min 1min 30sec 10sec 5sec

Y Axis Column Num

Specify the Y-axis scale to use during waveform or circular printing in terms of the number
of columns. Specify to which column from the right of the Y-axis to print (including the active
Y-axis). The range is 1 column (default value) to 50 columns. The columns of the active
Y-axis are prioritized, and the Y-axis will be printed to the specified number of columns from
the right.

For example, if you specify the number of columns to 1, only the active Y-axis will be printed.
If you enter 3, the active Y-axis and the two Y-axes from the right are printed.

IM 04L61B01-01EN
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4.3 Printing

4.3.2

Waveform Legend Position

You can specify the legend position of the waveform display. You can select top, bottom,
right, or left in the waveform display area. (The default value is right.)

When printing with the legend display mode set to axis mode, the legend position is fixed to
the right.

If the legend position is set to top or bottom when a superimposed display is printed, the
legends for waveform1 and waveform2 are displayed on the left or right.

Color Mode
Specify black and white print or color print. The default value is Color.

Print Color

You can specify different colors for the marks placed with the recorder and those placed with
the software.

Comment

You can enter a print comment. The comment that you enter here is the same as that in the
File Information dialog box described in step 2. Up to 128 characters are displayed.

The table below shows the relationship between the settings in the Print Settings dialog box
and the different displays.

Display Window Type
Setup ltem Waveform display| Digital display | Circular display
Print Range Yes Yes Yes
Print group Yes Yes Yes
Print Graph Format Yes
Line Thickness Yes Yes
Waveform font size Yes
Print Graph Grid Yes
Image mark occupation Yes
Sub Grid Yes
Split Circular Interval Yes
Sub Split Yes
Y Axis Column Num Yes Yes
Waveform legend position Yes
Color Mode Yes Yes Yes
Print Color Yes Yes Yes
Comment Yes Yes Yes

Print Preview

You can preview the print layout.
To do so, on the File menu, click Print Preview.

Print Operation

Procedure

1 In the window, display the list that you want to print.

On the File menu, click Print.
For setting the print content, see the previous section.

The Print dialog box appears.

3 Click OK.
The displayed content will be printed.

4-10
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4.3 Printing

43.3

Print Example (Superimposed display)

A print example of superimposed display (Individual mode) is shown below.

Header
rF. —1— Legend
i \ 7 "\\ o
] ]
i % \
[N YA
! i 1 §
\ !
f" \ ;‘ :'\_ a'llll \\
\,/] \/ h¥ /
= = = Time Axis

Time Axis

In Synchronous mode, only the time axis of Waveform1 is displayed. In Individual mode,
time axes are displayed at the top and bottom, with the top being the time axis of Waveform1
and the bottom being that of Waveform2.

Header

The following information is printed when the corresponding item is selected in the About
File dialog box for Waveform1 and Waveform2.

Legend

The legend is divided into top and bottom halves. The top half shows Waveform1 and the
bottom half Waveform2.

If the number of displayed channels is large and the legends do not fit, the separation
between Waveform1 and Waveform?2 is set at the center, and the legends of channels that
overflow are not printed.

If the legends do not fit using normal font, a smaller font is used.

The width of the legends are also adjusted according to the length of the character strings
(width of the longest tag name to be printed). This also applies when printing normal
waveforms.

Y-Axis
The number of columns that can be printed is 50 (from waveform number W01 of
Waveform1).

Cursor Value Dialog
If the cursor value dialog box is displayed, it is printed at the bottom section of the header.
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Chapter 5 Troubleshooting

5.1 Troubleshooting

Messages

Code Message Description

3130 Do you want to sign this record? This message appears to confirm whether you want to sign
the record.

3131 Do you want to cancel? Click OK to cancel the operation.

3136 The data file you are attempting to save is stored as a This message appears when you close a file displayed in the

temporary file. Any changes you made will be lost. If you
wish to make changes to the data file, please open the

original data file directly from the Viewer software.

viewer from the GA10’s Data files Page.

To edit the display data on the viewer, first copy the relevant
files to the local PC, start the viewer according to the
following procedure, and edit and save the data.

Start menu > All Programs > SMARTDAC+ Data Logging
Software > Viewer

Warning Messages

Code Message Description or Cause Corrective Action
1102 Converted data file will be A file with the same name already Rearrange the files so that there are no
overwritten. OK? exists at the save destination. overlapping file names, or save with a different
name.
3108 This file already exists. Replace A file with the same name already Rearrange the files so that there are no
existing file? exists at the save destination. overlapping file names, or save with a different
name.
3126 You cannot sign because the The signature information of the Check the consistency in the file signature

signature information of the files in files in the batch is inconsistent.

the batch is inconsistent.

information. Contact the administrator if you
cannot solve the problem.

3128 The file does not exist. The file has been deleted or Refresh the file list, and check whether the file
moved. exists. Check the disk condition. Contact the

administrator if you cannot solve the problem.

3129 Cannot link and display data A data file planned to be linked Close such files, and try again.

because some of them have is already open, so it cannot be
already been displayed. displayed.

Error Messages

Code Message Description Corrective Action

201 Can’t open. No YOKOGAWA You are trying to open a file thatis Use compatible files.

binary file. not in YOKOGAWA binary format.

203 There is no available data. This message appears when there Open a file containing data.
is no data in the file that you are
trying to open.

211 Can’t write to file. There is insufficient space in the ~ Check the free space in the directory. Check
directory, the file is being used by  whether the file is being used by another
another program, or the file path is program. If the file path is over the limit (218
too long. characters), change to an output destination

with a shorter file path.

212 Can’t read file. The file does not exist, or there is a Check whether the file exists. Check whether
problem with the file system, or the the file system is normal. Check whether the
viewer is not the latest version. file is one that can be displayed by the viewer.

Also, update the viewer to the latest version.
You may be trying to open alink  (section 1.1.1)
information file (.Idx extension)
without the original linked data To reproduce a display using a link information
files. file (.Idx extension), check that all the original
linked files are in the same folder.

213 Can’t open file. The file does not exist, or there is a Check whether the file exists. Check whether
problem with the file system. the file system is normal.

214 Insufficient disk capacity. Not enough free space in the Secure enough free space.
directory.

215 No such file. The specified file does not exist.  Specify a different file.

218 No such folder. The specified folder does not exist. Specify a different folder.

250 Failed to start Adobe Reader. Adobe Reader is not installed. Install it.
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5.1 Troubleshooting

Code Message Description Corrective Action

3109 This name’s directory already Check the directory name.

exists.

3110 Can't overwrite to file. There is insufficient space in the ~ Check the free space in the directory. Check

directory, or the file is being used  whether the file is being used by another
by another program. program.

3111 Can’t write to file. There is insufficient space in the ~ Check the free space in the directory. Check

directory, or the file is being used  whether the file is being used by another
by another program. program.

3115 Too many data. The number of data entries in the  Decrease the number of files to link.

files that are to be linked exceeds
32 million entries, so the files
cannot be linked.

3118 CRC illegal! The file may be corrupt. Check the disk condition, and recover the file.
Contact the administrator if you cannot solve
the problem.

3119 Already signed Already signed at the current user Contact the administrator if you cannot solve

level. the problem.

3120 Not registered user. User name, user ID, or password Check them, and try again.

entry is incorrect. Contact the administrator if you cannot solve
the problem.

3121 There is no signature no. The user does not have signature Check the signature privileges.

privileges. Enter the correct user name, user ID, and

3122 %d times password input failure.  Processing terminated. password.

%d is the number of failures. If you fail to sign the specified number of times,

3123 %d times password input failure.  This user’s privileges will be you will be disabled. B

The user will be disabled. disabled. %d is the number of Log in as another user with the privileges and
failures. apply the signature.
Contact the administrator if you cannot solve
the problem. If all users are disabled, contact
your nearest YOKOGAWA dealer to have your
system serviced.

3124 %s File is not found. The setting data file could not be  Place the relevant setting file in the folder

found. containing the data file.

3125 Cannot perform authentication. Unable to connect to the KDC Contact your administrator.

There is a problem with the KDC  server or unable to authenticate
server. because the KDC server setting
has been changed. KDC
authentication is also not possible
if the time zone on the PC is
changed while Universal Viewer
is running. Authentication is not
possible if there a time difference
of 5 minutes or more between the
PC and the KDC server.
3132 Failed to start Hardware Unable to start because Hardware Install the Hardware Configurator.
Configurator. Configurator is not available.
3133 Insufficient sufficient memory to Insufficient memory on the PC. Check the available memory on your PC.
display all files. This message appears when you We recommend you increase the amount of
open a file or link files. memory or use a 64-bit OS and software.
3141 Unable to download file from the  Data files cannot be downloaded = Check that communication is working properly,

server.

from the data folder of the GA10
server.

and try again.
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